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Copyright

Copyright © 2002 - 2010 Patchmanager BV. All rights reserved. No part of this publication or of the 
PatchManager software, in source code or object code form, may be reproduced, stored in a 
retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, 
recording or otherwise, without the prior written consent of Patchmanager BV. Contact information 
is available on the Internet at http://www.patchmanager.com.

Disclaimer

These materials are subject to change without notice and for informational purposes only, without 
representation of warranty of any kind.
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Chapter 1: Introduction
The following sections describe the contents of and the conventions used in this document.

1.1   About This Document
This is the PatchManager Reference Manual. The intention of this document is to provide a 
complete reference of the PatchManager functionality. 

This document consists of fifteen chapters. This chapter is the introduction to this manual. Section 
1.2 presents the version history of this document. Section 1.3 discusses the conventions used in this 
manual. Section 1.4 illustrates how to start and login to the PatchManager Client.

Chapter 2 presents the main PatchManager window. Chapter 3 discusses how PatchManager models 
your network infrastructure using model templates. Chapters 4, 5 and 6 discuss how physical 
objects in your network infrastructure are handled in PatchManager. Chapter 4 covers locations, 
chapter 5 covers network objects such as cabinets, equipment, cables and components, and chapter 
6 covers connections. 

Chapter 7 presents the use of graphical overviews. User attributes are discussed in chapter 8. Work 
orders are discussed in chapter 9. Importing and exporting data to and from the PatchManager 
database is discussed in chapter 10. The search facilities available in PatchManager are discussed in 
chapter 11. 

Chapter 12 describes how PatchManager handles resources. Monitoring is described in chapter 13. 
Note that chapters 12 and 13 only apply if the data center module is included in your installation. 
Chapter 14 describes user access management in PatchManager. Finally, chapter 15 presents general 
administration tasks you may need to perform in PatchManager.

Two appendixes complete this document. Appendix A provides an introduction to regular 
expressions, which are used by patterns in PatchManager. Appendix B presents the CSV formats 
used when importing data to the PatchManager database.

1.2   Version History
• January 24, 2010: Original Version, based on version 4.1.1153.

• February 20, 2010: Updated for version 4.1.1207.

• March 19, 2010: Updated for version 4.1.1286.

• June 09, 2010: Updated for version 4.1.1582.

1.3   Conventions
Most actions you can perform are explained using easy-to-follow numbered steps. Steps are usually 
single actions, such as clicking a button or entering a value. When a step leads to a reaction from 
the interface, a description of the reaction will be included in the step. 

Where necessary detailed examples are given. References to items appearing in the user interface 
and keys on the keyboard are displayed using a fixed-width font, for example, “Click on the Save 
button.” When referring to a nested menu entry, the individual menu items are separated using >, 
for example File > Preferences.
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1.4   Starting the PatchManager Client
The PatchManager client can be run either by installing the desktop client or by using the web-start 
client. Both options are described in the following sections.

1.4.1   Desktop Client
1. Launch the PatchManager Client from the desktop or the start menu. The login screen 

shown in Illustration 1 will appear. Note that the project selection will only appear if there 
are multiple projects that you can login to.

2. Optionally use the project box to select a project to login to. Note that the PatchManager 
Client will remember the last project you logged in to the next time you start it.

3. Use the language box to select your preferred language. Note that the PatchManager Client 
will remember your preferred language the next time you start it.

4. Enter your user name and password.

5. Click on the OK button. A splash screen will appear, indicating the start-up progress. You can 
hide the splash screen by clicking anywhere on it. After loading has completed you will see 
the main PatchManager window, which is discussed in detail in chapter 2.

1.4.2   Web-Start Client
If PatchManager Server has been configured to enable web-start, there is no need to install the 
client software on the client machines. Instead, all that is required on the client machines is a 
current installation of the Java TM runtime environment (JRE), which can be downloaded from 
http://java.sun.com.

Assuming a current version of the JRE is installed and the server is configured to enable web-start, 

PatchManager Reference Manual Version 4.1 Page 20 / 274

Illustration 1: PatchManager Login Screen

http://java.sun.com/


you can start the web-start client by directing your Internet browser to 
http://<server-host>:<port>/patchmanager.jnlp, where <server-host> is 
the host name or IP address of the server, and <port> is the port number where PatchManager 
server is configured to listen for HTTP requests. The login screen shown in Illustration 1 will 
appear. From here on, the login procedure is the same as it is with the desktop client, as described in 
the previous section.

Chapter 2: The PatchManager Window
Illustration 2 illustrates the PatchManager window after login. The green text in the illustration 
indicates the names of the different parts of the window. These parts are discussed in sections 2.1 
through 2.8.

The PatchManager interface is highly configurable. Workspaces are used to define different views 
suitable for different tasks. Workspaces are discussed in section 2.9. You are free to further 
configure the interface by moving and resizing the different parts of the interface. This functionality 
is achieved through the docking framework used by PatchManager. Docking is discussed in section 
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2.10. 

Many functions in PatchManager can be performed using only the keyboard. Navigating the 
interface using the keyboard is discussed in section 2.11. PatchManager's support for undoing and 
redoing actions is described in section 2.12. PatchManager also supports a recycle bin for deleted 
objects. The recycle bin is described in section 2.13.

Several views in PatchManager support zooming. Controlling the zoom percentage of a view is 
described in section 2.14.

2.1   Menu Bar
The menu bar provides access to general actions you can perform. The entries available in the menu 
are discussed in Table 1, along with references to the sections containing more information on the 
menu entries. Note that the File and Edit menus are context-sensitive. As such, these menus 
may contain entries that are not discussed in Table 1. These entries are discussed in the appropriate 
sections.
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Menu Entry Description
File > Preferences Opens the preferences dialog. Preferences are discussed in section 

15.9.
File > Recycle Bin Opens the recycle bin dialog. The recycle bin is discussed in 

section 2.13.
File > Exit Closes the application.
Edit > Undo Undoes the last action. Undoing and redoing are described in 

section 2.12.
Edit > Redo Redoes the last action. Undoing and redoing are described in 

section 2.12.
Edit > Find Opens the find dialog. The find dialog is described in section 11.1.
Searches This menu contains favorite searches. Favorite searches are 

described in section 11.2.1.6.
Searches > Group by 
search type

Toggles whether or not favorite searches should be grouped into 
sub-menus by search type. Favorite searches are described in 
section 11.2.1.6.

Administration > User 
Overview

Opens the User Overview. User access management is discussed 
in chapter 14.

Administration > 
Scheduled Imports

Opens the scheduled imports overview. Scheduled imports are 
discussed in section 15.4.

Administration > 
History Overview

Opens the history overview. The history overview is discussed in 
section 15.1.

Administration > 
Server Administration

Opens the server administration view. Server administration is 
discussed in section 15.3. Note that this option appears only if the 
data center module is installed.

Administration > User 
Attribute Overview

Opens the user attribute overview. User Attributes are described in 
chapter 8.

Administration > 
Monitoring

Opens the monitoring overview. Monitoring is discussed in 
chapter 13. Note that this option appears only if the data center 
module is installed.

Administration > File 
Management

Opens the file management dialog. File management is discussed 
in section 15.2.

Administration > 
Labeling Schemes

Opens the labeling schemes overview. Labeling schemes are 
discussed in section 15.5.

Administration > 
Rules

Opens the rules overview. Rules are discussed in section 15.7.

Administration > 
Searches and Data 
Formats

Opens the searches and data formats overview. Searches and data 
formats are described in section 11.2.

Administration > Opens the patterns overview. Patterns are discussed in section 
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Patterns Overview 15.8.
Administration > 
Sequences Overview

Opens the sequences overview. Sequences are discussed in 
section 15.6.

Administration > 
Resources Overview

Opens the resources overview. Resources are discussed in chapter 
12. Note that this option appears only if the data center module is 
installed.

Workspace > Default Switches the interface to the default workspace. Workspaces are 
discussed in section 2.9.

Workspace > Work 
Order

Switches the interface to the work order workspace. Workspaces 
are discussed in section 2.9. Work orders are discussed in chapter 
9.

Workspace > Locations Switches the interface to the locations workspace. Workspaces are 
discussed in section 2.9. Locations are discussed in chapter 4.

Workspace > Templates Switches the interface to the templates workspace. Workspaces 
are discussed in section 2.9. Model templates are discussed in 
chapter 3.

Help > Help Opens this user manual in a help dialog.
Help > About 
PatchManager

Show the About PatchManager dialog. The About PatchManager 
dialog is discussed in section 15.10.

Table 1: Menu Entries

2.2   Tool Bar
Tool bars are used extensively in the PatchManager interface. This section discusses the tool bar of 
the main window, as shown in Illustration 2.

The tool bar provides single click access to frequently performed actions. The actions available in 
the tool bar are briefly described in  Table 2, along with references to the sections where the actions 
are discussed in detail.
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Button Description
Closes the application.
Undoes the last action. Undoing and redoing are described in section 2.12.
Redoes the last action. Undoing and redoing are described in section 2.12.
Opens the recycle bin dialog. The recycle bin is discussed in section 2.13.
Opens the find dialog. The find dialog is discussed in section 11.1.
Shows a menu containing the favorite searches. Favorite searches are described in 
section 11.2.1.6.
Opens the user overview. User administration is discussed in chapter 14.
Opens the scheduled imports overview. Scheduled imports are discussed in section 
15.4.
Opens the history overview. The history overview is discussed in section 15.1.
Opens the server administration view. Server administration is discussed in section 
15.3. Note that this option appears only if the data center module is installed.
Opens the user attribute overview. User Attributes are described in chapter 8.
Opens the monitoring overview. Monitoring is discussed in chapter 13. Note that this 
button appears only if the data center module is installed.
Opens the file management dialog. See section 15.2 for more details.
Opens the labeling schemes overview. Labeling schemes are discussed in section 
15.5.
Opens the rules overview. Rules are discussed in section 15.7.
Opens the searches and data formats overview. Searches and data formats are 
discussed in section 11.2.
Opens the patterns overview. Patterns are discussed in section 15.8.
Opens the sequences overview. Sequences are discussed in section 15.6.
Switches the interface to the default workspace. See section 2.9 for information about 
workspaces.
Switches the interface to the work order workspace. See section 2.9 for information 
about workspaces. Work orders are discussed in chapter 9.
Switches the interface to the locations workspace. See section 2.9 for information 
about workspaces. Locations are discussed in chapter 4.
Switches the interface to the templates workspace. See section 2.9 for information 
about workspaces. Model templates are discussed in chapter 3.
Opens this user manual in a help dialog.

Table 2: Tool Bar Buttons
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2.3   Locations Tree
The locations tree displays the locations and network objects in the database. Items can be opened 
by clicking on them, or by clicking on the + next to their name. Items can be closed by clicking on 
the – next to their name. Locations are discussed in chapter 4. Network objects are discussed in 
chapter 5.

2.3.1   Selecting Items in the Locations Tree
A single item can be selected by clicking on it. Items can be added to or removed from the current 
selection by keeping the Ctrl key pressed while clicking on the item. A range of items can be 
selected by selecting the first item in the range and then clicking on the last item in the range while 
keeping the Shift key pressed. Finally, a range of items can be added to or removed from the 
current selection by keeping the Ctrl key pressed while selecting the first item in the range and 
clicking on the last item in the range while keeping both the Ctrl and the Shift keys pressed.

2.3.2   Finding Items in the Locations Tree
PatchManager allows users to easily find items in the database using a flexible search function (see 
chapter 11). In order to locate items in the locations tree, you can simply select search results in the 
export preview (see section 10.1.2.1); the locations tree will automatically expand and scroll to the 
selected item.

If you have an item showing in a graphical overview (see chapter 7) and you would like to make it 
visible in the locations tree, you can right-click on the item and select the Show in Locations 
option. The locations tree will expand and scroll such that the item becomes visible in the locations 
tree.

2.4   Templates Tree
The templates tree organizes the model templates in categories. Categories can be opened by 
clicking on them or by clicking on the + next to the closed category name. Categories can be closed 
by clicking on the - next to the open category name. Model templates and categories are discussed 
in detail in chapter 3.

Selection of items in the templates tree works the same as for the locations tree, as discussed in 
section 2.3.1. You can also find items in the templates tree, similar to the locations tree, as discussed 
in section 2.3.2.

2.5   Property Sheet
The bottom left corner of the window contains the property sheet. The property sheet displays the 
properties of the object you are currently working with. You can modify the values of properties of 
the current object through the property sheet. If applicable, the property sheet also displays and 
allows the editing of the user attributes for the current object (see chapter 8).

2.5.1   Modifying a Property
1. Click on the object whose property is to be modified (for example in the locations tree or the 

PatchManager Reference Manual Version 4.1 Page 26 / 274



graphical overviews).

2. Click on the value field for the property that is to be modified. An editor will appear that is 
appropriate for the type of value for the property. 

3. Use the editor to select or type in the new value for the property. The new value will be 
saved when the editor is committed (for example by clicking elsewhere in the interface, 
pressing the Tab key or pressing the Enter key).

2.5.2   Modifying a Property for Multiple Items
In some cases, you can select multiple items and set properties for all of them at the same time. This 
applies when selecting multiple ports that all share the same defect state or the same reserved state, 
or when all the selected items have the same user attribute (see chapter 8). Modifying the property 
works the same as described in the previous section. If you modify the value for a user attribute for 
multiple items, you can enter values separated by a comma, or you can enter a single value that will 
apply to all selected items. Note that if the value itself contains a comma, it should be replaced with 
<COMMA>.

2.6   Main View
The main view organizes open views using tabs. By default two views are open in the main view: 
the work orders view (see chapter 9) and the enterprise overview (see chapter 7). After starting the 
PatchManager Client, the enterprise overview is showing.

When opening a new view, for example a graphical overview (see chapter 7) or one of the 
administration views (see chapter 15), a new tab for the view is added to the main view. You can 
change the view currently shown in the main view by clicking on its tab. 

If the main view is not wide enough to display all tabs, the  widget appears. You can 
navigate through the open views by clicking on the left arrow button and the right arrow button. 
You can also select an open view from a drop-down menu by clicking on the  button. The 
remaining two buttons allow you to minimize and maximize the main view respectively. 
Minimizing and maximizing views is discussed in section 2.10.

2.7   Connection Details
The connection details part of the window is used to display details about connections between 
ports and between equipment instances. Connections are discussed in chapter 6. The connection 
details view is discussed in detail in section 6.4.

2.8   Status Bar
The status bar displays the currently logged in user. It is also used for information messages about 
scheduled imports. Scheduled imports are discussed in section 15.4.

The bottom-right corner of the status bar indicates the status of the connection to the server. A 
check-mark means there are no problems in the connection. A warning sign indicates a problem. 
You can get details about the status of the connection to the server by moving the mouse over the 
icon in the bottom-right corner of the status bar.
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2.9   Workspaces
As discussed in the next section, the PatchManager interface is highly configurable. A specific 
configuration of the interface is called a workspace. You can quickly make the interface suitable for 
a specific task by switching between one of the four workspaces defined in PatchManager. The 
workspaces can be accessed through the Workspaces menu entries (see section 2.1) or through the 
tool bar (see section 2.2). The following workspaces are available:

● Default workspace This is the workspace you see when you first start the PatchManager 
Client. It is suitable for a wide variety of tasks.

● Work Order workspace This workspace makes it easy to work with work orders. Work 
orders are discussed in chapter 9.

● Locations workspace This workspace facilitates the administration of locations. Locations 
are discussed in chapter 4.

● Templates workspace This workspace facilitates the administration of model templates. 
Model templates are discussed in chapter 3.

Note that the PatchManager Client remembers your last selected workspace and restores it the next 
time it is started.

2.10   Docking
The docking framework used by PatchManager allows you to rearrange the various parts of the 
interface, or views, to your preferences. The following sections discuss the changes you can make 
to views.

2.10.1   Resizing Views
1. Move the mouse cursor to the area between the views you would like to resize. The mouse 

cursor will change to a resize cursor to indicate that the views can be resized.

2. Press the left mouse button and keep it pressed.

3. Move the mouse up or down for a vertical resize, or left or right for a horizontal resize. The 
interface will update accordingly.

4. Release the mouse button.

2.10.2   Maximizing Views
You can maximize a view by clicking on the appropriate  button. The view will use the entire 
window.

2.10.3   Minimizing Views
You can minimize a view by clicking on its  button. A button with the name of the view will 
appear at the bottom of the screen. If there is not enough space to display all the buttons of 
minimized views, the  widget appears to the right of the buttons.
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2.10.4   Restoring Views
You can restore a minimized or maximized view to its former size by clicking on its   button. If 
there is not enough space to display all the buttons of minimized views, you can  search through the 
list of buttons by clicking on the left and right arrow buttons in the widget shown in the previous 
section. Alternatively you can quickly select a minimized view by clicking on the  button.

2.10.5   Moving Views
1. Move the mouse cursor over the title bar of the view you would like to move.

2. Press the left mouse button and keep it pressed.

3. Move the mouse over the main window. The name of the view being moved will appear 
under the mouse cursor. A black rectangle indicates where the view will appear upon 
releasing the mouse button.

4. Release the mouse button.

2.10.6   Undocking Views
Views that were added to the main view (see section 2.6) can be undocked by clicking on their  
button. After clicking on the button the view will appear in a separate window. An alternative is to 
move the view outside the main window using the method discussed in the previous section.

2.10.7   Docking Views
Views that were undocked using the method discussed in the previous section can be returned to 
their position in the main window by clicking on their  button. Note that you can also move an 
undocked view back to the main window using the method discussed in section 2.10.5.

2.10.8   Closing Views
Views that were added to the main view can be closed by clicking on their  button. Undocked 
views can also be closed using the close button of the window.

2.11   Keyboard Navigation
PatchManager allows you to perform many functions using only the keyboard. Table 3 summarizes 
the keyboard shortcuts available in PatchManager.
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Shortcut Function
<arrow keys> Move selected items in graphical overviews, navigate through trees, 

tables and menus.
Alt Shortcut to the menu bar. Some menu entries will have a letter 

underlined; typing that letter will select that menu entry.
Ctrl + A Selects all items in the currently focused view.
Ctrl + C Copy the selected item(s) to the clipboard.
Ctrl + Enter Simulates a right-click on the currently selected item.
Ctrl + Shift + 
Tab

Switches focus to a new view.

Ctrl + F Opens the find dialog (see chapter 11).
Ctrl + V Paste the item(s) on the clipboard to the selection item.
Ctrl + X Cut the selected item(s) to the clipboard.
Ctrl + Y Redoes the last action (see section 2.12).
Ctrl + Z Undoes the last action (see section 2.12).
Delete Deletes the currently selected item(s).
Enter Performs the default action on the currently selected item. For 

example, this can be used to open a graphical overview. The default 
action for an item is the action that appears in a bold font when right-
clicking on the item.

Escape Close (cancel) the current dialog or menu.
F1 Opens the user manual in a help dialog.
Tab Cycles the selection in the currently focused view.

Table 3: Keyboard Shortcuts

2.12   Undo / Redo
PatchManager remembers the changes you make to the database and allows you to undo and redo 
them. You can undo the last change using the Edit > Undo menu entry, by clicking on the  
button in the tool bar or by pressing the Ctrl and Z keys on the keyboard. You can redo the last 
change using the Edit > Redo menu entry, by clicking on the  button in the tool bar or by 
pressing the Ctrl and Y keys on the keyboard.

If you are unsure what the last action was, you can open the Edit menu or move the mouse over 
the  or  button. Note that undoing or redoing an action may fail because another user has 
performed a conflicting action. Also note that changes that are recorded in a work order (see chapter 
9) cannot be undone or redone.
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2.13   Recycle Bin
If you delete a location, cabinet, equipment, cable or category it will be moved to the recycle bin. 
You can open the recycle bin dialog using the File > Recycle Bin menu entry or by clicking 
on the  button in the tool bar. An example of the recycle bin dialog is shown in Illustration 3.

2.13.1   Restoring Items
1. Open the recycle bin dialog as described above.

2. Select the items you would like to restore. Note that you can use the Ctrl and Shift keys 
on the keyboard to select multiple items.

3. Right-click on one of the selected items.

4. Select the Restore option. The selected items will be restored to their former location.

2.13.2   Permanently Deleting Items
1. Open the recycle bin dialog as described above.

2. Select the items you would like to delete. Note that you can use the Ctrl and Shift keys 
on the keyboard to select multiple items.

3. Right-click on one of the selected items.
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4. Select the Delete option. The selected items, including their history, will be permanently 
deleted from the database. As an alternative to steps 3 and 4, you can also press the Delete 
key on the keyboard.

2.13.3   Emptying the Recycle Bin
1. Open the recycle bin dialog as described above.

2. Right-click anywhere in the table.

3. Select the Empty Recycle Bin option. All items in the recycle bin, including their 
history, will be permanently deleted from the database.

2.14   Zoom Control
Several views, such as graphical overviews and the connection details view, support zooming. For 
these views, a zoom box appears in the tool bar at the right side. An example of the zoom box is 
shown in Illustration 4.

You can use the zoom box in the following ways:

• drag the mouse left or right over the box to zoom in or out respectively,

• click on the zoom box and select a predefined zoom percentage in the menu that appears,

• click on the zoom box and select Fit, Fit Width or Fit Height to fit the current 
view to the available space and

• click on the zoom box and select Other... to enter a custom zoom percentage.
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Chapter 3: Model Templates
Network objects in PatchManager are modeled as instances of templates. For example, a PC on a 
desk is an instance of the PC template. The PC template determines the appearance of a PC object, 
the type and position of ports on the PC object and more. PatchManager uses the template 
information during instantiation (when you add an instance of the PC template to the model) in 
order to create the correct ports on the PC object. In summary, templates contain information that is 
applicable to all instances of that template, whereas an instance of a template contains information 
relevant only to that particular object.

Out of the box, PatchManager includes a large number of templates. It is also possible to create 
custom templates or edit the included templates, as discussed in the following section. Note that it is 
not possible to create instances without the use of a template.

3.1   Template Administration
Templates are used in PatchManager to model locations, cabinets, equipment, cables, cable-
elements, connectors, ports, slots and terminators. The general mechanisms for organizing, adding, 
editing, deleting and using templates are similar for each template type. These mechanisms are 
discussed in the following sections. The specific template types and their associated dialogs are 
discussed in detail in section 3.2. Importing and exporting templates are described in section 10.3.

3.1.1   Organizing Templates
Templates are organized into template categories, similar to how files are organized into folders in a 
filing system. You can create new categories (and sub-categories), edit existing categories, delete 
categories and move templates and categories to a new parent category in the templates tree.

3.1.1.1   Adding a Category
1. Right-click on the category that is to be the parent of the new category.

2. Select the New Category... option. The category dialog will appear. An example of the 
category dialog is shown in Illustration 5. As an alternative to steps 1 and 2, you can select 
the parent category in the tree and use the File > New > Category... menu entry.

3. Enter the category name and optionally a description.

4. If applicable, add user attributes to the category using the  button in the tool bar. If you 
add user attributes to the category, these attributes will apply to all templates in this 
category, either directly or in one of its sub-categories. See chapter 8 for details on user 
attributes.

5. Click on the OK button. The new category will appear in the templates tree.

PatchManager Reference Manual Version 4.1 Page 33 / 274



3.1.1.2   Editing a Category
1. Right-click on the category that is to be edited.

2. Select the Edit... option. The category dialog will appear. An example of the category 
dialog is shown in Illustration 5 . As an alternative to steps 1 and 2, it is also possible to 
double-click on the category you would like to edit or to select the category and use the 
File > Edit... menu entry.

3. If applicable, enter the new name and / or new description of the category.

4. If applicable, edit the user attributes applied to the category using the  and  buttons in 
the tool bar. If you add user attributes to the category, these attributes will apply to all 
templates in this category, either directly or in one of its sub-categories. See chapter 8 for 
details on user attributes.

5. Click on the OK button. If applicable, the update will be reflected in the templates tree.

3.1.1.3   Deleting a Category
There are a number of ways to delete an empty category:

● right-click on the category and select the Delete option,

● select the category in the tree and press the Delete key or

● select the category in the tree and use the File > Delete menu entry.

It is also possible to delete categories that are not empty, but only if none of the templates in the 
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category (either directly or in one of its sub-categories) is in use. The confirmation question will 
indicate how many categories and templates are to be deleted and which item is to be deleted next.

3.1.1.4   Moving Categories and Templates
Categories and templates can be moved to a different parent category using drag and drop:

1. Place the mouse pointer over the category or template that is to be moved.

2. Press the left mouse button.

3. While keeping the mouse button pressed, move the mouse to the new parent category. Note 
that the mouse cursor will indicate whether or not the move is allowed. (For example, 
moving a port template into a cabinet category is not allowed.) Dragging an item near the 
edge of the tree will cause the tree to scroll up or down.

4. Release the mouse button. The templates tree will be updated to reflect the move.

3.1.2   Adding a Template
1. Right-click on the parent category.

2. Select the New Template... option. As an alternative for steps 1 and 2, select the parent 
category in the tree and use the File > New > Template... menu entry.

3. Configure the new template in the dialog that appears (specific dialogs are discussed in 
section 3.2).

4. Click on the Apply or OK button. The new template will appear in the templates tree.

3.1.3   Editing a Template
Note that templates can be edited even if they are currently in use. However, when the template is in 
use, some modifications may not be allowed. Any existing instances of a modified template will be 
updated according to the changes.

1. Right-click on the template that is to be modified.

2. Select the Edit... option. As an alternative to steps 1 and 2 you can double-click on the 
template or select the template in the tree and use the File > Edit... menu entry.

3. Make the changes in the dialog that appears. 

4. Click on the Apply or OK button. If applicable, the interface will update to reflect the 
changes.

3.1.4   Deleting a Template
There are several ways to delete an unused template:

● right-click on the template and select the Delete option,

● select the template in the tree and press the Delete key or

● select the template in the tree and use the File > Delete menu entry.
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It is not possible to delete a template if it is still in use.

3.2   Template Details
Each template dialog uses a table to display the appropriate properties of the template. The 
properties can be edited by clicking in the right column of the table (note that properties that are 
grayed out cannot be edited). 

Each template dialog also has a help button which you can use to open the appropriate section of 
this user manual in a help dialog. Finally, all template dialogs have  and  buttons above the 
table used to control user attributes. User attributes are discussed in detail in chapter 8.

3.2.1   Location Templates
An example of a location template dialog is shown in Illustration 6. The properties of the location 
template dialog are discussed in Table 4. The Manage Dimensions property can be used to 
specify whether or not dimensions of locations of this template should be manageable. The 
Application and Parameters properties can be used to associate an external application with 
locations of the template. Running external applications is described in section 3.2.3.2. 

The Identifier Format property can be used to specify how the locations of this template 
should be identified throughout the application. This property is described in detail in section 
3.2.1.1. If all locations of this template must have a unique name you can check the Unique 
Names property. You can apply a pattern to names of locations of this template using the Pattern 
property. Patterns are described in section 15.8. Finally, you can specify the font used to display the 
names of locations of this template in graphical overviews using the Font property. Graphical 
overviews are described in chapter 7.
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Property Description
Name The unique name of this template.
Icon The icon used to represent this template in the trees.
Overview Icon The icon used to represent this template in graphical overviews.
Category The category this template belongs to. Note that this cannot be edited 

through the dialog, but can be changed using the mechanism discussed 
in section 3.1.1.4.

Description An optional short description of this template.
Manage Dimensions Specifies whether or not the dimensions of locations of this template 

should be manageable.
Application An optional external application that can be executed for locations of 

this template. Running external applications is described in section 
3.2.3.2.

Parameters Optional parameters for the application specified in the 
Application property.

Identifier Format Specifies how locations of this template should be identified 
throughout the application. This property is described in detail in 
section 3.2.1.1.

Unique Names When checked, each location of this template must have a unique 
name.

Pattern An optional pattern the names of locations of this template must adhere 
to. See section 15.8 for more on patterns.

Font Specifies the font used to display names of locations of this template in 
graphical overviews. Graphical overviews are described in chapter 7.

Table 4: Location Template Properties

3.2.1.1   Identifier Format
By default, locations are identified using a line of text containing the names of all locations that 
directly or indirectly contain the location identified. If you have many levels of locations in your 
database, this can result in very long identifiers. In this case, you can use the Identifier 
Format property of a location template to specify which other location templates should be 
included in the identifier.

As an example, assume you have four location templates in your database (Campus, Building, 
Floor and Room) and you would like to have room identifiers only include the building name and 
the room name. The following steps can be used to achieve this.

1. Open the location template dialog for the Room template (see section 3.1.2 or 3.1.3).

2. Click on the value of the Identifier Format property. A dialog similar to the one 
shown in Illustration 7 will appear.
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3. Make sure only the box next to the Building template is checked.

4. Click on the OK button.

5. Click on the Apply or OK button in the location template dialog to save the changes.

3.2.2   Cabinet Templates
An example of a cabinet template dialog is shown in Illustration 8. The properties of the cabinet 
template dialog are discussed in Table 5. The U Style property can be used to specify if and how 
labels for the U positions in the cabinet should be shown on the cabinet frame. The Application 
and Parameters properties can be used to associate external applications with cabinets of the 
template. Running external applications is described in section 3.2.3.2. 

You can apply a pattern to names of cabinets of the template using the Pattern property. Patterns 
are described in section 15.8. You can use the Font and Color Name properties to specify how 
the names of cabinets of the template should be displayed in graphical overviews (see chapter 7). 
The Color, Gradient and Line Fill properties affect the appearance of cabinet boxes in 
graphical overviews.

When displaying cabinets in a cabinets overview (see section 7.3), PatchManager distinguishes 
between a cabinet's frame and the space where the equipment is placed. The dimensions of the 
equipment space can be specified using the Height, Width and Depth properties. The 
dimensions of the cabinet frame can be specified using the Top, Bottom, Left and Right 
properties. 

It is possible to override the appearance of cabinets by using frame images. When using frame 
images, the image replaces both the frame and the equipment space of cabinets, i. e. the width of the 
image corresponds to Left + Width + Right and the height of the image corresponds to Top 
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+ Height + Bottom. Note that when using frame images, it is still necessary to specify the 
dimensions of the cabinet so that PatchManager knows how to handle the different parts of the 
image.

It is also possible to specify images for cabinet doors on both sides of the cabinets by using the 
Image Front and Image Rear properties. When a cabinet in the cabinets overview is closed, 
PatchManager will display this image instead of the cabinet contents, and it will not be possible to 
directly affect the cabinet contents through the cabinets overview. See section 7.3.7 for more details 
on closed cabinets.

The dimensions specified in the cabinet template dialog directly affect what cabinets of that 
template will look like in the location overview and cabinet overview (see chapter 7). Illustrations 9 
and 10 show what a cabinet based on the template shown in Illustration 8 looks like in a location 
overview and cabinet overview respectively. Note that in the cabinet overview, 0.625 '' mounting 
strips are added on the left and right side of the equipment space. 
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Property Description
Name The unique name of this template.
Icon The icon used to represent this template where appropriate, for example 

in the trees.
Category The category this template belongs to. Note that this cannot be edited 

through the dialog, but can be changed using the mechanism discussed 
in section 3.1.1.4.

Description An optional short description of this template.
U Style Specifies whether U1 should be at the top or base of the cabinets, or if U 

values should be hidden.
Application An optional external application that can be executed for cabinets of this 

template. Running external applications is described in section 3.2.3.2.
Parameters Optional parameters for the application specified in the Application 

property.
Pattern An optional pattern the names of cabinet instances of this template must 

adhere to. See section 15.8 for more on patterns.
Font The font used to display names of cabinets of this template in graphical 

overviews (see chapter 7).
Color Name The color used to display names of cabinets of this template in graphical 

overviews (see chapter 7).
Height The physical height of the equipment space of cabinet instances of this 

template. Note that it is possible to select a different unit by clicking on 
the unit.

Width The physical width of the equipment space of cabinet instances of this 
template.

Depth The physical depth of the equipment space of cabinet instances of this 
template.

Color The color of cabinets in graphical overviews.
Gradient Specifies whether or not cabinets of this template should be displayed 

using a gradient color.
Line Fill If checked, room overviews will display cabinets using a diagonal line 

fill in the cabinet boxes instead of a solid background color.
Image Front An optional image used to display the front of a cabinet when it is 

closed.
Image Rear An optional image used to display the rear of a cabinet when it is closed.
Frame Front An optional image used to display the front cabinet frame.
Frame Rear An optional image used to display the rear cabinet frame.
Top The physical width of the top side of the cabinet frame.
Bottom The physical width of the bottom side of the cabinet frame.
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Left The physical width of the left side of the cabinet frame.
Right The physical width of the right side of the cabinet frame.

Table 5: Cabinet Template Properties
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3.2.3   Equipment Templates
Illustration 11 shows an example of the equipment template dialog. The properties are described in 
Table 6. Two icons can be specified for equipment templates. The Tree Icon is used in trees to 
represent the template and equipment instances of it. If specified, the Overview Icon is used in 
graphical overviews (see chapter 7). The Application and Parameters properties are 
discussed in section 3.2.3.2 below. 

In PatchManager, equipment instances have two sides. By default, these sides are referred to as 
front and rear. The Terms property can be used to select different terms for the two sides. An 
optional Pattern can be specified in order to impose a restriction on the labels of equipment 
instances of the template. Patterns are described in section 15.8. The Font property can be used to 
specify how equipment labels should be displayed in graphical overviews (see chapter 7).

The remaining properties apply to the appearance of equipment instances of the template. Changes 
to these properties are reflected in the design tab of the right part of the equipment template dialog. 
The design tab and the properties related to it are discussed in section 3.2.3.3. The Internal 
Connections tab is discussed in section 3.2.3.4. Shortcuts to create equipment templates based on a 
single port or a single slot are described in sections 3.2.3.5 and 3.2.3.6.

PatchManager supports the creation of modular equipment, which is equipment that is plugged into 
other equipment (see section 5.2 for more details on modular equipment). The creation of modular 
equipment templates is discussed in section 3.2.3.1).
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Property Description
Name The unique name of this template.
Tree Icon The icon used to represent this template in the trees.
Overview Icon The icon used to represent this template in graphical overviews.
Category The category this template belongs to. Note that this cannot be edited 

through the dialog, but can be changed using the mechanism discussed 
in section 3.1.1.4.

Description An optional short description of this template.
Rack mounted Selecting this property means that when adding equipment instances of 

this template to a cabinet, the equipment instances must be mounted to 
the rack. See the Mounted Width property for more details.

Application An optional external application that can be executed for equipment 
instances of this template.

Parameters Optional parameters for the application specified in the 
Application property.

Terms By default, PatchManager refers to the two sides of equipment 
instances as Front and Rear. Different terms can be specified using 
this property.

Identifier This property appears only if the equipment template has user attributes 
(see chapter 8). By default, PatchManager uses equipment labels to 
refer to equipment instances. Using the Identifier property, you 
can select a user attribute to refer to equipment instances. For example, 
if you have an equipment template with user attribute IP Address, 
you can select this user attribute as the identifier. In this case, any 
instances of the template that have their IP address set will be referred 
to using their IP address instead of their label.

Pattern An optional pattern labels of equipment instances of this template must 
adhere to. See section 15.8 for details on patterns.

Font Specifies the font used to display labels of equipment of this template 
in graphical overviews. Graphical overviews are described in chapter 7.

Background Front The background color used when displaying the front of instances of 
this template.

Background Rear The background color used when displaying the rear of instances of 
this template.

Gradient If checked, PatchManager will use a gradient background instead of a 
solid background color for both sides of equipment instances of this 
template.

Height The physical height of equipment instances of this template. Note that 
it is possible to select a different unit by clicking on the unit.

Width The physical width of equipment instances of this template. This value 
excludes the optional widths of mounting plates.
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Mounted Width The mounted width of rack mounted equipment. Note that this property 
appears only if Rack mounted is selected. For it to be possible to 
add an instance of this equipment template to a cabinet instance, the 
value for Mounted Width should be equal to or less than the value 
of Width of the template of the cabinet instance.

Depth The physical depth of equipment instances of this template.
Background Image 
Front

An optional image used to override the appearance of the background 
of the front of equipment instances of this template.

Background Image 
Rear

An optional image used to override the appearance of the background 
of the rear of equipment instances of this template.

Mounting Plates This property appears only if Rack mounted is selected. You should 
check this property when using a background image for the front of 
rack mounted equipment that does not include mounting plates.

Transparent 
Ports/Slots Front

If background images are specified that include the ports and slots on 
the equipment, this property can be checked to stop PatchManager 
from displaying ports and slots itself.

Transparent 
Ports/Slots Rear

If background images are specified that include the ports and slots on 
the equipment, this property can be checked to stop PatchManager 
from displaying ports and slots itself.

Table 6: Equipment Template Properties

3.2.3.1   Modular Equipment Templates
You can specify that an equipment template models modular equipment by making it compatible 
with port and / or slot templates. If an equipment template is compatible with a port or slot 
template, instances of the equipment template can be added to ports or slots of those templates. See 
section 5.2 for more information about modular equipment.

3.2.3.1.1   Adding Compatible Port Templates
1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Click on the  button in the tool bar above the properties table. A dialog similar to the one 
shown in Illustration 12 appears.

3. Select the port templates you would like to add as compatible port templates. 

4. Click on the OK button. The selected port templates will appear in the properties table.
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You can also choose to create a new port template by clicking on the New... button in the add 
compatible port templates dialog. If you do, the port template dialog (see section 3.2.7) will be 
opened with initial values based on the equipment template you are adding the compatible port 
template to. Once you confirm the port template dialog, the new port template will appear in the 
equipment template dialog as a compatible port template.

3.2.3.1.2   Removing Compatible Port Templates
1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the compatible port template you would like to remove in the properties table.

3. Click on the  button in the tool bar above the properties table. The selected port template 
will disappear from the properties table.

3.2.3.1.3   Adding Compatible Slot Templates
1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Click on the  button in the tool bar above the properties table. A dialog similar to the one 
shown in Illustration 13 appears.

3. Select the slot templates you would like to add as compatible slot templates.

4. Click on the OK button. The selected slot templates will appear in the properties table.
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You can also choose to create a new slot template by clicking on the New... button in the add 
compatible slot templates dialog. If you do, the slot template dialog (see section 3.2.9) will be 
opened with initial values based on the equipment template you are adding the compatible slot 
template to. Once you confirm the slot template dialog, the new slot template will appear in the 
equipment template dialog as a compatible slot template.

3.2.3.1.4   Removing Compatible Slot Templates
1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the compatible slot template you would like to remove in the properties table.

3. Click on the  button in the tool bar above the properties table. The selected slot template 
will disappear from the properties table.

3.2.3.2   Running External Applications
Using the Application and Parameters properties of an equipment template, a cable 
template, a cabinet template or a location template, it is possible to specify an external application 
that can be applied to instances of the template. The Application property specifies the path to 
the external application. The Parameters property can be used to pass parameters to the external 
application based on properties of the equipment instance.

For example, switches generally have an administration page. Using the Application and 
Parameters, it is possible to open this administration page in a web browser directly from 
PatchManager.

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Click on the value field of the Application property.

3. Click on the ... button that appears.
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4. Browse to the path of the external application (e. g. Internet Explorer) and select it.

5. Set the Parameters property to [Administration Address].

6. Add a user attribute Administration Address to the equipment template (see 
chapter 8).

7. Click on the Apply or OK button to save the changes.

It is now possible to launch the web browser for any instance of the template that has its 
Administration Address property correctly set (see section 8.4) by right-clicking on the 
equipment instance and selecting the Launch option.

When evaluating the parameters, PatchManager will replace any item within square brackets with 
the appropriate value from the template instance. Besides user attributes, the label and description 
of the equipment instance can also be used ([Label] and [Description] respectively). Any 
text outside brackets will be passed to the external application unchanged.

3.2.3.3   Equipment Template Design
The following sections describe in detail how to use the equipment template dialog to design 
equipment templates.

3.2.3.3.1   Dimensions
The dimensions of equipment instances of the template are specified using the Height, Width 
and Depth properties. For rack mounted equipment an additional Mounted Width property 
exists. When equipment is specified as rack mounted and a Mounted Width larger than Width 
is specified, PatchManager will automatically add mounting plates and screws to the appearance of 
the front of equipment instances of the template.

3.2.3.3.2   Designing the Background
The following discussion refers to the background of the fronts of equipment instances of the 
template. Unless otherwise stated the same applies to the rear background.

There are two alternatives for designing the background. The first alternative is to specify a 
background color and whether or not to use a gradient. The second alternative is to use a 
background image. When using an image, the image will be scaled to the dimensions of the 
equipment automatically. In the case of rack mounted equipment, you can use the Mounting 
Plates property to specify whether or not PatchManager should add mounting plates to the image 
for the front of the equipment.

3.2.3.3.3   Transparent Ports and Slots
If you are using a background image that includes the ports and slots on the equipment, you can 
prevent PatchManager from displaying the ports and slots itself by selecting the Transparent 
Ports/Slots Front and Transparent Ports/Slots Rear properties. Note that this 
applies to free ports and empty slots only. The ports and slots will appear in the equipment template 
dialog as dashed rectangles to make it easier to position the ports and slots over the background 
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image.

3.2.3.3.4   Adding Ports
Use the following steps to add ports to the equipment template. Note that it is possible to add ports 
to an equipment template even if it is in use. In this case, the ports will be added to all the existing 
equipment instances of the template.

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Right-click on the background at the position where you would like to add the ports. Note 
that if you are adding a single port that is the same size as the equipment, PatchManager will 
automatically position it.

3. Select the Add Ports... option. The dialog shown in Illustration 14 will appear.

4. Select the port template of the ports that are to be added. Note that the icon in front of the 
port template indicates the port's color and form.

5. Specify the grid of ports that is to be added (see section 3.2.3.3.10.2 for an explanation of 
the relevant parameters).

6. Click on the OK button. If there is enough horizontal and vertical space available, the ports 
will appear in the equipment template dialog.

7. Click on the Apply or OK button to save the changes.

3.2.3.3.5   Adding Slots
Use the following steps to add slots to the equipment template. Note that it is possible to add slots 
to an equipment template even if it is in use. In this case, the slots will be added to all the existing 
equipment instances of the template.

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Right-click on the background at the position where you would like to add the slots. Note 
that if you are adding a single slot that is the same size as the equipment, PatchManager will 
automatically position it.
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3. Select the Add Slots... option. The dialog shown in Illustration 15 will appear.

4. Select the slot template of the slots that are to be added. Note that the icon in front of the slot 
template indicates the slot's color and form.

5. Specify the grid of slots that is to be added (see section 3.2.3.3.10.2 for an explanation of the 
relevant parameters).

6. Click on the OK button. If there is enough horizontal and vertical space available and the 
depth of the equipment template is deep enough to hold the slots, the slots will appear in the 
equipment template dialog. Note that the slots will also appear on the other side of the 
equipment if the depth of the equipment is equal to the depth of the slot template.

7. Click on the Apply or OK button to save the changes.

3.2.3.3.6   Selecting Items
You can select multiple ports and slots by clicking the left mouse button anywhere on the 
background, keeping the mouse button pressed and moving the mouse to create a selection box. 
Any item that intersects the selection box is added to the selection. Alternatively, you can:

1. Select the first item by clicking on it.

2. Press the Ctrl key and keep it pressed.

3. Add items to the selection by clicking on them. Clicking on an item that is already in the 
selection will remove it from the selection.

Note that in both cases, PatchManager remembers the order in which items were added to the 
selection. For example, this order is applied when aligning items.

3.2.3.3.7   Copying Items to the Other Side
For some equipment, such as patch panels, ports on one side of the equipment have corresponding 
ports directly behind them on the other side of the equipment. A shortcut exists for creating 
equipment templates for such equipment.

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).
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2. Add the ports and slots to the equipment template dialog using the techniques discussed 
above.

3. Select the ports and slots that are to be copied to the other side using the techniques 
described in section 3.2.3.3.6.

4. Right-click on one of the selected items.

5. Select the Copy to other side option. The selected items will appear on the other 
side of the equipment directly behind their originals.

6. If necessary, use the technique discussed in section 3.2.3.3.12 to modify the templates of the 
copied items.

7. Click on the Apply or OK button to save the changes.

3.2.3.3.8   Removing Ports and Slots
Use the following steps to remove ports and slots from the equipment template. Note that it is 
possible to remove ports and slots from an equipment template even if the equipment template is in 
use, provided that the ports and slots are not occupied in any of the equipment instances of the 
template.

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the items to be removed using the techniques described in section 3.2.3.3.6.

3. Right-click on one of the selected items.

4. Select the Delete menu entry. The entry will be disabled if the delete is not allowed. If 
applicable, the items will disappear from the equipment template dialog. As an alternative 
for steps 3 and 4 you can also press the Delete key.

5. Click on the Apply or OK button to save the changes.

3.2.3.3.9   Moving Ports and Slots
The layout of ports and slots can be modified by moving the ports and slots. Invalid moves are not 
allowed; if PatchManager determines that a move results in an invalid layout, it will restore the 
original layout. Note that in the case of slots, PatchManager takes the depth of the slots on both 
sides of the equipment into account when determining whether or not a layout is valid. 
Consequently, it may not be apparent when looking at one side of the equipment why a move is not 
allowed.

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the items that are to be moved using the techniques described in section 3.2.3.3.6.

3. Move the mouse cursor over one of the selected items and press the left mouse button.

4. While keeping the mouse button pressed, move the selected items to their new location.

5. Release the mouse button. If the move is valid, the selected items will remain at their new 
position. Otherwise the former layout will be restored.

6. Click on the Apply or OK button to save the changes.
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For more precise positioning of ports and slots, use the following alternative.

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the items that are to be moved using the techniques described in section 3.2.3.3.6.

3. Press and hold one of the four arrow keys on the keyboard until the items reach the correct 
position.

4. Click on the Apply or OK button to save the changes.

3.2.3.3.10   Aligning Ports and Slots
In some cases, it is necessary to more precisely specify the positions of ports and slots. This can be 
achieved by aligning them.

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the items you would like to align using the techniques described in section 3.2.3.3.6. 
Note that the order in which items are added to the selection is relevant for the result of 
aligning the items.

3. Right-click on one of the selected items.

4. Select the Align option.

5. The dialog shown in Illustration 16 appears. You can specify either a linear align or a grid 
align. Both forms of aligning are discussed below.

6. Click on the OK button. If the specified aligning results in a valid layout the layout will be 
updated.

7. Click on the Apply or OK button in the equipment template dialog to save the changes.

3.2.3.3.10.1   Linear Aligning

When aligning linearly, all items are put in a single line. You can select to align on top, bottom, 
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left or right. Aligning on top means that after aligning, the tops of all selected items will be at 
the same height and equal to the original top of the first item in the selection. 

If you leave Modify Gap unchecked, the align function will only rearrange the selected items in 
one dimension. For example, if you align on top or bottom and leave Modify Gap unchecked, the 
align function will only affect the vertical position of the selected items.

If you select Modify Gap, the align function will affect both the horizontal and the vertical 
position of the selected items. For example, consider aligning on top with a gap of 0.5'' (note that 
you can select a different unit by clicking on the “). In this case, the position of the first item in the 
selection will stay the same. The position of the other items in the selection will be updated such 
that their tops are the same as the top of the first item, and each item is placed to the right of its 
preceding item such that there is a 0.5'' gap between the left side of the item and the right side of the 
preceding item.

3.2.3.3.10.2   Grid Aligning

An alternative to linear aligning is grid aligning, which arranges the selected items in a two-
dimensional grid. In this case, you can specify the number of columns (Columns), number of rows 
(Rows), the gap between columns (Horizontal gap) and the gap between rows (Vertical 
gap). The first item in the selection will be the top left item in the grid. The remaining items fill the 
grid left-to-right, top-to-bottom. Note that if you change the number of rows, the number of 
columns will be updated automatically based on the number of items in the selection (and vice 
versa).

3.2.3.3.11   Labeling
You can specify default labels for the ports and slots in the equipment. These labels will be applied 
to the ports and slots when an equipment instance is created from the template (after creation you 
can change the labels for equipment instances as discussed in sections 5.2.6, 5.6.1 and 5.8.1). You 
can also specify if and how port labels should appear when displaying the equipment instances. 
Note that it is possible to have multiple items in an equipment template with the same default label 
(and consequently, to have multiple items on an equipment instance with the same label).

3.2.3.3.11.1   Modifying a Single Label

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Right-click on the item whose label is to be modified.

3. Select the Edit... option.

4. Enter the new label in the dialog that appears.

5. Press Enter or click on the OK button. The label of the item will be updated to the new 
value.

6. Click on the Apply or OK button to save the changes.

3.2.3.3.11.2   Applying a Labeling Scheme

If the port and slot labels on equipment should be incremental, you can change the labels of 
multiple items by applying a labeling scheme to them using the following steps.
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1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the items for which you would like to modify the labels using the techniques 
described in section 3.2.3.3.6.

3. Right-click on one of the selected items.

4. Select the Relabel... option.

5. Specify the labeling scheme in the dialog that appears (see Illustration 18). Labeling 
schemes are discussed below.

6. Click on the OK button. If applicable, the equipment template dialog will update to reflect 
the changes.

7. Click on the Apply or OK button to save the changes.

3.2.3.3.11.3   Labeling Schemes

When modifying multiple labels, PatchManager allows you to specify a labeling scheme using a 
prefix, a starting number, a step size and optional padding zeroes. The prefix is the fixed start of the 
label that will be applied to all ports. The starting number is the number of the first port. The step 
size specifies the increment in port number for consecutive ports. Finally, padding zeroes can be 
used to make sure each port label has the same number of characters. If checked, zeroes will be 
inserted between the prefix and the port number to ensure equal-length labels.

The following examples illustrate how these parameters work together to specify the labeling 
scheme for six selected ports.
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Example 1 Example 2
Prefix A B-
Start with 1 7
Step 2 1
Padding zeroes yes no
Resulting labels: A01, A03, A05, A07, A09, A11 B-7, B-8, B-9, B-10, B-11, B-12

Table 7: Labeling Scheme Examples

3.2.3.3.11.4   Port Label Appearance

You can specify how the labels of ports should be displayed by PatchManager using the following 
steps.

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the ports for which you would like to modify label appearance using the techniques 
described in section 3.2.3.3.6.

3. Right-click on one of the selected ports.

4. Select the Label Appearance... option. A dialog similar to the one shown in 
Illustration 18 will appear.

5. Select the position, distance from port, orientation, color and font to use for the labels of the 
selected ports.

6. Click on the OK button. If applicable, the equipment template dialog will update to reflect 
the changes.

7. Click on the Apply or OK button to save the changes.
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3.2.3.3.12   Changing Port or Slot Templates
If you have added ports or slots, but decide that they should use a different template, you can 
change the template using the following steps.

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the items for which you would like to change the template using the techniques 
described in section 3.2.3.3.6. Note that you must either select ports only or slots only to be 
able to change the template.

3. Right-click on one of the selected items.

4. Select the Change Template option. A dialog similar to the one shown in Illustration 19 
will appear.

5. Select the template you would like to apply. 

6. Click on the OK button. The selected items will be updated accordingly.

7. Click on the Apply or OK button to save the changes.

3.2.3.3.13   Dual Personality Ports
PatchManager supports the specification of dual personality ports. Dual personality is a property of 
two ports that imposes the restriction that at any time, at most one of the ports can be connected. In 
the equipment template dialog you can specify dual personality for either two ports, or one port and 
one slot.

If modular equipment is plugged into a port or slot that is specified as dual personality, the dual 
personality constraint applies to all ports on the modular equipment. In case of multiple levels of 
modular equipment, dual personality constraints are inherited by all levels.

3.2.3.3.13.1   Specifying Dual Personality

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the two ports or the port and the slot using the techniques described in section 
3.2.3.3.6.

3. Right-click on either of the selected items.
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4. Select the Dual Personality menu entry. A dashed box will appear around the selected 
items.

5. Click on the Apply or OK button to save the changes.

3.2.3.3.13.2   Removing Dual Personality

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Select the two ports or the port and the slot having dual personality using the techniques 
described in section 3.2.3.3.6.

3. Right-click on either of the selected items.

4. If you selected the right items, a check mark is shown before the Dual Personality 
option. Click it to remove the dual personality.

5. Click on the Apply or OK button to save the changes.

3.2.3.3.14   Changing the Detail Level
You can zoom in and out on either side of the equipment template using the zoom boxes, as 
described in section 2.14. Scroll bars appear if necessary. The equipment template dialog also 
supports a quick scrolling button ( ) that appears to the right of the horizontal scroll bar and / or 
below the vertical scroll bar. Clicking this button will show a miniature version of the design. 
Moving the mouse over the miniature will show a red rectangle; a left mouse click causes the dialog 
to display the area in the red rectangle.

3.2.3.4   Internal Connections
Internal connections can be used to specify that a connection between two ports on an equipment 
instance exists within the equipment. Most often this is the case when equipment has ports on both 
sides. For example, the ports on the patching side of a patch panel have internal connections to the 
ports that are used for fixed connections on the other side of the panel.

Note that it is possible to internally connect one port to multiple other ports on the equipment. A 
USB hub is an example of equipment where one port is internally connected to multiple other ports. 
Also note that it is possible to create an internal connection between two ports that are on the same 
side of the equipment. For ports that have multiple terminators the internal connections can be 
specified at the terminator level.

3.2.3.4.1   Adding Internal Connections
1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Click on the Internal Connections tab.

3. Select a port by clicking on it.

4. Press the Ctrl key and keep it pressed.

5. Click on the other port of the connection. A new connection will appear in the dialog.

6. Click on the Apply or OK button to save the changes.
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When creating an internal connection between a port and the corresponding port on the other side 
(e. g. between the third port on the front and the third port on the rear) you can also right-click one 
of the ports and select the Connect one on one option. To create internal connections 
between each port and its corresponding port on the other side, you can click anywhere between the 
ports and select the Connect one on one option. To create internal connections between a 
port and all ports on the other side of the equipment you can right-click on the port and select the 
Connect to other side option.

3.2.3.4.2   Removing Internal Connections
In order to remove the internal connections of one port, perform the following steps:

1. Open the equipment template dialog (see section 3.1.2 or 3.1.3).

2. Click on the Internal Connections tab.

3. Right-click on the port whose internal connections should be removed.

4. Select the Remove connections option. The internal connections of the port will disappear.

5. Click on the Apply or OK button to save the changes.

If you would like to remove all internal connections you can also right-click anywhere between the 
ports and select the Remove connections option.

3.2.3.5   Creating an Equipment Template Based on a Single Port
A shortcut exists for creating equipment templates that represent equipment with a single port. Note 
that this shortcut cannot be used if an equipment template with the same name as the port template 
already exists.

1. Move the mouse pointer over the port template you would like to use in the templates tree.

2. Press the left mouse button.

3. While keeping the mouse button pressed, move the mouse to an equipment category. Note 
that the mouse cursor will indicate whether or not the move is allowed. Dragging an item 
near the edge of the tree will cause the tree to scroll up or down.

4. Release the mouse button. PatchManager will ask you if you would like to create the 
equipment template based on the port template. If you confirm, the equipment template will 
be created in the selected category and the equipment template dialog will open for the new 
equipment template.

3.2.3.6   Creating an Equipment Template Based on a Single Slot
The steps described in the previous section can also be used to create equipment templates based on 
slot templates.
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3.2.4   Cable Templates
Cables in PatchManager consist of one or more cable-elements and optional connectors. The cable-
elements are connected to connectors by use of termination points. The connectors on a cable can 
be used to make connections to connectors on other cables or ports on equipment. Cables can also 
be connected to ports or other cables without the use of connectors. 

Illustration 20 shows an example of the cable template dialog. The properties are described in Table
6. The Capacity property specifies the maximum number of cable-elements cables of the 
template can contain. Note that you can set the capacity of the template to a number higher than the 
number of elements specified in the dialog. In this case, cable-elements can be added to cables of 
this template after the cable has been created. This is useful for example when modeling a fiber 
cable where the cable-elements are injected while the cable is already in the ground. See 
section 5.3.1 for details on adding cables. Adding cable-elements to an existing cable is described in 
section 5.4.1.

The Application and Parameters properties can be used to associate an external application 
with locations of the template. Running external applications is described in section 3.2.3.2. The 
Required, Unique and Pattern properties can be used to impose restrictions on the labels that 
are allowed for cables of the template if no labeling scheme is specified. See section 15.8 for more 
on patterns. 
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The Labeling Scheme property can be used to apply a labeling scheme to cables of this 
template. Labeling schemes are described in section 15.5. The Font property specifies how cable 
labels should be displayed in graphical overviews (see chapter 7). The Color property specifies 
the color used to display cables of this template. The Weight and Style properties affect the 
appearance of cables of this template in graphical overviews. You can use the right part of the cable 
template dialog to design the cable template. Cable template design is described in the following 
section.

Property Description
Name The unique name of this template.
Category The category this template belongs to. Note that this cannot be edited 

through the dialog, but can be changed using the mechanism discussed in 
section 3.1.1.4.

Description An optional short description of this template.
Capacity The number of cable elements cables of this template can contain. Note 

that you can set this number higher than the number of elements defined in 
the dialog. If you do, you can later on add cable elements to cables as 
described in section 5.4.1.

Application An optional external application that can be executed for cables of this 
template. Running external applications is described in section 3.2.3.2.

Parameters Optional parameters for the application specified in the Application 
property.

Required When checked, cables of this template are required to have a non-empty 
label. Note that this property will not appear if a labeling scheme is 
selected.

Unique When checked, each cable of this template must have a unique label. Note 
that this property will not appear if a labeling scheme is selected.

Pattern An optional pattern the labels of cables of this template must adhere to. 
See section 15.8 for more on patterns. Note that this property will not 
appear if a labeling scheme is selected.

Labeling Scheme The labeling scheme applied to cables of this template. Labeling schemes 
are described in section 15.5. Note that if a labeling scheme is selected, 
labels of cables of this template cannot be changed manually.

Font Specifies the font used to display labels of cables of this template in 
graphical overviews. Graphical overviews are described in chapter 7.

Color The color used to display cables of this template.
Weight Specifies the weight of the lines representing cables of this template in 

graphical overviews (in pixels).
Style Specifies the line style used to represent cables of this template.

Table 8: Cable Template Properties
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3.2.4.1   Cable Template Design
You can design a cable template by adding cable-elements, adding connectors and connecting the 
cable-elements to the termination points on the connectors. Note that you cannot change the design 
of a cable template if cables of that template exist in the database. For a design to be valid, it must 
adhere to the following rules:

● all termination points must be connected to a cable-element and

● no two cable-elements can connect the same two termination points.

If a cable has connectors, whether or not the cable can be connected to equipment or another cable 
is determined using the compatibilities of its connectors. These compatibilities are specified in the 
connector template dialog, see section 3.2.6. If a cable does not have connectors, its cable-elements 
can be connected to any connector or port that has exactly one termination point, any terminator or 
any cable-element in another cable.

Because the actions described in the following sections are generally performed in the same dialog, 
the following sections ignore the steps of opening the cable template dialog (see section 3.1.2 or 
3.1.3) and confirming the changes (by clicking on the Apply or Save button in the cable template 
dialog).

3.2.4.1.1   Adding Cable-Elements
1. Click on the  button in the tool bar of the cable template dialog. A dialog similar to the 

one shown in Illustration 21 will appear.

2. Select the template for the cable-elements you would like to add. Note that the color of the 
icon in front of the cable-element template corresponds to the color of the cable-element.

3. Enter the number of cable-elements you would like to add.

4. Click on the OK button. The new cable-elements will appear in the cable template dialog.

3.2.4.1.2   Modifying a Cable-Element Label
1. Right-click on the cable-element whose label you would like to modify.

2. Select the Edit Label... option.
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3. In the dialog that appears, enter a new label.

4. Click on the OK button or press the Enter key on the keyboard.

3.2.4.1.3   Removing Cable-Elements
1. Right-click on the cable-element you would like to remove.

2. Select the Remove Cable-Element option. The cable-element will disappear from the 
cable template dialog.

3.2.4.1.4   Adding Connectors
1. Click on the  button in the tool bar of the cable template dialog. A dialog similar to the 

one shown in Illustration 22 will appear.

2. Select the template for the connectors you would like to add. Note that the icon in front of 
the connector template indicates the color and form of the connectors.

3. Select the side of the cable template design where you would like to add the connectors.

4. Enter the number of connectors you would like to add.

5. Click on the OK button. The new connectors will appear in the cable template dialog. Note 
that the black circles in the connector boxes represent the termination points on the 
connector.

3.2.4.1.5   Removing Connectors
1. Right-click on the connector you would like to remove.

2. Select the Remove Connector option. The connector will disappear from the cable 
template dialog.

3.2.4.1.6   Connecting a Cable-Element to a Connector
1. Move the mouse pointer over one of the circles on the cable-element you would like to 

connect. Note that this also applies to reconnecting a cable-element.

2. Press the left mouse button.
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3. While keeping the left mouse button pressed, move the mouse pointer to the termination 
point you would like to connect the cable-element to.

4. Release the mouse button. The cable-element will be connected to the selected termination 
point.

A shortcut exists for connecting the first cable-element to the first termination points on each side, 
the second cable-element to the second termination points on each side et cetera. To apply this 
shortcut, right-click on the background of the cable template design and select the 
Connect one on one option.

3.2.4.1.7   Disconnecting a Cable-Element from a Connector
1. Move the mouse pointer over one of the circles on the cable-element you would like to 

disconnect.

2. Press the left mouse button.

3. While keeping the left mouse button pressed, move the mouse pointer to the center of the 
cable template design.

4. Release the mouse button. The cable-element will be disconnected.

3.2.4.1.8   Changing the Detail Level
You can zoom in and out on the cable template design using the  and  buttons. Scroll bars 
appear if necessary. The cable template dialog also supports a quick scrolling button ( ) that 
appears to the right of the horizontal scroll bar and / or below the vertical scroll bar. Clicking this 
button will show a miniature version of the design. Moving the mouse over the miniature will show 
a red rectangle; a left mouse click causes the dialog to display the area in the red rectangle.

3.2.5   Cable-Element Templates
Illustration 23 shows an example of the cable-element template dialog. The properties are described 
in Table 9. The Color property is used when displaying cable-elements of the template, for 
example in the cable template dialog (see section 3.2.4) and the connection details (see section 6.4). 
The color is also reflected in the icon created for the cable-element template.

You can specify cable-element compatibilities to restrict the combinations of cable-element 
templates that can be used in connections. Cable-element compatibilities are described in the next 
section.

PatchManager Reference Manual Version 4.1 Page 65 / 274



Property Description
Name The unique name of this template.
Category The category this template belongs to. Note that this cannot be 

edited through the dialog, but can be changed using the 
mechanism discussed in section 3.1.1.4.

Description An optional short description of this template.
Color The color used to display cable-elements of this template.

Table 9: Cable-Element Template Properties

3.2.5.1   Cable-Element Compatibilities
By specifying cable-element compatibilities, you can ensure consistency in the use of cable-
elements in connections using multiple cables. For example, you can specify that a cable-element 
that supports duplex communication is only compatible with other cable-elements that support 
duplex communication. With this compatibility specified, PatchManager will not allow the use of a 
simplex connection if earlier in the connection path a duplex connection is present. 

When you specify cable-element compatibilities, you only have to specify each compatibility in one 
template dialog. If necessary, PatchManager will automatically update the other relevant templates. 
The following sections describe how to add and remove cable-element compatibilities.
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3.2.5.1.1   Adding Compatible Cable-Element Templates
1. Open the cable-element template dialog (see section 3.1.2 or 3.1.3).

2. Click on the  button in the tool bar above the properties table. A dialog similar to the one 
shown in Illustration 24 appears.

3. Select the cable-element templates you would like to add as compatible cable-element 
templates.

4. Click on the OK button. The selected cable-element templates will appear in the properties 
table.

3.2.5.1.2   Removing Compatible Cable-Element Templates
1. Open the cable-element template dialog (see section 3.1.2 or 3.1.3).

2. Select the compatible cable-element template you would like to remove in the properties 
table.

3. Click on the  button in the tool bar above the properties table. The selected cable-element 
template will disappear from the properties table.

3.2.6   Connector Templates
An example of the connector template dialog is shown in Illustration 25. The properties are 
described in Table 10. The Terminations property can be used to specify the number of 
termination points on the connector. For details on termination points are used see section 3.2.4.1.

The Form, Width, Height and Diameter properties specify the physical dimensions of 
connectors of the template. The Color and Image properties affect how PatchManager will 
represent the connector in the cabinets and equipment overviews (see sections 7.3 and 7.4 
respectively). Note that for connected connectors, the cabinets and equipment overviews first 
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display the port on the equipment and then display the connector over it. For this reason, it may be 
useful to select a partially transparent image for the connector template. 

In order to be able to connect connectors to ports, or to other connectors, it is necessary to specify 
compatibilities in the connector template dialog. These compatibilities are described in detail in the 
following section.
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Property Description
Name The unique name of this template.
Category The category this template belongs to.
Description An optional short description of this template.
Terminations The number of termination points on connectors of this template. 

See section 3.2.4.1 for more details on terminators.
Form Whether the connector is rectangular or circular.
Width The physical width of connector instances of this template. Note 

that this property appears only if rectangular form is selected.
Height The physical height of connector instances of this template. Note 

that this property appears only if rectangular form is selected.
Diameter The physical diameter of connector instances of this template. 

Note that this property appears only if circular form is selected.
Color The color used to display connector instances of this template.
Image An optional image used to override the appearance of the 

background of connector instances of this template.

Table 10: Connector Template Properties

3.2.6.1   Connector Compatibilities
A connector and a port, a connector and a terminator or a connector and another connector, can only 
be connected if their templates are specified to be compatible. For example, a male RJ45 connector 
on a cable is compatible with a female RJ45 port on equipment. 

Note that two connector templates or a connector template and a port template can only be 
compatible if they have the same number of terminators. A connector template can only be 
compatible with a terminator template if it has exactly one terminator. 

When you specify connector compatibilities, you only have to specify each compatibility in one 
template dialog. PatchManager will automatically update the other relevant templates.

3.2.6.1.1   Adding Compatible Port Templates
5. Open the connector template dialog (see section 3.1.2 or 3.1.3).

6. Click on the  button in the tool bar above the properties table. A dialog similar to the one 
shown in Illustration 26 appears.

7. Select the port templates you would like to add as compatible port templates.

8. Click on the OK button. The selected port templates will appear in the properties table.
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You can also choose to create a new port template by clicking on the New... button in the add 
compatible port dialog. If you do, the port template dialog (see section 3.2.7) will be opened with 
initial values based on the connector template you are adding the compatible port template to. Once 
you confirm the port template dialog, the new port template will appear in the connector template 
dialog as a compatible port template.

3.2.6.1.2   Removing Compatible Port Templates
1. Open the connector template dialog (see section 3.1.2 or 3.1.3).

2. Select the compatible port template you would like to remove in the properties table.

3. Click on the  button in the tool bar above the properties table. The selected port template 
will disappear from the properties table.

3.2.6.1.3   Adding Compatible Terminator Templates
1. Open the connector template dialog (see section 3.1.2 or 3.1.3).

2. Click on the  button in the tool bar above the properties table. A dialog similar to the one 
shown in Illustration 27 appears.

3. Select the terminator templates you would like to add as compatible terminator templates.

4. Click on the OK button. The selected terminator templates will appear in the properties table.

PatchManager Reference Manual Version 4.1 Page 70 / 274

Illustration 26: Add Compatible Port  
Dialog



You can also choose to create a new terminator template by clicking on the New... button in the 
add compatible terminator dialog. If you do, the terminator template dialog (see section 3.2.8) will 
be opened with initial values based on the connector template you are adding the compatible 
terminator template to. Once you confirm the terminator template dialog, the new terminator 
template will appear in the connector template dialog as a compatible terminator template.

3.2.6.1.4   Removing Compatible Terminator Templates
1. Open the connector template dialog (see section 3.1.2 or 3.1.3).

2. Select the compatible terminator template you would like to remove in the properties table.

3. Click on the  button in the tool bar above the properties table. The selected terminator 
template will disappear from the properties table.

3.2.6.1.5   Adding Compatible Connector Templates
1. Open the connector template dialog (see section 3.1.2 or 3.1.3).

2. Click on the  button in the tool bar above the properties table. A dialog similar to the one 
shown in Illustration 28 appears.

3. Select the connector templates you would like to add as compatible connector templates.

4. Click on the OK button. The selected connector templates will appear in the properties table.
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You can also choose to create a new connector template by clicking on the New... button in the 
add compatible connector dialog. If you do, a new connector template dialog will be opened with 
initial values based on the connector template you are adding the compatible connector template to. 
Once you confirm the new connector template dialog, the new connector template will appear in the 
original connector template dialog as a compatible connector template.

3.2.6.1.6   Removing Compatible Connector Templates
1. Open the connector template dialog (see section 3.1.2 or 3.1.3).

2. Select the compatible connector template you would like to remove in the properties table.

3. Click on the  button in the tool bar above the properties table. The selected connector 
template will disappear from the properties table.

3.2.7   Port Templates
An example of the port template dialog is shown in Illustration 29. The port template properties 
shown in the dialog are described in Table 11. The Pattern property can be used to impose a 
restriction on the labels port instances of this template can have. See section 15.8 for details on 
patterns. The remaining properties affect the design of the port. Port template design is discussed in 
detail in section 3.2.7.2.

In order to be able to connect a connector to a port, the connector template and port template must 
be compatible. Specifying compatibilities for a port template is discussed in the following section.
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Property Description
Name The unique name of this template.
Category The category this template belongs to.
Description An optional short description of this template.
Pattern An optional pattern the labels of port instances of this template must 

adhere to. See section 15.8 for more on patterns.
Form Whether the port is rectangular or circular.
Width The physical width of port instances of this template. Note that this 

property appears only if rectangular form is selected.
Height The physical height of port instances of this template. Note that this 

property appears only if rectangular form is selected.
Diameter The physical diameter of port instances of this template. Note that this 

property appears only if circular form is selected.
Color The color used to display port instances of this template.
Defect Color The color used to display defect port instances of this template. See 

section 5.6.2 for more information on defect ports.
Reserved Color The color used to display reserved port instances of this template. See 

section 5.6.3 for more information on reserved ports.
Image An optional image used to override the appearance of the background of 

the port instances of this template.
Transparent 
Terminators

If a background image is specified that includes the terminators on the 
port, this property can be checked to stop PatchManager from displaying 
terminators itself.

Table 11: Port Template Properties

3.2.7.1   Port Compatibilities
A connector and a port can only be connected if their templates are specified to be compatible. For 
example, a male RJ45 connector on a cable is compatible with a female RJ45 port on equipment. 
Note that two templates can only be compatible if they have the same number of terminators (see 
the following section for details about terminators on ports). 

When you specify compatibilities, you only have to specify each compatibility in one template 
dialog. PatchManager will automatically update the other relevant templates.

3.2.7.1.1   Adding Compatible Connector Templates
1. Open the port template dialog (see section 3.1.2 or 3.1.3).

2. Click on the  button in the tool bar above the properties table. A dialog similar to the one 
shown in Illustration 28 appears.

3. Select the connector templates you would like to add as compatible connector templates.
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4. Click on the OK button. The selected connector templates will appear in the properties table.

You can also choose to create a new connector template by clicking on the New... button in the 
add compatible connector dialog. If you do, a  connector template dialog (see section 3.2.6) will be 
opened with initial values based on the port template you are adding the compatible connector 
template to. Once you confirm the connector template dialog, the new connector template will 
appear in the port template dialog as a compatible connector template.

3.2.7.1.2   Removing Compatible Connector Templates
1. Open the port template dialog (see section 3.1.2 or 3.1.3).

2. Select the compatible connector template you would like to remove in the properties table.

3. Click on the  button in the tool bar above the properties table. The selected connector 
template will disappear from the properties table.

3.2.7.2   Port Template Design
You can design a port template by specifying the shape and size of the port, by specifying how the 
background of the port should appear and by adding terminators (see section 3.2.8) to the port. Note 
that you cannot add or remove terminators to or from a port template if ports of that template exist 
in the database.

Note that in most cases it is not necessary to add terminators. By default PatchManager treats ports 
as having a single terminator that is the same size as the port itself. This is suitable for most simple 
ports, like RJ45 ports. The option to add terminators to a port is available for modeling more 
complex ports that have multiple terminators, for example RJ21 ports. Another reason you might 
want to add a single terminator to a port is to separate the user attributes that apply to the terminator 
from those that apply to the port (see chapter 8 for details on user attributes).

The following sections describe in detail how to use the port template dialog to design port 
templates. While reading the following sections, keep in mind that in most cases it is not necessary 
to explicitly model terminators on a port.

3.2.7.2.1   Dimensions
You can use the Form property to specify if the port should be rectangular or circular. For 
rectangular ports, the Width and Height properties will appear. For circular ports the Diameter 
property will appear. Note that while editing the Width, Height or Diameter property you can 
change the unit by clicking on the unit.

3.2.7.2.2   Designing the Background
There are two alternatives for designing the background. The first alternative is to specify a 
background color. The second alternative is to specify a background image using the Image 
property. When using an image, the image will be scaled to the dimensions of the port 
automatically. Also, when designing a circular port using a background image, only the part of the 
image that falls in the circular form specified will be shown.
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3.2.7.2.3   Transparent Terminators
If you are using a background image on a port with multiple terminators and the background image 
actually displays the terminators, you can prevent PatchManager from displaying the terminators 
itself by selecting the Transparent Terminators property. The terminators will appear in 
the port template dialog as dashed rectangles (or circles) to make it easier to position the terminators 
over the background image.

3.2.7.2.4   Adding Terminators
Use the following steps to add terminators to a port template. Note that it is not possible to add 
terminators to a port template if it is in use.

1. Open the port template dialog (see section 3.1.2 or 3.1.3).

2. Right-click on the background at the position where you would like to add the terminators. 
Note that if you are adding a single terminator that is the same size as the equipment, 
PatchManager will automatically position it.

3. Select the Add Terminators... option. A dialog similar to the one shown in  will 
appear.

4. Select the terminator template of the terminators that are to be added. Note that the icon in 
front of the terminator template indicates the terminator's color and form. You can click on 
the New... button to create a new terminator template. A terminator template dialog (see 
section 3.2.8) will appear. Once you confirm the terminator template dialog, the new 
terminator template will be selected in the add terminators dialog.

5. Specify the grid of terminators that is to be added (see section 3.2.3.3.10.2 for an 
explanation of the relevant parameters).

6. Click on the OK button. If there is enough horizontal and vertical space available, the 
terminators will appear in the port template dialog.

7. Click on the Apply or OK button to save the changes.
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3.2.7.2.5   Selecting Terminators
You can select multiple terminators by clicking the left mouse button anywhere on the background, 
keeping the mouse button pressed and moving the mouse to create a selection box. Any terminator 
that intersects the selection box is added to the selection. Alternatively, you can:

1. Select the first terminator by clicking on it.

2. Press the Ctrl key and keep it pressed.

3. Add terminators to the selection by clicking on them. Clicking on a terminator that is 
already in the selection will remove it from the selection.

3.2.7.2.6   Removing Terminators
Use the following steps to remove terminators from the port template. Note that it is not possible to 
remove terminators from a port template if the port template is in use.

1. Open the port template dialog (see section 3.1.2 or 3.1.3).

2. Select the terminators to be removed using the techniques described in section 3.2.7.2.5.

3. Right-click on one of the selected terminators.

4. Select the Delete menu entry. The entry will be disabled if the delete is not allowed. If 
applicable, the terminators will disappear from the port template dialog. As an alternative for 
steps 3 and 4 you can also press the Delete key.

5. Click on the Apply or OK button to save the changes.

3.2.7.2.7   Moving Terminators
The layout of terminators can be modified by moving them. Invalid moves are not allowed; if 
PatchManager determines that a move results in an invalid layout, it will restore the original layout.

1. Open the port template dialog (see section 3.1.2 or 3.1.3).

2. Select the terminators that are to be moved using the techniques described in section 
3.2.7.2.5.

3. Move the mouse cursor over one of the selected terminators and press the left mouse button.

4. While keeping the mouse button pressed, move the selected terminators to their new 
location.

5. Release the mouse button. If the move is valid, the selected terminators will remain at their 
new position. Otherwise the former layout will be restored.

6. Click on the Apply or OK button to save the changes.

For more precise positioning of terminators, use the following alternative.

1. Open the port template dialog (see section 3.1.2 or 3.1.3).

2. Select the terminators that are to be moved using the techniques described in section 
3.2.7.2.5.

3. Press and hold one of the four arrow keys on the keyboard until the terminators reach the 
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correct position.

4. Click on the Apply or OK button to save the changes.

A final option is to select a single terminator. The X and Y coordinates of the terminator will be 
displayed in the properties table of the port template dialog. Here you can enter precise values for 
the coordinates.

3.2.7.2.8   Aligning Terminators
In some cases, it is necessary to more precisely specify the positions of terminators. This can be 
achieved by aligning them.

1. Open the port template dialog (see section 3.1.2 or 3.1.3).

2. Select the terminators you would like to align using the techniques described in section 
3.2.7.2.5. Note that the order in which items are added to the selection is relevant for the 
result of aligning the items.

3. Right-click on one of the selected items.

4. Select the Align option.

5. The dialog shown in Illustration 16 appears. This dialog works the same as it does for ports 
and slots. See section 3.2.3.3.10 for an explanation of the aligning options.

6. Click on the OK button. If the specified aligning results in a valid layout the layout will be 
updated.

7. Click on the Apply or OK button in the port template dialog to save the changes.

3.2.7.2.9   Terminator Labeling
You can specify default labels for the terminators on the port. These labels will be applied to the 
terminators when an equipment instance is created from an equipment template using the port 
template (after creation you can change the label of a terminator as discussed in section 5.7.1). You 
can also specify if and how terminator labels should appear when displaying the port instances. 
Note that it is possible to have multiple terminators on a port template with the same default label 
(and consequently, to have multiple terminators on a port instance with the same label).

3.2.7.2.9.1   Modifying a Single Label

1. Open the port template dialog (see section 3.1.2 or 3.1.3).

2. Right-click on the terminator whose label is to be modified.

3. Select the Edit... option.

4. Enter the new label in the dialog that appears.

5. Press Enter or click on the OK button. The label of the terminator will be updated to the 
new value.

6. Click on the Apply or OK button to save the changes.
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3.2.7.2.9.2   Applying a Labeling Scheme

If the terminator labels on equipment should be incremental, you can change the labels of multiple 
items by applying a labeling scheme to them, similar to ports and slots. See section 3.2.3.3.11.2 for 
details about applying a labeling scheme.

3.2.7.2.9.3   Terminator Label Appearance

You can specify how the labels of terminators should be displayed by PatchManager. This is similar 
to specifying port label appearance, as described in section 3.2.3.3.11.4.

3.2.7.2.10   Changing Terminator Templates
If you have added terminators, but decide that they should use a different template, you can change 
the template using the following steps. Note that this is not possible if the port template is in use.

1. Open the port template dialog (see section 3.1.2 or 3.1.3).

2. Select the terminators for which you would like to change the template using the techniques 
described in section 3.2.7.2.5.

3. Right-click on one of the selected terminators.

4. Select the Change Template option. A dialog similar to the one shown in Illustration 31 
will appear.

5. Select the template you would like to apply. 

6. Click on the OK button. The selected terminators will be updated accordingly.

7. Click on the Apply or OK button to save the changes.

3.2.7.2.11   Changing the Detail Level
You can zoom in and out on the port template design using the zoom box, as described in section 
2.14. Scroll bars appear if necessary. The port template dialog also supports a quick scrolling button 
( ) that appears to the right of the horizontal scroll bar and / or below the vertical scroll bar. 
Clicking this button will show a miniature version of the design. Moving the mouse over the 
miniature will show a red rectangle; a left mouse click causes the dialog to display the area in the 
red rectangle.
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3.2.7.3   Creating a Port Template Based on a Single Terminator
A shortcut exists for creating port templates that represent ports with a single terminator. In most 
cases it is not necessary to specify the terminator explicitly, but it may be useful for example to 
separate the user attributes that apply to the port from the user attributes that apply to the terminator 
(see chapter 8). Note that this shortcut cannot be used if a port template with the same name as the 
terminator template already exists.

1. Move the mouse pointer over the terminator template you would like to use in the templates 
tree.

2. Press the left mouse button.

3. While keeping the mouse button pressed, move the mouse to a port category. Note that the 
mouse cursor will indicate whether or not the move is allowed. Dragging an item near the 
edge of the tree will cause the tree to scroll up or down.

4. Release the mouse button. PatchManager will ask you if you would like to create the port 
template based on the terminator template. If you confirm, the port template will be created 
in the selected category and the port template dialog will open for the new port template.

3.2.8   Terminator Templates
Terminators are the end points of connections on ports. For simple cases where ports have a single 
terminator, it is not necessary to explicitly model terminators. Terminator templates can be used 
however to create more complex ports with multiple terminators.

An example of the terminator template dialog is shown in Illustration 32. The properties of a 
terminator template are described in Table 12. The Pattern property can be used to impose a 
restriction on the labels terminators of this template can have. See section 15.8 for details on 
patterns. 

The Form, Width, Height and Diameter properties can be used to specify the physical 
dimensions of terminators of the template. The Color, Defect Color and Reserved Color 
properties can be used to specify how terminators should appear in the PatchManager interface 
depending on their state (see sections 5.7.2 and 5.7.3 for details about defect and reserved 
terminators respectively).

You can connect connectors directly to terminators if you specify their templates to be compatible. 
Specifying compatibilities for a terminator template is discussed in the following section.
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Property Description
Name The unique name of this template.
Category The category this template belongs to.
Description An optional short description of this template.
Pattern An optional pattern the labels of terminators of this template must adhere 

to. See section 15.8 for more on patterns.
Form Whether the terminator is rectangular or circular.
Width The physical width of terminators of this template. Note that this 

property appears only if rectangular form is selected.
Height The physical height of terminators of this template. Note that this 

property appears only if rectangular form is selected.
Diameter The physical diameter of terminators of this template. Note that this 

property appears only if circular form is selected.
Color The color used to display terminators of this template.
Defect Color The color used to display defect terminators of this template. See section 

5.7.2 for more information on defect terminators.
Reserved Color The color used to display reserved terminators of this template. See 

section 5.7.3 for more information on reserved terminators.

Table 12: Terminator Template Properties

3.2.8.1   Terminator Compatibilities
A connector can only be connected directly to a terminator if their templates are specified to be 
compatible. Note that a connector template can only be compatible with a terminator template if it 
has exactly one terminator. 

When you specify compatibilities, you only have to specify each compatibility in one template 
dialog. PatchManager will automatically update the other relevant templates.

3.2.8.1.1   Adding Compatible Connector Templates
1. Open the terminator template dialog (see section 3.1.2 or 3.1.3).

2. Click on the  button in the tool bar above the properties table. A dialog similar to the one 
shown in Illustration 28 appears.

3. Select the connector templates you would like to add as compatible connector templates.

4. Click on the OK button. The selected connector templates will appear in the properties table.

You can also choose to create a new connector template by clicking on the New... button in the 
add compatible connector dialog. If you do, a  connector template dialog (see section 3.2.6) will be 
opened with initial values based on the terminator template you are adding the compatible 
connector template to. Once you confirm the connector template dialog, the new connector template 
will appear in the terminator template dialog as a compatible connector template.
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3.2.8.1.2   Removing Compatible Connector Templates
1. Open the terminator template dialog (see section 3.1.2 or 3.1.3).

2. Select the compatible connector template you would like to remove in the properties table.

3. Click on the  button in the tool bar above the properties table. The selected connector 
template will disappear from the properties table.

3.2.9   Slot Templates
Slots are positions on equipment where modular equipment can be added. The modular equipment 
may add functionality (and ports) to the equipment the slot is on. For example, personal computers 
have PCI slots in the rear where modular cards, such as networking or sound cards, may be added. 
A network card effectively adds an Ethernet port to the PC. Note that it would be possible to add the 
Ethernet port directly to the PC template, but this solution would be less flexible. It would for 
example not handle the case where not all PC's of a certain template have a network card plugged 
in.

Illustration 33 shows an example of the slot template dialog. The properties in the dialog are 
discussed in Table 13. The Background, Height and Width properties affect how empty slots 
appear in the equipment template dialog, and the cabinets and equipment overview (see sections 7.3 
and 7.4 respectively). 

The Depth property can be used to create slots that appear on both sides of the equipment by 
setting the depth of the slot to the same value as that of the equipment. In this case, when adding 
modular equipment to the slot, both sides of the modular equipment appear on the respective sides 
of the containing equipment. If the depth of the slot is less than the depth of the equipment it is on, 
the slot will only appear at the side it was added to and consequently, when viewing the containing 
equipment only the front of the modular equipment added to the slot is shown.

Some slots have an option to contain either one equipment instance, or two smaller equipment 
instances. In PatchManager this situation can be modeled by specifying snap points for the slot 
template. Snap points are discussed in the following section.
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Property Description
Name The unique name of this template.
Category The category this template belongs to. Note that this cannot be edited 

through the dialog, but can be changed using the mechanism discussed in 
section 3.1.1.4.

Description An optional short description of this template.
Height The physical height of the slot instances of this template.
Width The physical width of the slot instances of this template.
Depth The physical depth of the slot instances of this template.
Background The color used when displaying an empty slot of this template.

Table 13: Slot Template Properties

3.2.9.1   Snap Points
Snap points are positions in a slot where equipment can be attached. If you specify multiple snap 
points for a slot template you can add multiple equipment instances to slot instances of the template, 
provided that the equipment instances physically fit in the slot.
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3.2.9.1.1   Adding Snap Points
Use the following steps to add snap points to a slot template. Note that you cannot add snap points 
to a slot template if any slot instance of the template currently has modular equipment in it.

1. Open the slot template dialog (see section 3.1.2 or 3.1.3).

2. Right-click anywhere on the background of the slot.

3. Select the Add Snap Points... option. A dialog similar to the one shown in 
Illustration 34 will appear.

4. Specify the coordinates of the first snap point you would like to add. 

5. If adding multiple snap points, specify the grid coordinates for the snap points.

6. Click on the OK button. The snap points will appear on the slot as red circles.

7. Click on the Apply or OK button to save the changes.

3.2.9.1.2   Selecting Snap Points
You can select multiple snap points by clicking the left mouse button anywhere on the background, 
keeping the mouse button pressed and moving the mouse to create a selection box. Any snap point 
that intersects the selection box is added to the selection. Alternatively, you can:

1. Select the first snap point by clicking on it.

2. Press the Ctrl key and keep it pressed.

3. Add snap points to the selection by clicking on them. Clicking on a snap point that is 
already in the selection will remove it from the selection.
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3.2.9.1.3   Moving Snap Points
The layout of snap points can be modified by moving them. Invalid moves are not allowed; if 
PatchManager determines that a move results in an invalid layout, it will restore the original layout. 
Note that it is not possible to move snap points in a slot template if a slot instance of the template 
has modular equipment in it.

1. Open the slot template dialog (see section 3.1.2 or 3.1.3).

2. Select the snap points that are to be moved using the techniques described in the previous 
section.

3. Move the mouse cursor over one of the selected snap points and press the left mouse button.

4. While keeping the mouse button pressed, move the selected snap points to their new 
location.

5. Release the mouse button. If the move is valid, the selected snap points will remain at their 
new position. Otherwise the former layout will be restored.

6. Click on the Apply or OK button to save the changes.

For more precise positioning of snap points, use the following alternative.

1. Open the slot template dialog (see section 3.1.2 or 3.1.3).

2. Select the snap points that are to be moved using the techniques described in the previous 
section.

3. Press and hold one of the four arrow keys on the keyboard until the snap points reach the 
correct position.

4. Click on the Apply or OK button to save the changes.

A final option is to select a single snap point. The X and Y coordinates of the snap point will be 
displayed in the properties table of the slot template dialog. Here you can enter precise values for 
the coordinates.

3.2.9.1.4   Removing Snap Points
Use the following steps to remove snap points from the slot template. Note that it is not possible to 
remove snap points from a slot template if a slot instance of the slot template has modular 
equipment in it.

1. Open the slot template dialog (see section 3.1.2 or 3.1.3).

2. Select the snap points to be removed using the techniques described in section 3.2.9.1.2.

3. Right-click on one of the selected snap points.

4. Select the Delete menu entry. The entry will be disabled if the delete is not allowed. If 
applicable, the snap points will disappear from the slot template dialog. As an alternative for 
steps 3 and 4 you can also press the Delete key.

5. Click on the Apply or OK button to save the changes.
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3.2.9.2   Changing the Detail Level
You can zoom in and out on the slot template design using the zoom box, as described in section 
2.14. Scroll bars appear if necessary. The slot template dialog also supports a quick scrolling button 
( ) that appears to the right of the horizontal scroll bar and / or below the vertical scroll bar. 
Clicking this button will show a miniature version of the design. Moving the mouse over the 
miniature will show a red rectangle; a left mouse click causes the dialog to display the area in the 
red rectangle.
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Chapter 4: Locations
Locations in PatchManager can be used to organize the cabinets and equipment in your database, 
similar to how files are organized into folders and sub-folders in a filing system. Examples of 
locations are buildings and rooms.

Each location is associated with a location template (see section 3.2.1). The template of a location 
describes general properties of the location. Locations can contain other locations, cabinets, 
equipment and cables. PatchManager does not put any restriction on the depth of your location 
hierarchy. 

The top level in the locations tree is the enterprise. The enterprise is a location itself and is 
associated with the enterprise template. However, the enterprise differs from other locations in the 
following aspects:

• There can only be one enterprise, i. e. you cannot add new locations with the enterprise 
template.

• The enterprise cannot be deleted, moved or copied.

• The name of the enterprise is not included in location identifiers (see section 3.2.1.1).

The following sections describe how to add, modify, delete, move and copy locations respectively. 
Note that locations can also be added using an import file, as described in section 10.1.

4.1   Adding a Location
1. Right-click on the location where you would like to add a new location in the locations tree 

(see section 2.3). Alternatively you can right-click on the background of a location overview 
at the position where you would like to add the new location (see chapter 7).

2. Select the New Location... option. The dialog shown in Illustration 35 will appear. As 
an alternative for steps 1 and 2, you can also load the parent location in the property sheet 
and use the File > New Location... menu entry.

3. Enter the name and select the template of the new location.

4. Optionally enter the other values for the new location in the dialog.

5. Click on the OK button. The new location will now appear in the locations tree and if 
applicable, in the location overview.
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As a shortcut, you can also drag a location template from the templates tree to the locations tree or a 
graphical overview (see chapter 7) to create a new location. If a pattern is set for the selected 
location template, PatchManager will first ask for a location name that matches the pattern (see 
sections 3.2.1 and 15.8).

4.2   Modifying a Location
The properties of a location that can be modified are described in Table 14. You can modify these 
properties by loading the location in the property sheet (see section 2.5).
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Property Description
Name The name of the location.
Description An optional short description for the location.
Background An optional background image for the location overview (see chapter 7).
Length The length of the location. If both length and breadth are specified and not 

zero, the graphical overview of the location will indicate the location bounds 
using a dashed rectangle (see section 7.2 for details on location overviews). 
Note that this property appears only if the Manage Dimensions property 
of the location template is checked (see section 3.2.1).

Breadth The breadth of the location. If both length and breadth are specified and not 
zero, the graphical overview of the location will indicate the location bounds 
using a dashed rectangle (see section 7.2 for details on location overviews). 
Note that this property appears only if the Manage Dimensions property 
of the location template is checked (see section 3.2.1).

Table 14: Location Properties
You can also modify a location using the following steps.

1. Right-click on the location you would like to modify in the locations tree (see section 2.3) or 
in the location overview of its parent location (see chapter 7). You can also right-click on the 
background of the location overview of the location itself (see chapter 7).

2. Select the Edit... option. A dialog similar to the one shown in Illustration 35 will appear 
with the values for the location filled in. As an alternative for steps 1 and 2, you can also 
load the location that is to be modified in the property sheet and use the File > 
Edit... menu entry.

3. Enter the values for the location in the dialog.

4. Click on the OK button. If applicable the interface will update according to the changes.

4.3   Deleting a Location
1. Select the location that is to be deleted in the locations tree (see section 2.3) or in a location 

overview (see chapter 7). Note that you can also select multiple items for deletion.

2. Right-click on the selected location. 

3. Select the Delete option. As an alternative to steps 2 and 3, you can also press the 
Delete key on the keyboard or use the File > Delete menu entry.

4. Confirm the deletion in the dialog that appears. Note that if the location that is to be deleted 
is not empty (i. e. has cabinets or equipment in it) PatchManager will ask you if you would 
like to delete the contents of the location as well. The location, and if applicable its contents, 
will be deleted and the interface will be updated accordingly.

Another option for deleting a location is to right-click on the background of the its location 
overview and select the Delete option.
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4.4   Moving a Location
You can move locations to a different part of the locations tree using drag and drop. You can initiate 
the drag from the locations tree (see section 2.3) or from a location overview (see section 7.2). Note 
that in the last case, you should press the Ctrl button on the keyboard while starting the drag 
operation.

You can drop a location on another location in the locations tree, or in the graphical overview of the 
destination location. As an alternative to drag and drop, you can also use cut and paste, as described 
in the following steps.

1. Select the location you would like to move.

2. Select the Edit > Cut menu entry, or simultaneously press the Ctrl and X keys on the 
keyboard. As an alternative to steps 1 and 2 you can also right-click on the location you 
would like to move and select the Cut option.

3. Select the destination location you would like to move the location to.

4. Select the Edit > Paste menu entry, or simultaneously press the Ctrl and V keys on 
the keyboard. The interface will update to reflect the changes. As an alternative to steps 3 
and 4 you can also right-click on the destination location and select the Paste option.

4.5   Copying Locations
You can create a copy of a location, and all its contents (including connections), using the following 
steps.

1. Right-click on the location you would like to copy (for example in the locations tree or a 
graphical overview).

2. Select the Copy option. As an alternative to steps 1 and 2 you can also select the location 
and use the Edit > Copy menu entry or simultaneously press the Ctrl and C keys on 
the keyboard.

3. Right-click on the location where you would like to create the copy (for example in the 
locations tree or a graphical overview). 

4. Select the Paste option. A copy of the location used in steps 1 and 2 will be created. As an 
alternative to steps 3 and 4 you can also select the destination location and use the Edit > 
Paste menu entry or press the Ctrl and V keys on the keyboard.

Note that you can select multiple locations to copy. All connections between the selected locations 
will be copied as well (see chapter 6 for details on connections).
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Chapter 5: Network Objects
PatchManager models the cabinets, equipment, cables, cable-elements, connectors, ports, 
terminators, slots and connections in your network infrastructure. Cabinets, equipment, cables, 
cable-elements, connectors, ports, terminators and slots are discussed in sections 5.1 through to 5.8. 
Connections are discussed in chapter 6.

5.1   Cabinets
Cabinets can be used to organize the equipment in a location. A cabinet contains a number of U 
positions that can be used to mount equipment. Cabinets have a front and a rear side. When 
determining whether or not equipment fits in a cabinet, PatchManager takes into account the 
physical dimensions of both the cabinet and the equipment. The physical dimensions, along with 
other attributes, of a cabinet are stored in cabinet templates, as discussed in section 3.2.2. You can 
view cabinets and the equipment they contain using the cabinets overview, which is described in 
section 7.3.

5.1.1   Adding a Cabinet
1. Open the graphical overview for the location where you would like to add cabinets (see 

section 7.1.1).

2. Place the mouse pointer over the cabinet template you would like to use to add cabinets.

3. Press the left mouse button.

4. While keeping the left mouse button pressed, move the mouse pointer to the appropriate 
position in the graphical overview.

5. Release the mouse button. The cabinet will appear in the graphical overview. If a pattern is 
set for the selected cabinet template, PatchManager will first ask for a cabinet name that 
matches the pattern (see sections 3.2.2 and 15.8).

5.1.2   Copying a Cabinet
You can create a copy of a cabinet and all its contents, including connections, using the following 
steps.

1. Right-click on the cabinet you would like to copy (for example in the locations tree or a 
graphical overview).

2. Select the Copy option. As an alternative to steps 1 and 2 you can also select the cabinet and 
use the Edit > Copy menu entry or press the Ctrl and C keys on the keyboard.

3. Right-click on the location where you would like to create the copy (for example in the 
locations tree or a graphical overview). 

4. Select the Paste option. A copy of the cabinet used in steps 1 and 2 will be created. As an 
alternative to steps 3 and 4 you can also select the location and use the Edit > Paste 
menu entry or press the Ctrl and V keys on the keyboard.

Note that you can select multiple cabinets to copy. All connections between the selected cabinets 
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will be copied as well (see chapter 6 for details on connections).

5.1.3   Adding Multiple Cabinets
You can use the following steps to add multiple cabinets of the same cabinet template to a location.

1. Right-click on the location where you would like to add cabinets (for example in the 
locations tree).

2. Select the New Cabinets... option. A dialog similar to the one shown in Illustration 36 
will appear. As an alternative for steps 1 and 2, you can also select the location and use the 
File > New Cabinets... menu entry or keep the Ctrl key on the keyboard pressed 
while performing the steps described in section 5.1.1.

3. Select the cabinet template you would like to use for the new cabinets.

4. Specify the grid parameters used to determine the amount and positions of the cabinets to 
add.

5. Specify the naming scheme for the cabinets. Naming schemes are explained in section 
5.1.3.1. Please note that the naming scheme is ignored if a pattern is set for the selected 
cabinet template. In this case, PatchManager will specifically ask for a name that matches 
the pattern for each cabinet added (see sections 3.2.2 and 15.8).

6. Click on the OK button. The cabinets will be added to the location.
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5.1.3.1   Naming Schemes
PatchManager can generate names for cabinets based on their row and column identifiers. Both for 
rows and for columns you can specify a character or number as the first identifier, a step size and 
whether the identifier should be incremented or decremented by that step size. You can specify 
separator characters that should appear between the row and column identifiers. Finally, you can tell 
PatchManager to use the column identifier first instead of the row identifier. 

Table 15 illustrates two examples of naming schemes and the resulting names when adding a 3 x 3 
grid of cabinets.

PatchManager Reference Manual Version 4.1 Page 94 / 274

Illustration 36: New Cabinets Dialog



Example 1 Example 2
Separator <empty> -
Columns First No Yes
Rows Starts With A 9
Rows Step 1 1
Rows Descending No Yes
Columns Starts 
With

1 1

Columns Step 1 1
Columns Descending No No
Resulting Names A1   A2   A3

B1   B2   B3
C1   C2   C3

1-9   2-9   3-9
1-8   2-8   3-8
1-7   2-7   3-7

Table 15: Examples of Naming Schemes

5.1.4   Modifying a Cabinet
You can modify the properties of cabinets using the property sheet (see section 2.5). The properties 
of cabinets that can be modified are described in Table 16. If you have specified user attributes for 
the cabinet template of a cabinet, you can edit the user attributes of the cabinet through the property 
sheet as well (see chapter 8 for information about user attributes).

Property Description
Name The name of the cabinet.
Description An optional short description of the cabinet.
Rotated The dimensions of the cabinet box in the room overview correspond to the 

physical dimensions of the cabinet specified in the cabinet template. The 
rotated property controls whether the width of the cabinet box should 
correspond to the width of the cabinet or the depth of the cabinet (see 
sections 3.2.2 and 7.2.11 for details).

Template The template of the cabinet. You can only assign a new template if the 
dimensions of the new template are sufficient for the equipment currently in 
the cabinet.

Color Allows you to override the color used to display the cabinet (by default this is 
the color specified in the cabinet template, see section 3.2.2).

Table 16: Cabinet Properties
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5.1.5   Moving a Cabinet
You can move cabinets to a different part of the locations tree using drag and drop. You can initiate 
the drag from the locations tree (see section 2.3) or from a location overview (see section 7.2). Note 
that in the last case, you should press the Ctrl button on the keyboard while starting the drag 
operation.

You can drop a cabinet on a location in the locations tree, or in the graphical overview of the 
destination location. As an alternative to drag and drop, you can also use cut and paste, as described 
in the following steps.

1. Select the cabinet you would like to move.

2. Select the Edit > Cut menu entry, or simultaneously press the Ctrl and X keys on the 
keyboard. As an alternative to steps 1 and 2 you can also right-click on the cabinet you 
would like to move and select the Cut option.

3. Select the location you would like to move the cabinet to.

4. Select the Edit > Paste menu entry, or simultaneously press the Ctrl and V keys on 
the keyboard. The interface will update to reflect the changes. As an alternative to steps 3 
and 4 you can also right-click on the destination location and select the Paste option.

5.1.6   Deleting a Cabinet
You can delete cabinets using the following steps. Note that you can delete cabinets even if they 
contain equipment. 

1. Select the cabinet you would like to delete (for example in the locations tree or in a 
graphical overview). If applicable, you can select multiple cabinets to delete.

2. Right-click on the selected cabinet. 

3. Select the Delete option. As an alternative for steps 2 and 3, you can also press the 
Delete key on the keyboard or use the File > Delete menu entry.

4. Confirm the deletion by clicking on the Yes button. The cabinet will be deleted. Note that 
the confirmation message tells you if the cabinet you are about to delete contains equipment.

5.2   Equipment
Equipment are devices holding ports and slots. Examples of equipment are PCs, switches, servers 
and patch panels. Equipment are modeled in the PatchManager database using equipment templates, 
as discussed in section 3.2.3. Equipment can be added to the enterprise, campuses, buildings, floors, 
rooms, cabinets and other equipment (modular). You can view the details of equipment in a 
graphical overview, as discussed in section 7.4. You can also view the connections of equipment 
using the connection details, as discussed in section 6.4.

The following discussion uses the following terms:

● regular equipment,

● rack mounted equipment and

● modular equipment.
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Regular equipment refers to stand-alone equipment in locations. Cabinets can also hold regular 
equipment. However, most often cabinets are used to hold rack mounted equipment.

Rack mounted equipment refers to equipment templates that have their Rack mounted property 
set to true (see section 3.2.3). Rack mounted equipment can be mounted in cabinets using mounting 
strips. Note however that equipment instances of a rack mounted equipment template can be added 
to locations as well. Also note that equipment of a rack mounted equipment template can be added 
to a cabinet if its mounted width is less than the width of the cabinet. In this case, the equipment 
acts as regular equipment.

Modular equipment refers to equipment that is plugged into other equipment. Modular equipment 
can be plugged into regular, rack mounted or other modular equipment. Modular equipment can be 
added when an equipment template is configured to have compatible port or slot templates (see 
section 3.2.3.1). Note that equipment templates that are compatible with ports or slots can also be 
used to create regular equipment.

5.2.1   Adding Equipment
In general, you can add equipment by dragging an equipment template from the templates tree to 
the location where you want to add the equipment. The following sections describe the specific 
steps for adding equipment to a location, adding equipment to a cabinet and adding modular 
equipment.

5.2.1.1   Adding Equipment to a Location
1. Open the graphical overview for the location where you would like to add equipment (see 

section 7.1.1).

2. Place the mouse pointer over the equipment template you would like to use to add 
equipment.

3. Press the left mouse button.

4. While keeping the left mouse button pressed, move the mouse pointer to the appropriate 
position in the graphical overview.

5. Release the mouse button. The equipment will appear in the graphical overview. If a pattern 
is set for the selected equipment template, PatchManager will first ask for a label that 
matches the pattern (see sections 3.2.3 and 15.8).

Note that you are not required to use the graphical overview when adding equipment to a location. 
You can also drag the equipment template directly to the location in the locations tree. 
PatchManager will automatically determine a position for the added equipment.

5.2.1.2   Adding Equipment to a Cabinet
1. Open a cabinets overview for the cabinet where you would like to add equipment (see 

section 7.1.1).

2. Place the mouse pointer over the equipment template you would like to use to add 
equipment.

3. Press the left mouse button.
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4. While keeping the mouse button pressed, move the mouse pointer to the appropriate 
position in the cabinets overview. The cabinets overview will show you where the 
equipment will be added.

5. By default, equipment is added at a integral U position. If you would like to add the 
equipment between U positions you can press and hold the Ctrl key on the keyboard while 
performing the next step.

6. Release the mouse button. The equipment will appear in the cabinets overview. If a pattern 
is set for the selected equipment template, PatchManager will first ask for a label that 
matches the pattern (see sections 3.2.3 and 15.8).

Note that you are not required to use the cabinets overview when adding equipment to a cabinet. 
You can also drag the equipment template directly to either the front or the rear of a cabinet in the 
locations tree, or to the cabinet itself; in the latter case, the equipment will be added in the front of 
the cabinet. PatchManager will automatically determine a position for the added equipment.

5.2.1.3   Adding Modular Equipment
1. Open the equipment overview for the equipment to which you would like to add modular 

equipment, or open a cabinets overview for the cabinet containing the equipment to which 
you would like to add modular equipment.

2. Place the mouse pointer over the equipment template you would like to use to add modular 
equipment.

3. Press the left mouse button.

4. While keeping the mouse button pressed, move the mouse pointer over the port or slot you 
would like to use for the modular equipment. Note that you can only add modular 
equipment to compatible ports and slots (see section 3.2.3.1). For slots with multiple snap 
points (see section 3.2.9.1) the snap point nearest to the mouse is used.

5. Release the mouse button. The modular equipment will appear in the graphical overview. If 
a pattern is set for the selected equipment template, PatchManager will first ask for a label 
that matches the pattern (see sections 3.2.3 and 15.8).

Note that you are not required to use the cabinets or equipment overview when adding modular 
equipment. You can also drag the equipment template directly to a compatible port or slot in the 
locations tree. In this case, for slots with multiple snap points, the snap points will be considered in 
left-to-right, top-to-bottom order.

5.2.1.4   Adding Multiple Equipment to a Location
You can add multiple equipment of the same equipment template to a location using the following 
steps.

1. Right-click on the location where you would like to add multiple equipment (for example in 
the locations tree).

2. Select the New Equipment... option. A dialog similar to that shown in Illustration 37 
will appear.

3. Select the equipment template you would like to use for the equipment.
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4. Specify the grid parameters used to determine the amount and positions of the equipment to 
add.

5. Click on the OK button. The equipment will be added to the location. If a pattern is set for 
the selected equipment template, PatchManager will first ask for a label that matches the 
pattern for each equipment added (see sections 3.2.3 and 15.8).

As an alternative to steps 1 and 2 you can also right-click on the background of the appropriate 
location overview and select New Equipment..., or keep the Ctrl key on the keyboard 
pressed while performing the steps described in section 5.2.1.1, or select the location where you 
would like to add equipment and use the File > New Equipment... menu entry.

5.2.1.5   Adding Multiple Equipment to a Cabinet
You can add multiple equipment of the same equipment template to a cabinet using the following 
steps.

1. Right-click on the cabinet side where you would like to add multiple equipment in the 
locations tree.

2. Select the New Equipment... option. A dialog similar to that shown in Illustration 38 
will appear.

3. Select the equipment template you would like to use for the equipment.

4. Enter the amount of equipment to add.

5. Click on the OK button. The equipment will be added to the cabinet, starting in the bottom of 
the cabinet.
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As an alternative to steps 1 and 2 you can also right-click on the background of the appropriate 
cabinets overview and select New Equipment..., keep the Ctrl and Shift keys on the 
keyboard pressed while performing the steps described in section 5.2.1.2, or select the cabinet side 
where you would like to add equipment and use the File > New Equipment... menu entry.

5.2.2   Copying Equipment
You can create a copy of equipment using the following steps. Note that it is currently not possible 
to copy a single modular equipment instance. You can however copy equipment containing modular 
equipment.

1. Right-click on the equipment you would like to copy (for example in the locations tree or a 
cabinets overview).

2. Select the Copy option. As an alternative to steps 1 and 2 you can also select the equipment 
and use the Edit > Copy menu entry or press the Ctrl and C keys on the keyboard.

3. Right-click on the location where you would like to create the copy (for example in the 
locations tree or a graphical overview). Note that you can copy equipment from a cabinet to 
a location and vice versa.

4. Select the Paste option. A copy of the equipment used in steps 1 and 2 will be created. As 
an alternative to steps 3 and 4 you can also select the destination location and use the Edit 
> Paste menu entry or press the Ctrl and V keys on the keyboard.

Note that you can select multiple equipment to copy. All connections between the selected 
equipment will be copied as well (see chapter 6 for details on connections).

5.2.3   Modifying Equipment
You can modify the properties of all types of equipment using the property sheet (see section 2.5). 
The properties of equipment that can be modified are described in Table 17. If you have specified 
user attributes for the equipment template of an equipment instance, you can edit the user attributes 
of the equipment instance through the property sheet as well (see chapter 8 for information about 
user attributes).

PatchManager Reference Manual Version 4.1 Page 100 / 274

Illustration 38: New Cabinet Equipment Dialog



Property Description
Label The label of the equipment.
Description An optional short description of the equipment.

Table 17: Equipment Properties

5.2.4   Moving Equipment
Equipment can be moved within its location or cabinet as described in sections 7.2.2 and 7.3.5. 
Equipment can also be moved between locations, cabinets, ports or slots using the following steps. 

1. Place the mouse pointer over the equipment you would like to move.

2. Press the left mouse button.

3. While keeping the mouse button pressed, move the mouse pointer to the position where you 
would like to move the equipment to. The mouse cursor will indicate whether or not the 
move is allowed. Note that the locations tree will scroll automatically when the mouse 
pointer is near the top or bottom edge of the view.

4. Release the mouse button. The equipment will be moved to its new position.

You can also move equipment using the following alternative.

1. Select the equipment you would like to move.

2. Right-click on the equipment you would like to move.

3. Select the Cut option. As an alternative for steps 2 and 3 you can also press the Ctrl and X 
keys on the keyboard or use the Edit > Cut menu entry.

4. Select the position you would like to move the equipment to.

5. Right-click on the position you would like to move the equipment to.

6. Select the Paste option. The equipment will be moved to its new position. As an 
alternative for steps 4 and 5 you can also press the Ctrl and V keys on the keyboard or use 
the Edit > Paste menu entry.

Note that you can move multiple regular or rack-mounted equipment by selecting multiple items in 
the locations tree before performing the steps described above. 

5.2.5   Deleting Equipment
You can delete equipment using the following steps. Note that you can delete equipment even if it is 
connected or if it contains modular equipment. The following applies to all types of equipment.

1. Select the equipment you would like to delete (for example in the locations tree or in a 
graphical overview). If applicable, you can select multiple equipment to delete.

2. Right-click on the selected equipment. 

3. Select the Delete option. As an alternative for steps 2 and 3, you can also press the 
Delete key on the keyboard or use the File > Delete menu entry.
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4. Confirm the deletion by clicking on the Yes button. The equipment will be deleted. Note 
that the confirmation message tells you if the equipment you are about to delete is 
connected.

5.2.6   Modifying Port Labeling
The following steps describe how to modify the labels of all ports on an equipment instance at the 
same time. You can also modify the label of an individual port only as described in section 5.6.1.

1. Right-click on the equipment for which you would like to modify the port labels (for 
example in the locations tree).

2. Select the Relabel... option. The dialog shown in Illustration 39 will appear. As an 
alternative for steps 1 and 2 you can also select the equipment and use the File > 
Relabel... menu entry.

3. Specify the labeling scheme. Refer to section 3.2.3.3.11.3 for an explanation of the available 
parameters.

4. Select Apply to Modules if you would like to apply the labeling scheme to the ports on 
modular equipment as well.

5. Click on the OK button. The port labels will be updated accordingly.
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5.3   Cables
Cables consist of one or more cable elements and zero or more connectors. Examples range from 
patch cables, which typically consist of one cable-element with one connector on each side, to fixed 
ground cables, which can have hundreds of cable-elements and connectors.

Cables are modeled in the PatchManager database using cable templates, as discussed in section 
3.2.4.  Cables can only be added to locations. You can view the details of a cable in the cable dialog, 
as discussed in section 6.3. You can also view the connections of cables using the connection 
details, as discussed in section 6.4.

Each cables has a capacity that specifies how many cable-elements it can hold (see section 3.2.4). If 
this capacity has not yet been reached, you can add cable-elements to the cable as described in 
section 5.4.1.

5.3.1   Adding a Cable
1. Open the location overview for the location where you would like to add a cable (see section 

7.1.1).

2. Place the mouse pointer over the cable template you would like to use to add a cable.

3. Press the left mouse button.

4. While keeping the left mouse button pressed, move the mouse pointer to the appropriate 
position in the location overview.

5. Release the mouse button. The cable will appear in the location overview. If a pattern is set 
for the selected cable template, or a label is required, PatchManager will first ask for a cable 
label that matches the pattern (see sections 3.2.4 and 15.8).

5.3.2   Adding Multiple Cables
You can add multiple cables of the same cable template to a location using the following steps.

1. Right-click on the location where you would like to add multiple cables (for example in the 
locations tree).

2. Select the New Cables... option. A dialog similar to that shown in Illustration 40 will 
appear.

3. Select the cable template you would like to use for the cables.

4. Specify the grid parameters used to determine the amount and positions of the cables to add.

5. Click on the OK button. The cables will be added to the location. If a pattern is set for the 
selected cable template, or if labels are required, PatchManager will first ask for a label that 
matches the pattern for each cable added (see sections 3.2.4 and 15.8).

PatchManager Reference Manual Version 4.1 Page 103 / 274



As an alternative to steps 1 and 2 you can also right-click on the background of the appropriate 
location overview and select New Cables..., or keep the Ctrl key on the keyboard pressed 
while performing the steps described in section 5.3.1, or select the location where you would like to 
add cables and use the File > New Cables... menu entry.

5.3.3   Modifying a Cable
You can modify the properties of cables using the property sheet (see section 2.5). The properties of 
cables that can be modified are described in Table 18. If you have specified user attributes for the 
cable template of a cable, you can edit the user attributes of the cable through the property sheet as 
well (see chapter 8 for information about user attributes).

Property Description
Label The label of the cable. Note that the label cannot be modified if a labeling 

scheme applies to the cable.
Description An optional short description of the cable.
Labeling Scheme The labeling scheme that applies to the cable. You can override the 

default value from the cable template by changing the labeling scheme for 
individual cables.

Table 18: Cable Properties

5.3.4   Moving a Cable
If a cable is unconnected, you can move it to a new location using the following steps.

1. Open the location overview of the location the cable is currently in (see section 7.2).
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2. Move the mouse pointer over the cable you would like to move.

3. Press the Ctrl key on the keyboard and the left mouse button.

4. While keeping the Ctrl key and mouse button pressed, move the mouse pointer over the 
location you would like to move the cable to in the locations tree (see section 2.3). Note that 
the mouse pointer will indicate if the move is allowed.

5. Release the mouse button and the Ctrl key. The cable will disappear from the location 
overview and will be moved to the selected location.

5.3.5   Deleting a Cable
You can delete cables using the following steps. Note that you can delete a cable even if it is 
connected.

1. Select the cable you would like to delete in the location overview (see section 7.2).

2. Right-click on the selected cable.

3. Select the Delete option. As an alternative for steps 2 and 3, you can also press the 
Delete key on the keyboard or use the File > Delete menu entry.

4. Confirm the deletion by clicking on the Yes button. The cable will be deleted. Note that the 
confirmation message tells you if the cable you are about to delete is connected.

5.4   Cable-Elements
A cable contains one or more cable-elements. If a cable has less cable-elements than the capacity set 
in the cable template (see section 3.2.4), it is possible to add cable-elements to the cable. You can 
also modify the properties of a cable-element. Note that cable-elements can have their own label, 
description and user attribute values (see chapter 8) separate of the cable they are in. 

5.4.1   Adding Cable-Elements
1. Right-click on the cable you would like to add cable-elements to.

2. Select the Add Cable-Elements... option. A dialog similar to the one shown in 
Illustration 41 will appear. Note that the dialog indicates how many cable-elements can be 
added to the cable. Also note that the Add Cable-Elements... option will be grayed 
out if no cable-elements can be added.

3. Use the  and  buttons to add cable-elements and connectors to the cable.

4. Connect the cable-elements to the connectors. This step and the previous one are similar to 
designing a cable template (see section 3.2.4.1) and the same rules for a valid design apply 
here.

5. Click on the OK button. The cable-elements and connectors will be added to the cable.

PatchManager Reference Manual Version 4.1 Page 105 / 274



5.4.2   Modifying a Cable-Element
You can modify the properties of cable-elements using the property sheet (see section 2.5). The 
properties of cable-elements that can be modified are described in Table 19. If you have specified 
user attributes for the cable-element template of a cable-element, you can edit the user attributes of 
the cable-element through the property sheet as well (see chapter 8 for information about user 
attributes).

Property Description
Label The label of the cable-element.
Description An optional short description of the cable-element.

Table 19: Cable-Element Properties

5.5   Connectors
A connector is a physical connection point on a cable used to connect the cable to a port, a 
terminator or another cable (note that it is not required to use connectors to create connections, as 
discussed in section 3.2.4.1). Connectors are created automatically when you add cables, based on 
the cable templates used (see section 3.2.4). Connectors can also be added to an existing cable as 
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discussed in section 5.4.1. Connectors can be accessed through the cable dialog (see section 6.3).

5.5.1   Modifying a Connector
You can modify the properties of connectors using the property sheet (see section 2.5). The 
properties of connectors that can be modified are described in Table 20. If you have specified user 
attributes for the connector template of a connector, you can edit the user attributes of the connector 
through the property sheet as well (see chapter 8 for information about user attributes).

Property Description
Color Allows you to override the color used to display the connector (by default this 

is the color specified in the connector template, see section 3.2.6).

Table 20: Connector Properties

5.6   Ports
Ports are the end points of connections. Examples of ports are USB ports on a PC, RJ45 ports used 
to create Ethernet connections and RJ11 ports used for telephony. Some ports can also be used to 
add modular equipment, as discussed in section 5.2.1.3.

Ports are created automatically when you add equipment based on the ports specified for the 
equipment template (see section 3.2.3.3). Ports appear in the locations tree under either the front or 
rear of the equipment they are on. If modular equipment is added to a port, that modular equipment 
will appear under the port in the locations tree. 

The following sections describe how you can modify a port label and the concept of defect ports. 
Connections between ports and cables are discussed in chapter 6.

5.6.1   Modifying a Port
The following steps describe how to modify the label of a single port. A shortcut for modifying the 
labels of multiple ports is presented in section 5.2.6.

1. Right-click on the port whose label you would like to modify (for example in the locations 
tree, a cabinets overview or an equipment overview).

2. Select the Relabel option.

3. Enter the new label for the port and click on the OK button. The port's label will be updated. 
Note that if you specified a label pattern in the port's template, the new label must match 
that pattern (see section 3.2.7).

Note that you can also modify a port's label and any user attributes applied to the port (see chapter 
8) using the property sheet, as discussed in section 2.5. You can also specify a color for a port in the 
property sheet. This color will override the color specified in the port template of the port (see 
section 3.2.7).
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5.6.2   Defect Ports
PatchManager allows you to specify that a port is defect. A defect port cannot be used to create 
connections or for adding modular equipment. Where appropriate, defect ports will be displayed 
using the defect color of the port template (see section 3.2.7).

You can specify whether or not a port is defect by modifying a port's Defect property using the 
property sheet (see section 2.5). Note that you can set the Defect property of multiple ports at the 
same time by selecting multiple ports, provided that the selected ports are either all defect or all not 
defect.

5.6.3   Reserved Ports
PatchManager allows you to specify that a port is reserved. A reserved port cannot be used to create 
connections or for adding modular equipment. Where appropriate, reserved ports will be displayed 
using the reserved color of the port template (see section 3.2.7).

You can specify whether or not a port is reserved by modifying a port's Reserved  property using 
the property sheet (see section 2.5). Note that you can set the Reserved property of multiple ports 
at the same time by selecting multiple ports, provided that the selected ports are either all reserved 
or all not reserved.

5.6.4   Modifying Terminator Labeling
Given a port with multiple terminators, the following steps describe how to modify the labels of all 
terminators on a port instance at the same time. You can also modify the label of an individual 
terminator only as described in section 5.7.1.

1. Right-click on the port for which you would like to modify the terminator labels (for 
example in the locations tree).

2. Select the Terminator Labels... option. The dialog shown in Illustration 42 will 
appear. As an alternative for steps 1 and 2 you can also select the port and use the File > 
Terminator Labels... menu entry.

3. Specify the labeling scheme. Refer to section 3.2.3.3.11.3 for an explanation of the available 
parameters.

4. Click on the OK button. The terminator labels will be updated accordingly.
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5.7   Terminators
Terminators are the end points of connections on ports. For simple cases where a port has only a 
single terminator, the terminator is not shown explicitly in the locations tree. For ports with multiple 
terminators, the terminators are shown under the ports in the locations tree. In this case, based on 
the compatibilities specified in the terminator template (see section 3.2.8), it is possible to connect 
cables directly to a terminator. Such connections are described in chapter 6.

5.7.1   Modifying a Terminator
The following steps describe how to modify the label of a single terminator. A shortcut for 
modifying the labels of multiple terminators is presented in section 5.6.4.

1. Right-click on the terminator whose label you would like to modify (for example in the 
locations tree, a cabinets overview or an equipment overview).

2. Select the Relabel option.

3. Enter the new label for the terminator and click on the OK button. The terminator's label will 
be updated. Note that if you specified a label pattern in the terminator's template, the new 
label must match that pattern (see section 3.2.8).

Note that you can also modify a terminator's label and any user attributes applied to the terminator 
(see chapter 8) using the property sheet, as discussed in section 2.5. You can also specify a color for 
a terminator in the property sheet. This color will override the color specified in the terminator 
template of the terminator (see section 3.2.8).

5.7.2   Defect Terminators
PatchManager allows you to specify that a terminator is defect. Note that this is different from 
specifying that a port is defect in that it makes it possible to specify that some terminators on the 
port are defect whereas others are not. If a port is specified as defect, all its terminators are 
considered to be defect as well. If all terminators on a port are specified as defect, the port is 
considered to be defect as well (see section 5.6.2). 
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Where appropriate, defect terminators will be displayed using the defect color of the terminator 
template (see section 3.2.8). You can specify whether or not a terminator is defect by modifying a 
terminator's Defect property using the property sheet (see section 2.5).

If a port has multiple terminators, and only some of the terminators on the port are defect, the port 
can still be used to create connections or to add modular equipment. In other words, unlike the 
defect status of a port which affects whether or not a port can be used, the defect status of a 
terminator is applied only when displaying terminators.

5.7.3   Reserved Terminators
PatchManager allows you to specify that a terminator is reserved. If a port is specified as reserved, 
all its terminators are considered to be reserved as well. If all terminators on a port are reserved, the 
port is reserved as well (see section 5.6.3). 

Where appropriate, reserved terminators will be displayed using the reserved color of the terminator 
template (see section 3.2.8). You can specify whether or not a terminator is reserved by modifying a 
terminator's Reserved property using the property sheet (see section 2.5).

If a port has multiple terminators, and only some of the terminators on the port are reserved, the 
port can still be used to create connections or add modular equipment. In other words, unlike the 
reserved status of a port which affects whether or not a port can be used, the reserved status of a 
terminator is applied only when displaying terminators.

5.8   Slots
Slots are empty positions on equipment that can be used to add modular equipment. Slots are 
created automatically when you add equipment, based on the slots specified for the equipment 
template. Slots appear in the locations tree under either the front or rear node of the equipment they 
are on. If modular equipment is added to a slot, that modular equipment will appear under the slot 
in the locations tree.

The following section describes how to modify the label of a slot. Adding modular equipment to 
slots is described in section 5.2.1.3.

5.8.1   Modifying a Slot
1. Right-click on the slot whose label you would like to modify (for example in the locations 

tree, a cabinets overview or an equipment overview).

2. Select the Relabel option.

3. Enter the new label for the slot and click on the OK button. The slot's label will be updated.

Note that you can also modify a slot's label and any user attributes applied to the slot (see 
chapter 8) using the property sheet, as discussed in section 2.5.
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Chapter 6: Connections
This chapter discusses how PatchManager allows you to manage the connections between 
equipment and cables in your network infrastructure. The basic part of a connection is an 
association between two items in the infrastructure. The following combinations of items are 
supported as connections:

• a connector and a port,

• a connector and a terminator,

• a connector and a connector on another cable,

• a cable-element and a port, provided the port has only a single terminator,

• a cable-element and a terminator,

• a cable-element and a connector, provided the connector has only a single terminator and

• a cable-element and a cable-element in another cable.

Note that connections also exist within equipment and cables. For example, the ports on the front of 
a patch panel are connected to the ports on the back, and the terminations in a connector on one side 
of a cable are connected, by cable-elements, to the terminations on the connector on the other side 
of the cable. Because these connections are common to all equipment and cables of their respective 
templates, these connections are managed in the design of the templates (see sections 3.2.3 and 
3.2.4).

Some of the above-mentioned connection options are allowed only if the templates of the relevant 
items are configured to be compatible. See section 3.2.6 for details on connector template 
compatibilities, section 3.2.7 for details on port template compatibilities and section 3.2.8 for details 
on terminator template compatibilities. 

In the following discussion, it is assumed that cables have connectors, but all the methods discussed 
apply similarly when directly connecting cable-elements.

PatchManager allows several methods to connect cables to equipment. The methods of connecting 
are described in section 6.1. Similarly, there are several methods of disconnecting cables. These are 
described in section 6.2. A general way of modifying the connections of a cable is described in 
section 6.3. Finally, section 6.4 presents the connection details view, which can be used to view the 
connections for  ports or equipment.

6.1   Connecting
The methods described below range from connecting a single port on equipment to a single 
connector on a cable to easily connecting cables with many connectors. Before applying some of 
the methods below, you should create the necessary cables as described in section 5.3.1. Note that 
section 6.3 describes a more general way of changing the connections of a cable.

6.1.1   Connecting a Cable to a Port or Terminator
1. Open the location overview the cable is located in (see section 7.2).

2. Move the mouse pointer over the cable you would like to connect.
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3. Press the Ctrl key on the keyboard and the left mouse button.

4. While keeping the Ctrl key and mouse button pressed, move the mouse pointer over the 
port or terminator you would like to connect the cable to (for example in the locations tree, 
see section 2.3).

5. Release the mouse button. The cable will be connected to the port or terminator.

Note that if there are multiple available connectors on the cable and PatchManager cannot 
determine which one to use, the dialog described in section 6.3 will be opened with the selected port 
or terminator filled in in the first available box.

6.1.2   Connecting a Port or Terminator to a Cable
1. Right-click on the port or terminator you would like to connect.

2. Select the Connect... option. A dialog similar to the one shown in Illustration 43 will 
appear. As an alternative to steps 1 and 2 you can double-click on the port or terminator, or 
select the port or terminator and use the File > Connect... menu entry.

3. Select a cable template and optionally enter a label and description for the new cable. If an 
existing cable is available, you can also select it by selecting Existing Cable and then 
selecting the cable in the box.

4. Click on the OK button. If applicable the cable will be created, and the equipment will be 
connected to the cable.

6.1.3   Connecting the Other Side of the Cable
When you use one of the methods described in the previous sections to connect a cable and the 
cable has more free connectors, PatchManager will ask if you would like to connect the other side 
of the cable as well. If you click on Yes, and PatchManager can determine which connector on the 
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other side should be connected, the dialog shown in Illustration 44 will appear (if PatchManager 
cannot determine which connector to use, it will open the dialog described in section 6.3).

You can use the port box to select the port or terminator the other side of the cable should be 
connected to. Once you click on OK, PatchManager will connect the cable you were working on to 
the selected port or terminator.

6.1.4   Free Connector Indicators
If a port or terminator is connected to a cable, and the cable has one or more free connectors, 
PatchManager will display a free connector indicator where applicable (for example in the locations 
tree, see section 2.3, and the equipment overview, see section 7.4). An example of equipment with 
free connector indicators is shown in Illustration 45.

When a free connector indicator appears, you can use it to connect the other side of the cable using 
the following steps.

1. Move the mouse pointer over the free connector indicator.

2. Press the left mouse button.

3. While keeping the left mouse button pressed, move the mouse pointer over the port or 
terminator you would like to connect the other side of the cable to.

4. Release the mouse button. If PatchManager can determine which cable connector to use, the 
other side of the cable will be connected to the selected port or terminator. Otherwise, the 
dialog described in section 6.3 will appear.

Note that in step 3, the other port or terminator is allowed to have its own free connector indicator. 
In this case, PatchManager will open the connect cables dialog allowing you to connect the first 
cable to the second cable (see section 6.1.6).
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6.1.5   Connecting a Cable to Equipment
When a cable is compatible with equipment, you can use the steps described below to connect the 
cable to the equipment. To determine if a cable and equipment are compatible, PatchManager looks 
at both sides of the cable and both sides of the equipment. Per side, it groups the free connectors by 
their connector template and the free ports by their port template. 

A cable and equipment are considered compatible if PatchManager can find a group of connectors 
on the cable and a group of ports of equal size on the equipment, where the connector template of 
the first group is compatible with the port template of the second group. For example, if a patch 
panel has 24 free copper ports on its rear, and a cable has 24 free connectors on either side that are 
compatible with the copper ports, the cable is compatible with the patch panel.

You can use the following steps to connect a cable to a compatible equipment instance.

1. Open the location overview the cable is located in (see section 7.2).

2. Move the mouse pointer over the cable you would like to connect.

3. Press the Ctrl key on the keyboard and the left mouse button.

4. While keeping the mouse button pressed, move the mouse pointer over the equipment you 
would like to connect the cable to. Note that the mouse pointer will indicate whether or not 
the cable and equipment are compatible.

5. Release the mouse button. The relevant connections will be made.

6.1.6   Connecting Two Cables
1. Open the location overview the cables are located in (see section 7.2).

2. Select the two cables you would like to connect as described in section 7.2.1.

3. Right-click on one of the cables you would like to connect.

4. Select the Connect... option. A dialog similar to the one shown in Illustration 46 will 
appear. Note that the Connect... option will be grayed out if the selected cables cannot 
be connected.

5. If applicable, reverse the cables by right-clicking on them and selecting the Reverse 
option.

6. Create the connections between the cables as described below.

7. Click on the OK button to confirm the connections. The connection between the cables will 
appear in the location overview.
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In order to connect two connectors, you can select the first connector by clicking on it, then press 
the Ctrl key on the keyboard and click on the second connector. You can connect each connector 
to the corresponding connector on the other cable by right-clicking on one of the cables and 
selecting the Connect one on one option. You can clear all connections by right-clicking on 
one of the cables and selecting the Disconnect All option. Finally, you can clear one 
connection by right-clicking on the connector and selecting the Disconnect option.

6.1.7   Quick-Connect
Quick-Connect is a shortcut for creating simple connections between two ports or terminators, or 
between groups of ports and terminators. Simple connections are cables with a single cable-
element, used to connect one port or terminator on each side. Quick-Connect is explained in the 
following sections for ports. Note that the same mechanisms apply for connecting terminators.

6.1.7.1   Connecting a Port to Another Port
1. Select the first port you would like to connect anywhere in the interface.

2. Select the second port you would like to connect anywhere in the interface. If the two ports 
you selected can be connected using quick-connect, the ports will appear in the right part of 
the tool bar above the connection details view.

3. Click on the  button in the tool bar above the connection details view. The result of 
clicking on the button depends on the state of the selected ports. Table 21 describes the 
situations in which quick-connect is allowed.
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State of ports Result of clicking on quick-connect button
Both ports disconnected. A dialog similar to the one shown in Illustration 43 will 

appear. After you specify a new cable or select an existing 
cable, it will be used to connect the two selected ports.

One port is connected. The other side 
of the cable is not connected.

The other side of the cable that is connected to the 
connected port will be connected to the disconnected port.

One port is connected. The other side 
of the cable is connected to a third 
port.

The cable will be disconnected from the third port and 
connected to the disconnected port selected for quick-
connect. Effectively the connection is moved.

Table 21: Quick-Connect Scenarios

6.1.7.2   Connecting a Group of Ports to Another Group of Ports
1. Select the first group of ports you would like to connect anywhere in the interface. Note that 

the order in which ports are selected is significant.

2. Click on the  button in the tool bar above the connection details view. This will 
temporarily store the first selection. Note that you can clear the current selection by clicking 
on the  button in the tool bar above the connection details view.

3. Select the second group of ports you would like to connect anywhere in the interface. As 
soon as the  selection contains a group of ports that can be connected to the stored group of 
ports, the  button in the tool bar above the connection details view will be enabled.

4. Click on the  button in the tool bar above the connection details view. The dialog shown 
in Illustration 47 will appear.

5. Specify the cable template, and optionally the label and description, you would like to apply 
to the new cables.

6. Click on the OK button. New cables will be created, and used to connect the selected ports.
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6.2   Disconnecting
The methods described below range from disconnecting a single port on equipment from a single 
connector on a cable to easily disconnecting cables with many connectors. Note that section 6.3 
describes a more general way of changing the connections of a cable.

6.2.1   Disconnecting a Port or Terminator
1. Right-click on the port or terminator you would like to disconnect.

2. Select the Disconnect option. As an alternative to steps 1 and 2, you can also select the 
port or terminator and use the File > Disconnect menu entry.

3. Confirm the disconnect by clicking on the Yes button. The port or terminator will be 
disconnected.

Note that you can select multiple ports or terminators and use these steps to disconnect the entire 
selection at the same time.

6.2.2   Disconnecting a Complete Connection
You can use the following steps to disconnect all simple connections involved in the full connection 
of a port or terminator. A connection is considered simple if the cable has a single cable-element. 
The full connection of a port or terminator can be displayed in the connection details view, see 
section 6.4.

1. Right-click on the port or terminator you would like to disconnect.

2. Select the Disconnect Complete Connection option. As an alternative to steps 1 
and 2 you can also select the port or terminator and use the File > Disconnect 
Complete Connection menu entry.

3. PatchManager will display the cables that will be disconnected. Confirm the disconnect by 
clicking on the Yes button. The cables will be disconnected. If a cable involved in the 
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disconnect has become completely disconnected PatchManager will ask if you would like to 
delete it.

Note that you can select multiple ports or terminators and use these steps to disconnect the complete 
connections of the entire selection at the same time.

6.2.3   Disconnecting Equipment from a Cable
1. Open the location overview the cable is located in (see section 7.2).

2. Right-click on the cable you would like to disconnect.

3. Move the mouse over the Disconnect entry. The connected cables will be displayed. 
Note that the Disconnect option will be grayed out if the cable is not connected to any 
equipment. As an alternative to steps 1 and 2 you can also select the cable and use the 
File > Disconnect menu entry.

4. Click on the equipment you would like to disconnect the cable from. All relevant connectors 
will be disconnected. Note that you can also select the Disconnect All option. In this 
case, the cable will be completely disconnected, and PatchManager will ask if you would 
like to delete the cable as well.

6.2.4   Disconnecting a Cable from Equipment
1. Right-click on the equipment you would like to disconnect (for example in the locations 

tree, see section 2.3, or a graphical overview, see chapter 7).

2. Move the mouse pointer over the Disconnect option. The connected cables will be 
displayed. Note that the Disconnect option will be grayed out if the equipment is not 
connected to any cables. As an alternative to steps 1 and 2 you can also select the equipment 
and use the File > Disconnect menu entry.

3. Click on the cable you would like to disconnect the equipment from. All relevant ports will 
be disconnected. Note that you can also select the Disconnect All option. In this case, 
the equipment will be completely disconnected, and PatchManager will ask if you would 
like to delete the equipment as well.

6.2.5   Disconnecting Cables
You can use the following steps to disconnect two connected cables.

1. Open the location overview the cables are located in (see section 7.2).

2. Right-click on one of the cables you would like to disconnect.

3. Move the mouse over the Disconnect option. The connected cables will be displayed. 
Note that the Disconnect option will be grayed out if the cable is not connected to any 
cables. As an alternative to steps 2 and 3 you can also select the cable and use the File > 
Disconnect menu entry.

4. Click on the cable you would like to disconnect the cable from. The relevant connectors will 
be disconnected.

As an alternative you can also right-click on the dashed line between the cables in the location 
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overview and select the Disconnect option.

6.3   Modifying Cable Connections
You can get a detailed view of the connections of a cable by opening the cable dialog. An example 
of the cable dialog is shown in Illustration 48. You can open the cable dialog in several ways:

● double-clicking on a cable in a graphical overview, 

● right-clicking on a cable in a graphical overview and selecting the Modify 
Connections... option,

● selecting the cable in a graphical overview and using the File > Modify 
Connections... menu entry,

● double-clicking on a connected port or terminator, 

● right-clicking on a connected port or terminator and selecting the Modify 
Connections... option and

● selecting a connected port or terminator and using the File > Modify 
Connections... menu entry.

You can use the selection boxes in the cable dialog to select new connections for the cable or to 
disconnect connectors. If you select a port, and both the cable and the equipment have more free 
connectors and ports on the relevant sides, PatchManager will ask you if you would like to connect 
the other free cable connectors to the other free ports as well. A similar option exists when you 
select a terminator.

If a cable has connectors, you can click on the squares in the cable dialog to load (and modify) the 
properties of the connectors in the property sheet (see section 2.5). You can click on the cable-
elements to load the properties of the elements. Finally, clicking on the background causes the 
properties of the cable to be loaded.
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Note that if a cable connector is used to connect the cable to another cable, the box for that 
connector will be replaced by a link to the cable dialog for the connected cable (modifying cable to 
cable connections is described in the following section).

Once you click on the OK button in the cable dialog, PatchManager will update the connections in 
the database, first disconnecting connectors, ports and terminators if necessary.

6.3.1   Modifying Cable to Cable Connections
1. Open the location overview the cables are located in (see section 7.2).

2. Right-click on the dashed line representing the cable to cable connection you would like to 
modify.

3. Select the Modify Connections... option. A dialog similar to the one shown in 
Illustration 46 will appear. As an alternative to steps 2 and 3 you can also double-click on 
the dashed line.

4. Refer to section 6.1.6 for details on how to use the dialog shown in Illustration 46

6.4   Connection Details
The connection details view allows you to view and manage the connections of one or more ports or 
terminators, or all connections of an equipment instance. An example of the connection details view 
is shown in Illustration 49. Loading the connections of ports and terminators and loading the 
connections of an equipment instance are discussed in sections 6.4.1 and 6.4.2 respectively. Section 
6.4.3 explains how connections are shown in the connection details view.

You can specify the level of detail you would like to see in the connection details. The various 
options are described in section 6.4.4. Sections 6.4.5 and 6.4.6 describe how to export and print the 
connection details.

6.4.1   Loading Connection Details for Ports or Terminators
You can load the connection details for a port by selecting it anywhere in the interface. The same 
applies to loading the connection details for a single terminator if a port has multiple terminators. 
The port for which connection details are currently showing is highlighted with a yellow 
background. Note that you can prevent PatchManager from automatically loading connections by 
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pressing the  button in the tool bar of the connection details view.

You can load the connection details for multiple ports by selecting them in the locations tree, then 
right-clicking on one of the selected ports and selecting the Connection Details option. Note 
that all selected ports must be on the same equipment for the Connection Details option to 
be enabled. The same applies for loading the connection details of multiple terminators.

6.4.2   Loading Connection Details for Equipment
Loading the connection details for an equipment instance causes the connection details view to 
show a summary of the connections of all ports on the equipment. Determining all connections for 
an equipment instance can be a very intensive task, and as such it is not automatically performed 
when you select an equipment instance. Instead, in order to load the connection details of an 
equipment instance you can right-click on the equipment and select the Connection Details 
option.

6.4.3   Connection Details Legend
The lines in the connection details view represent single cables. When viewing all connections for 
an equipment instance, a single line may represent multiple connections. In this case, a dashed line 
is used. Finally, a black dashed line is used to represent the implicit connection that exists between 
the ports on a module and the port the module is plugged into.

6.4.4   Modifying the Detail Level
You can modify the detail level of the connection details by clicking on the  button in the tool bar 
of the connection details view. The dialog shown in Illustration 50 will appear. If you check the 
Show Locations box, PatchManager will display location boxes in the connection details for 
the locations used in the connections, provided that their template is selected in the list under the 
check box. Note that you can select multiple templates by pressing the Ctrl key on the keyboard.  
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If you check the Show Cabinets box, the connection details will include boxes for the cabinets 
used in the connections. By checking the Show Attributes box you can make PatchManager 
show user attribute values of the items in the connection details view. See chapter 8 for details on 
user attributes. Finally, if you check the Show End Points box, only the end points of each 
connection will be shown. If applicable, the connection details view will update once you click on 
the OK button in the connection details settings dialog.

Note that the connection details view also supports zooming as described in section 2.14.

6.4.5   Exporting Connection Details
You can export the connection details currently showing in the connection details view to an image 
file by clicking on the  button in the tool bar above the connection details, or by right-clicking on 
the background of the connection details view and selecting the Export Image option. A file 
dialog will appear allowing you to select the location and format for the image file.

6.4.6   Printing Connection Details
You can print the connection details currently showing in the connection details view by clicking on 
the   button in the tool bar above the connection details, or by right-clicking on the background of 
the connection details view and selecting the Print Image option. The standard printing dialog 
will appear.
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Chapter 7: Graphical Overviews
You can view visual representations of the locations and network objects in the database by opening 
them in graphical overviews. Topics that are common to all graphical overviews are discussed in the 
following section. The sections thereafter discuss each type of graphical overview in detail.

7.1   Using Graphical Overviews
The following sections discuss topics that are common to all graphical overviews in PatchManager.

7.1.1   Opening a Graphical Overview
By default, when PatchManager starts it shows the graphical overview for the enterprise. A new 
graphical overview can be opened using the following steps.

1. Expand the Locations tree so that the item is showing.

2. Right-click on the item.

3. Select the X Overview option, where X is the type of overview, for example Equipment 
Overview. As an alternative to steps 2 and 3 you can also double-click on the item, or 
select the item and use the File > X Overview menu entry.

Note that you can open the front and rear nodes of cabinets and equipment directly; the graphical 
overview will open with the appropriate side showing. If a graphical overview is already open for 
the  item, PatchManager will show that overview instead of opening a new overview.

7.1.2   Navigation
Navigating the graphical overviews works very similar to web browsers. The following descriptions 
each take the graphical overview for building BUILDING-01, as shown in Illustration 51, as a 
starting point. 
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7.1.2.1   One Level Down
1. Right-click on one of the items in the overview, for example SER-02.

2. Select the graphical overview option, in this case Room Overview. The building 
overview will be replaced by the room overview. As an alternative for steps 1 and 2 you can 
also double-click on the item.

Note that the menu shown in step 2 also includes an action Show in New Tab. This option can 
be used to open a graphical overview without replacing the current overview.

7.1.2.2   One Level Up

Use the  button in the tool bar above the graphical overview in order to go up one level. In the 
situation shown in Illustration 51 this would replace the building overview with the campus 
overview for campus SMALL OFFICE.

7.1.2.3   Back / Forward

The back ( ) and forward ( ) buttons in the tool bar above the graphical overview work the same 
as they do in web browsers. For example, after having double-clicked SER-02 in the building 
overview of Illustration 51, clicking the  button would return you to the building overview for 
building BUILDING-01. Clicking the  button after that would once again open the room 
overview for room SER-02.
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7.1.3   Zooming
You can modify the zoom level of a graphical overview using the zoom box in the tool bar above 
the graphical overview, as described in section 2.14.

7.1.4   Scrolling
You can scroll through graphical overviews using the standard scroll bars to the right of and below 
the graphical overviews. PatchManager also displays a rectangle below the vertical scroll bar and / 
or to the right of the horizontal scroll bar that offers an alternative for scrolling through the 
graphical overview:

1. Click on the rectangle ( ). A miniature version of the graphical overview appears next to 
the rectangle.

2. Move the mouse over the miniature version. A red rectangle will appear.

3. When the red rectangle is over the appropriate part of the graphical overview, click the left 
mouse button. The miniature version will disappear and the graphical overview will show 
the selected part.

Another alternative is to drag the view, using the following steps:

1. Move the mouse cursor over the background of the overview.

2. Simultaneously press the alt key on the keyboard and the left mouse button.

3. While keeping both the alt key and the left mouse button pressed, move the mouse cursor. 
The view will scroll in the direction of the mouse.

7.1.5   Exporting
Graphical overviews can be exported to an image using the following steps.

1. Click on the  button in the tool bar above the graphical overview. A file selection dialog 
will appear. Alternatively, you can right-click on the background of the overview and select 
the Export > Overview option.

2. Specify the path, file name and file type of the image. PatchManager supports the GIF, 
JPEG, BMP and PNG image file formats

3. Click on the Save button. The image is saved in the appropriate location.

7.1.6   Printing
In order to print a graphical overview, click on the  button in the tool bar above the graphical 
overview. Alternatively, right-click on the background of the overview and select the Print 
Image option. The standard printing dialog will appear.

7.2   Location Overviews
A location overview visualizes four aspects of a location:

1. sub-locations in the location,
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2. equipment in the location,

3. cables in the location and

4. any connections between the above items.

You can rearrange the items in the location overviews to your preferences using the techniques 
discussed in the following sections.

7.2.1   Selecting Items
You can select locations, cabinets, equipment and connections in the location overview by clicking 
the left mouse button anywhere on the background, keeping the mouse button pressed and moving 
the mouse to create a selection box. Any item that intersects the selection box is added to the 
selection. Alternatively, you can:

1. Select the first item by clicking on it.

2. Press the Ctrl key and keep it pressed.

3. Add items to the selection by clicking on them. Clicking on an item that is already in the 
selection will remove it from the selection.

Note that in both cases, PatchManager remembers the order in which items were added to the 
selection. For example, this order is applied when aligning items. Also note that if a selected item is 
connected to other items in the graphical overview, the other items will be highlighted using an 
orange border.

7.2.2   Moving Items
1. Select the items to be moved using the techniques described in section 7.2.1.

2. Move the mouse cursor over one of the selected items and press the left mouse button.

3. While keeping the button pressed, move the mouse until the selected items reach the 
appropriate position.

4. Release the mouse button.

Alternatively, the current selection can be moved using one of the four arrow keys on the keyboard.

7.2.3   Aligning Items
Aligning items in location overviews works the same as aligning ports in the equipment template 
dialog (see section 3.2.3.3.10). The only difference is that in the location overviews the distance 
between the items is specified in pixels instead of physical dimensions.

7.2.4   Cable Hiding
Location overviews can become cluttered when showing a lot of cables. You have four options to 
reduce this clutter: cable hiding, cable grouping, cable routing and equipment grouping. Cable 
hiding is discussed in this section. Cable grouping is discussed in section 7.2.5. Cable routing is 
discussed in section 7.2.6. Finally, Equipment grouping is discussed in section 7.2.7.

Cable hiding can be used to avoid showing too many cables on the location overview. Note that 
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cable hiding is a client-side mechanism. Consequently, one user may have all cables in the location 
overview hidden, while another user has only some connections hidden. When cables are hidden, 
any item that does not have all connected cables shown will have a * appended to its name or label.

7.2.4.1   Hiding a Single Cable
1. Right-click anywhere on the cable.

2. Select the Hide Cable option. The cable will disappear from the overview, and a * will 
be appended to the names of the appropriate items.

7.2.4.2   Hiding the Cables for one Item
1. Right-click on the item.

2. Select the Hide Connections option. All cables connected to the item will disappear 
and a * will be appended to the names of the appropriate items.

7.2.4.3   Showing the Cables for one Item
1. Right-click on the item.

2. Select the Show Connections option. All cables connected to the item will reappear and 
for the appropriate items the * will be removed from the name.

7.2.4.4   Hiding all Cables
1. Right-click anywhere on the background.

2. Select the Hide Connections option. All cables in the location overview will disappear 
and a * will be appended to the names of the appropriate items.

7.2.4.5   Showing all Cables
1. Right-click anywhere on the background.

2. Select the Show Connections option. All cables in the location overview will reappear 
and for the appropriate items the * will be removed from the name.

7.2.5   Cable Grouping
In some cases multiple cables in the location overview are member of the same logical group. 
PatchManager supports this notion by allowing you to group cables in the location overview. Note 
that this is a server-side mechanism, consequently each user will have the same view.

Cable groups are indicated on the location overview using a thicker line than regular cables. Cable 
groups behave similar to regular cables and as such can be used to create larger groups. 

7.2.5.1   Creating a Cable Group
1. Select the cables or cable groups that are to be made into one group using the techniques 

described in section 7.2.1.
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2. Right-click on one of the selected cables or cable groups.

3. Select the Group option. The selected cables and cable groups will be replaced by a single 
cable group in the location overview.

7.2.5.2   Modifying a Cable Group
You can modify the properties of a cable group through the property sheet by selecting it. See 
section 2.5 for details on the property sheet. The properties of a cable group that can be modified 
are described in Table 22. Note that the initial values for these properties are derived from the 
cables use to create the cable group.

Property Description
Name The name of the cable group.
Description A short description of the cable group.
Color The color used to display the cable group in the location overview.

Table 22: Cable Group Properties

7.2.5.3   Adding a Cable to a Cable Group
1. Right-click on the cable group you would like to add a cable to.

2. Move the mouse pointer over the Add to Group option. The cables that can be added to 
the group will be displayed. Note that the Add to Group option will be grayed out if no 
cables can be added to the group.

3. Click on the cable that you would like to add to the group. The cable will disappear from the 
location overview as it is now a member of the group.

7.2.5.4   Removing a Cable from a Cable Group
1. Right-click on the cable group you would like to remove a cable from.

2. Move the mouse pointer over the Remove from Group option. The cables that can be 
removed from the group will be displayed.

3. Click on the cable that you would like to remove from the group. The cable will reappear int 
the location overview as it is no longer a member of the group. If there is only one cable left 
in the group, the group will be replaced by the cable.

Note that you can ungroup all cables in a cable group using the All option at the top of the list of 
cables that can be removed from the group.

7.2.6   Cable Routing
PatchManager allows the introduction of routing points for displaying cables.
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7.2.6.1   Adding a Routing Point
1. Move the mouse over the cables between the two points where the new routing point is to be 

added.

2. Press and hold the Shift key on the keyboard.

3. Press and hold the left mouse button.

4. Move the mouse to the position of the new routing point. The location overview will update 
accordingly.

5. Release the mouse button and the Shift key.

7.2.6.2   Moving a Routing Point
1. Move the mouse over the routing point that is to be moved.

2. Press and hold the Shift key on the keyboard.

3. Press and hold the left mouse button.

4. Move the mouse to the new position of the routing point. The location overview will update 
accordingly.

5. Release the mouse button and the Shift key.

7.2.6.3   Deleting a Routing Point
1. Move the mouse over the routing point that is to be deleted.

2. Press and hold the Shift key on the keyboard.

3. Press and hold the left mouse button.

4. Move the mouse near another routing point (or one of the end points of the connection).

5. Release the mouse button and the Shift key. The routing point will be deleted.

7.2.7   Equipment Grouping
In order to prevent overly complex location overviews, PatchManager supports the grouping of 
equipment in the overview. When equipment is grouped in a location overview, their icons and 
labels are replaced by a single icon and label and the cables connected to the grouped equipment 
will all end in the single group icon. Equipment groups are displayed using a bold font in the 
graphical overview. A group node will be introduced in the locations tree and the equipment in the 
group will be placed under the appropriate group node. The group node will be displayed using a 
bold font as well.

7.2.7.1   Creating an Equipment Group
1. Select the equipment instances that are to be grouped using the techniques described in 

7.2.1.

2. Right-click on one of the selected equipment instances.

3. Select the Group... option. A dialog similar to the one shown in Illustration 52 will 
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appear.

4. Enter the values for the group.

5. Click on the OK button. The individual equipment instances will be replaced by a single 
group item in the location overview.

7.2.7.2   Modifying an Equipment Group
1. Right-click on the equipment group in the location overview.

2. Select the Edit Group... option. A dialog similar to that shown in Illustration 52 will 
appear with the values for the group filled in.

3. Edit the values for the group.

4. Click on the OK button. The graphical overview will update according to the changes made.

Alternatively, the properties of the group can also be edited using the property sheet, as described in 
section 2.5. Selecting any of the equipment instances in the group will cause the group properties to 
be displayed here.

7.2.7.3   Deleting an Equipment Group
1. Right-click on the equipment group in the location overview.

2. Select the Ungroup option. The equipment in the group will appear in the graphical 
overview as separate items.

7.2.8   Background Images
You can specify a background image for a location overview. If you have checked the Manage 
Dimensions property in the location template of the location (see section 3.2.1) and have 
specified the dimensions of the location, the background image will be scaled to those dimensions. 
Otherwise, three pixels in the background image correspond to 1 inch on the overview (note that 

PatchManager Reference Manual Version 4.1 Page 130 / 274

Illustration 52: Equipment Group Dialog



this is significant because the sizes of the cabinet boxes correspond to the actual widths and depths 
of the cabinets).

Background images can be specified using the property sheet (see section 2.5). The following 
example illustrates setting a background image for a campus named SMALL OFFICE.

Example: Specifying a Background Image for Campus SMALL OFFICE
1. Select campus SMALL OFFICE (either in the tree or in a graphical overview). The 

properties of the campus will appear in the property sheet in the bottom left corner of the 
window.

2. Click on the field for the Background property.

3. Select an image in the tree that appears. The selected image will appear as background in the 
graphical overview for campus SMALL OFFICE.

7.2.9   Annotations
Annotations can be used to display additional information on location overviews. Annotations are 
shown over the background image (if it is specified) but under any other items in the overview. 
There are three types of annotations: text annotations, image annotations and area annotations. 
These are described in sections 7.2.9.1 through 7.2.9.3. Moving and ordering annotations are 
described in sections 7.2.9.4 and 7.2.9.5.

Note that the annotations of a location overview are shown only if the annotations button ( ) in the 
tool bar of the location overview is pressed.

7.2.9.1   Text Annotations
Text annotations can be used to add any text to a location overview. Adding, modifying and deleting 
text annotations are described in the next three sections. Text annotations can be attached to items in 
the location overview, as described in section 7.2.9.1.4. Finally, text annotations can use 
expressions, as described in section 7.2.9.1.6. 

7.2.9.1.1   Adding a Text Annotation
1. Open the location overview as described in section 7.1.1.

2. Right-click in the overview at the position where you would like to add a text annotation.

3. Select the Add Annotation > Text... option. The text annotation dialog will 
appear. An example of the text annotation dialog is shown in Illustration 53.

4. Specify the properties of the text annotation. The properties of a text annotation are 
described in Table 23.

5. Click on the Apply or OK button. The new text annotation will appear in the location 
overview.
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Property Description
Text The text of the annotation. This value can contain expressions, as 

discussed in section 7.2.9.1.6.
Transparency The transparency used when displaying this annotation.
Font The font used to display the text.
Text Color The color used to display the text.
Border Style The type of border shown around the text.
Background Color The background color of the annotation. This property appears only if a 

Border Style is selected.
Line Width The line width of the border of the annotation. This property appears 

only if a Border Style is selected.
Border Color The color used to display the border. This property appears only if a 

Border Style is selected.

Table 23: Text Annotation Properties
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7.2.9.1.2   Modifying a Text Annotation
1. Open the location overview as described in section 7.1.1.

2. Right-click on the annotation you would like to modify.

3. Select the Edit Annotation... option. The text annotation dialog will appear. An 
example of the text annotation dialog is shown in Illustration 53. As an alternative to steps 2 
and 3 you can also double-click on the annotation you would like to modify.

4. Specify the properties of the text annotation. The properties of a text annotation are 
described in Table 23.

5. Click on the Apply or OK button. The text annotation will be updated accordingly.

7.2.9.1.3   Deleting a Text Annotation
1. Open the location overview as described in section 7.1.1.

2. Right-click on the annotation you would like to delete.

3. Select the Delete Annotation option. PatchManager will ask for confirmation before 
deleting the annotation.

4. Confirm the deletion. The selected annotation will disappear from the location overview.

7.2.9.1.4   Attaching a Text Annotation
A text annotation can be attached to a location in the overview, an equipment instance in the 
overview or another position in the overview. When a text annotation is attached to an item, and the 
item is moved, the text annotation will be moved as well. You can use the following steps to attach 
a text annotation. Detaching is described in the next section.

1. Open the location overview as described in section 7.1.1.

2. Right-click on the annotation you would like to attach.

3. Select the Attach option.

4. Move the mouse over the item or the position you would like to attach the annotation to.

5. Click the left mouse button. The text annotation will be attached to the selected item or 
position.

7.2.9.1.5   Detaching a Text Annotation
1. Open the location overview as described in section 7.1.1.

2. Right-click on the annotation you would like to detach.

3. Select the Detach option. The annotation will no longer be attached.

7.2.9.1.6   Expressions
The text of a text annotation can contain expressions. These expressions are evaluated based on the 
location the text annotation is in, or in the case of attached annotations the item the annotation is 
attached to (see section 7.2.9.1.4). The expressions that can be used are described in Table 24.
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Expression Description
{name} Evaluates to the name of the item.
{qname} Evaluates to the qualified name of the item.
{template} Evaluates to the name of the template of the item.
{attributes} Evaluates to a summary of the attribute values of the item (see 

chapter 8).
{attribute:A} Evaluates to the value of user attribute A for the item (see chapter 8), 

where A can be any existing user attribute name.
{resources} Evaluates to a summary of the resource consumption in the item (see 

chapter 12). Note that this expression can only be used if the data 
center module is installed.

{resource:R} Evaluates to a summary of the consumption of resource R in the item 
(see chapter 12), where R can be any existing resource name. Note 
that this expression can only be used if the data center module is 
installed.

Table 24: Text Annotation Expressions

7.2.9.2   Image Annotations
Image annotations can be used to display an image anywhere on a location overview. The following 
sections show how to add, modify and delete image annotations.

7.2.9.2.1   Adding an Image Annotation
1. Open the location overview as described in section 7.1.1.

2. Right-click in the overview at the position where you would like to add an image 
annotation.

3. Select the Add Annotation > Image... option. The image annotation dialog will 
appear. An example of the image annotation dialog is shown in Illustration 54.

4. Specify the properties of the image annotation. The properties of an image annotation are 
described in Table 25.

5. Click on the Apply or OK button. The new image annotation will appear in the location 
overview.
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Property Description
Image The image displayed.
Transparency The transparency used when displaying this annotation.

Table 25: Image Annotation Properties

7.2.9.2.2   Modifying an Image Annotation
1. Open the location overview as described in section 7.1.1.

2. Right-click on the annotation you would like to modify.

3. Select the Edit Annotation... option. The image annotation dialog will appear. An 
example of the image annotation dialog is shown in Illustration 54. As an alternative to steps 
2 and 3 you can also double-click on the annotation you would like to modify.

4. Specify the properties of the image annotation. The properties of an image annotation are 
described in Table 25.

5. Click on the Apply or OK button. The image annotation will be updated accordingly.

7.2.9.2.3   Deleting an Image Annotation
1. Open the location overview as described in section 7.1.1.

2. Right-click on the annotation you would like to delete.

3. Select the Delete Annotation option. PatchManager will ask for confirmation before 
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deleting the annotation.

4. Confirm the deletion. The selected annotation will disappear from the location overview.

7.2.9.3   Area Annotations
Area annotations can be used to define areas in the location overview. A special feature of area 
annotations is that when they are moved, all their contents are moved as well. The following 
sections describe how to add, modify and delete area annotations.

7.2.9.3.1   Adding an Area Annotation
1. Open the location overview as described in section 7.1.1.

2. Move the mouse to one corner of the area you would like to create.

3. Press the right mouse button.

4. While keeping the right mouse button pressed, move the mouse to the opposite corner of the 
area you would like to create.

5. Release the mouse button. The area annotation will be created.

Once you have created an area annotation, you can modify its properties or modify its area as 
described in the following sections.

7.2.9.3.2   Modifying an Area Annotation
1. Open the location overview as described in section 7.1.1.

2. Right-click on the annotation you would like to modify.

3. Select the Edit Annotation... option. The area annotation dialog will appear. An 
example of the area annotation dialog is shown in . As an alternative to steps 2 and 3 you 
can also double-click on the annotation you would like to modify.

4. Specify the properties of the area annotation. The properties of an area annotation are 
described in .

5. Click on the Apply or OK button. The area annotation will be updated accordingly.
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Property Description
Transparency The transparency used when displaying this annotation.
Border Style The type of border shown around the area.
Background Color The background color of the annotation.
Line Width The line width of the border of the annotation.
Border Color The color used to display the border.

7.2.9.3.3   Modifying the Area of an Area Annotation
You can modify the area of an area annotation by entering area editing mode. In area editing mode, 
the points defining the area are displayed using small circles. Area editing mode is entered by right-
clicking on the area annotation you would like to edit and selecting the Edit Area option. You 
can exit area editing mode by either

• pressing Enter to confirm the changes or

• pressing Escape to cancel the changes.

In area editing mode, you can perform the following actions. Note that you can also move the area 
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annotation as described in section 7.2.9.4, but that in area editing mode the contents of the area will 
not be moved along.

7.2.9.3.3.1   Moving Points

1. Enter area editing mode as described above.

2. Move the mouse over the point you would like to move, and press the left mouse button.

3. While keeping the mouse button pressed, move the mouse to the new position for the point.

4. Release the mouse button.

5. Press Enter to confirm the change.

7.2.9.3.3.2   Adding Points

1. Enter area editing mode as described above.

2. Double-click on the position where you would like to add a new point.

3. Press Enter to confirm the change.

7.2.9.3.3.3   Deleting Points

1. Enter area editing mode as described above.

2. Right-click on the point you would like to delete.

3. Select the Delete option.

4. Press Enter to confirm the change.

7.2.9.3.3.4   Changing Point Type

You can introduce curves in the outline of an area by changing points to control points. Curves are 
handled as Bézier curves and therefore at most two successive points can act as control points. You 
can switch between a point between being a control point and a regular point using the following 
steps. Note that control points are shown as blue circles, whereas regular points are shown as black 
circles.

1. Enter area editing mode as described above.

2. Right-click on the point you would like to change.

3. Select the Control Point option. 

4. Press Enter to confirm the change.

7.2.9.3.4   Deleting an Area Annotation
1. Open the location overview as described in section 7.1.1.

2. Right-click on the annotation you would like to delete.

3. Select the Delete Annotation option. PatchManager will ask for confirmation before 
deleting the annotation.
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4. Confirm the deletion. The selected annotation will disappear from the location overview.

7.2.9.4   Moving Annotations
1. Open the location overview as described in section 7.1.1.

2. Move the mouse cursor over the annotation you would like to move and press the left mouse 
button.

3. While keeping the button pressed, move the mouse until the annotation reaches the 
appropriate position.

4. Release the mouse button.

Note that if you move an area annotation, all contents of the area will also be moved. If you would 
like to move an area annotation without moving its contents you can move it while modifying the 
area of it (see section 7.2.9.3.3).

7.2.9.5   Ordering Annotations
Annotations are allowed to overlap each other. Therefore it might be necessary to modify the 
ordering of annotations. This can be done by moving annotations to the back or to the front, using 
the following steps.

1. Open the location overview as described in section 7.1.1.

2. Right-click on the annotation you would like to move to the front or back.

3. Select the Move to Front or Move to Back option. The location overview will be 
updated accordingly.

7.2.10   Expanded Locations
By default, locations in a graphical overview are displayed in a collapsed state. In collapsed state, 
locations are represented by a combination of the name of the location and the icon associated with 
the template of the location (for details about location templates see section 3.2.1). You have the 
option to display a location in extended state. In this case, instead of the name and icon 
combination, the location will be represented as the location overview of that location, embedded in 
the location overview of its parent location.

While almost all actions that can be performed in a regular location overview can also be performed 
in an embedded location overview, there are some restrictions. For example, it is not possible to 
move items from one location overview into another using embedded overviews (note though that 
this can easily be done using the locations tree). The following sections describe how to expand and 
collapse locations.

7.2.10.1   Expanding a Location
1. Open the location overview as described in section 7.1.1.

2. Right-click on the icon of the location you would like to expand.

3. Select the Expand option. The location will be displayed in extended state (bordered with a 
dashed line).
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As a shortcut, you can also press the Ctrl key on the keyboard and while keeping it pressed, 
double-click on the icon of the location you would like to expand. Note that it is not possible to 
expand a location that is empty.

7.2.10.2   Collapsing a Location
1. Open the location overview as described in section 7.1.1.

2. Right-click on the background of the location you would like to collapse.

3. Select the Collapse option. The location will be displayed in collapsed state.

As a shortcut, you can also press the Ctrl key on the keyboard and while keeping it pressed, 
double-click on the background of the location you would like to expand.

7.2.11   Rotated Cabinets
Cabinets appear in the location overviews as a box representing their actual dimensions (using a 3 
pixels : 1 inch ratio). By default, the width of the box corresponds to the width of the cabinet and 
the height of the box corresponds to the depth of the cabinet (resulting in a top-view). It is possible 
to rotate cabinets so that the width of their box corresponds to the depth of the cabinet and the 
height of the box corresponds to the width of the cabinet by editing the Rotated property of the 
cabinet in the property sheet (see section 2.5).

7.2.12   Sending Cables to Front / Back
In some location overviews, cables between cabinets may become obscured by cabinet boxes. You 
can specify whether or not cables should be displayed on top of items using the following steps.

1. Right-click on the background of the location overview.

2. Select the Bring Connections to Front or Send Connections to Back 
option. The cables will appear as specified.

7.2.13   Organizing Overlapping Items
Items in location overviews are allowed to overlap. Organizing overlapping items is simple. The 
last item to be moved, as described in section 7.2.2, will appear on top of any other items in the 
overview.

7.3   Cabinets Overview
Cabinets overviews visualize the equipment in cabinets. Multiple cabinets can be shown in a single 
cabinets overview. Sections 7.3.1 through 7.3.3 discuss how to open a cabinets overview for 
multiple cabinets and how to change the cabinets displayed in a cabinets overview. Sections 7.3.4 
through 7.3.8 discuss other topics specific to cabinets overviews.

7.3.1   Opening Multiple Cabinets
1. Select the cabinets in the locations tree using the methods described in section 2.3.1, or 

select the cabinets in a room overview using the methods described in section 7.2.1. Note 
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that the order in which cabinets are added to the selection determines the ordering of the 
cabinets in the cabinets overview.

2. Right-click on one of the selected cabinets.

3. Select the Cabinets Overview option. A cabinets overview showing the selected 
cabinets will appear.

7.3.2   Adding Cabinets
You can add cabinets to a cabinets overview using the following steps. Note that this is possible 
even if there is only one cabinet in the overview. Also note that it is not possible to have the same 
cabinet shown twice in a single cabinets overview; adding a cabinet to a cabinets overview already 
containing the cabinet causes the cabinet to become the last cabinet in the overview.

1. Make sure that the cabinet that is to be added to the cabinets overview is visible in the 
locations tree and that the cabinets overview is visible.

2. Move the mouse cursor over the cabinet that is to be added to the cabinets overview.

3. Press the left mouse button and keep it pressed.

4. Move the mouse cursor over the cabinets overview.

5. Release the mouse button. The cabinet will be added to the cabinets overview at the right.

7.3.3   Removing Cabinets
You can remove cabinets from a cabinet overview, provided there are more than one cabinets in the 
overview, using the following steps.

1. Right-click on the background of the cabinet in the cabinets overview (i. e. not on an 
equipment instance).

2. Select the Remove From Overview option. The cabinet will disappear from the 
overview.

7.3.4   Switching Cabinet Side
As discussed in section 5.1, cabinets in PatchManager have a front and a rear side. The cabinets 
overview shows one side of a cabinet at a time. You can switch between the front and rear views of 
all cabinets in the overview by clicking either on the  button to show the front, or the  button to 
show the rear, in the tool bar above the cabinets overview. Alternatively, you can right-click on the 
background of a cabinet in the overview and select the Show Front or Show Rear option.

You can also switch the side of a single cabinet by clicking on the cabinet and selecting the Show 
Front of X or Show Rear of X option, where X is the name of the cabinet. This way it is 
possible to show the rear of a cabinet next to the front of another cabinet. 

7.3.5   Moving Equipment
The cabinets overview can be used to move equipment to another position in the cabinet or in 
another cabinet or to the other side of the cabinet, as discussed in the following sections.
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7.3.5.1   Moving to Another Position or Cabinet
1. Move the mouse cursor over the equipment that is to be moved.

2. Press the left mouse button and keep it pressed.

3. Move the mouse cursor to another position or another cabinet. An outline of the equipment 
will be shown at the new position and the mouse cursor will indicate whether or not the 
move is allowed. By default, the equipment will 'snap' to integral U positions in the cabinet. 
To allow for non-integral U positioning, keep the Ctrl key pressed while moving the 
mouse cursor and releasing the mouse.

4. Release the mouse button. If applicable, the equipment will be updated in the locations tree 
to show the new U position.

7.3.5.2   Snapping
For more precise positioning, PatchManager allows the 'snapping' of equipment to certain positions. 
Snapping is performed by right-clicking on the equipment and selecting one of the options in the 
Snap To menu entry. The options for snapping are described in Table 26.

Snapping Option Description
U Below Moves the equipment down until it reaches an integral U position. This 

option is not available if the equipment is currently at an integral U 
position.

U Above Moves the equipment up until it reaches an integral U position. This 
option is not available if the equipment is currently at an integral U 
position.

Equipment Below Moves the equipment down until it borders the equipment below it, or 
the bottom of the cabinet if there is no equipment below it. This option 
is not available if the equipment is currently bordering the equipment 
below it or the bottom of the cabinet.

Equipment Above Moves the equipment up until it borders the equipment above it, or the 
top of the cabinet if there is no equipment above it. This option is not 
available if the equipment is currently bordering the equipment above it 
or the top of the cabinet.

Left Moves the equipment left until it borders the equipment to the left of it, 
or the left side of the cabinet if there is no equipment to the left of it. 
This option is not available if the equipment is currently bordering the 
equipment to the left of it or the left side of the cabinet.

Right Moves the equipment right until it borders the equipment to the right of 
it, or the right side of the cabinet if there is no equipment to the right of 
it. This option is not available if the equipment is currently bordering 
the equipment to the right of it or the right side of the cabinet.

Table 26: Snapping Options
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7.3.5.3   Moving to the Other Side
Equipment can be moved to the other side of the cabinet by right-clicking on the equipment and 
selecting either the Move to Front Side or Move to Rear Side option. Note that the 
option will not be available if the equipment cannot be moved to the other side due to the space on 
the other side already being occupied by another equipment.

7.3.6   Cabinet Overview Configuration
You can configure a cabinets overview in the cabinets overview configuration dialog. An example 
of this dialog is shown in Illustration 56. You can open the cabinets overview configuration dialog 
by clicking on the  button in the tool bar at the top of the cabinets overview. The available 
settings in the cabinets overview configuration dialog are explained in the following sections.

7.3.6.1   Annotations
You can add annotations to cabinets overviews, similar to what is described for location overviews 
in section 7.2.9. Note that annotations are enabled in cabinets overviews only if the overview is 
showing a single cabinet. Also note that area annotations are not supported in cabinets overviews. 
You can hide or show the annotations for a cabinet using the Show Annotations setting in the 
cabinets overview configuration dialog.
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7.3.6.2   Equipment Labels
Cabinets overviews can be set to display labels for the equipment instances in the cabinets. The 
background color of equipment labels indicates whether or not the equipment is connected: a light 
yellow is used for equipment that is not connected; a darker orange is used for equipment that is 
connected. Connections are discussed in chapter 6.

You can hide or show equipment labels in the cabinets overview using the Show Labels setting 
in the cabinets overview configuration dialog. If labels are shown, you can use the Position 
setting to specify whether labels should appear in the center of the equipment or in the top-left 
corner. Finally, you can use the Font setting to specify the font used to display the equipment 
labels. 

7.3.7   Closed Cabinets
As discussed in section 3.2.2 it is possible to specify images for the front and rear doors of cabinets. 
If an image is specified for a cabinet door in the template of a cabinet, you can use the cabinets 
overview to open and close that door. To open or close the door on the side of the cabinet currently 
showing, you can double-click on the background of the cabinet. You can also open and close 
cabinet doors by modifying the Closed Front and Closed Rear properties of the cabinet in 
the property sheet (see section 2.5).

When a cabinet door is closed on the side of the cabinet currently showing in the cabinets overview, 
the door image will replace the contents of the cabinet. The only action that can be performed on a 
cabinet door in the cabinets overview is opening it.

7.3.8   Port Highlighting
Cabinets overviews support port highlighting as a way to visualize connections between ports. 
When the mouse cursor is over a port that is connected, the port is highlighted with a yellow border. 
Any other ports connected to the same cable will be highlighted as well. Note that this mechanism 
works across overviews, including equipment overviews. In other words, if one port of the 
connection is in one overview, and the other port is in another, then moving the mouse over either 
port will highlight both ports. Connections are discussed in chapter 6.

7.4   Equipment Overview
Equipment overviews visualize equipment instances. Equipment overviews show the ports 
(including whether the port is connected, defect or free), slots and modular equipment of equipment 
instances. 

If an equipment overview is showing equipment containing modular equipment, you can double-
click on the background of that modular equipment to open the equipment overview for that 
modular equipment. Conversely, you can click on the  button in the tool bar above the overview 
to replace an overview for modular equipment with the overview of the equipment it is plugged in 
to.

Sections 7.4.1 through 7.4.3 discuss how to open an equipment overview for multiple equipment 
and how to change the equipment displayed in an equipment overview. Sections 7.4.4 through 7.4.6 
discuss other topics specific to equipment overviews.
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7.4.1   Opening Multiple Equipment
1. Select the equipment in the locations tree using the methods described in section 2.3.1, or 

select the equipment in a graphical overview using the methods described in section 7.2.1. 
Note that the order in which equipment are added to the selection determines the ordering of 
the equipment in the equipment overview.

2. Right-click on one of the selected equipment.

3. Select the Equipment Overview option. An equipment overview showing the selected 
equipment will appear.

7.4.2   Adding Equipment
You can add equipment to an equipment overview using the following steps. Note that this is 
possible even if there is only one equipment in the overview. Also note that it is not possible to have 
the same equipment shown twice in a single equipment overview; adding equipment to an 
equipment overview already containing the equipment causes the equipment to become the last 
equipment in the overview.

1. Make sure that the equipment that is to be added to the equipment overview is visible in the 
locations tree and that the equipment overview is visible.

2. Move the mouse cursor over the equipment that is to be added to the equipment overview.

3. Press the left mouse button and keep it pressed.

4. Move the mouse cursor over the equipment overview.

5. Release the mouse button. The equipment will be added to the equipment overview at the 
right or bottom, depending on the orientation of the overview.

7.4.3   Removing Equipment
You can remove equipment from an equipment overview, provided there are more than one 
equipment in the overview, using the following steps.

1. Right-click on the background of the equipment in the equipment overview (i. e. not on a 
connector, slot or modular equipment).

2. Select the Remove From Overview option. The equipment will disappear from the 
overview.

7.4.4   Switching Equipment Side
As discussed in section 5.2, equipment instances in PatchManager have a front and a rear side. The 
equipment overview shows one side of an equipment instance at a time. You can switch between the 
front and rear views of all equipment in the overview by clicking either on the  button to show 
the front, or the  button to show the rear, in the tool bar above the equipment overview. 
Alternatively, you can right-click on the background of an equipment instance in the overview and 
select the Show Front or Show Rear option.

You can also switch the side of a single equipment by clicking on the equipment and selecting the 
Show Front of X or Show Rear of X option, where X is the label of the equipment. This 
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way it is possible to show the rear of an equipment instance next to the front of another equipment 
instance. 

7.4.5   Module and Slot Labels
Equipment overviews can be set to display the labels of slots and modular equipment it is showing. 
The background color of a label indicates whether it is a slot label or a module label. A light yellow 
is used for slot labels, a darker orange is used for module labels.

You can modify the appearance of module and slot labels in the equipment overview configuration 
dialog. An example of this dialog is shown in Illustration 57. You can use the Show Labels 
setting to hide or show labels. The Position setting affects whether labels appear in the center or 
the top-left corner of the item they apply to. The Font setting can be used to specify the font used 
to display the labels.

7.4.6   Port Highlighting
Similar to the cabinets overviews, equipment overviews support port highlighting. See section 7.3.8 
for a discussion of port highlighting.
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Chapter 8: User Attributes
User attributes can be used to store custom information about locations and network objects. Using 
user attributes, you can extend the data structures used by PatchManager in order to store your own 
information. User attributes are integrated in many parts of the software. For example, user attribute 
values can be displayed in graphical overviews using annotations (see sections 7.2.9 and 7.3.6.1) 
and are available in the import and export (see chapter 10).

An example of a user attribute is an IP address attribute for a switch equipment template. This user 
attribute would allow you to specify the IP address for each equipment instance of the template. 
Another example is a Telephone Number attribute for a hardware address port template. Using this 
attribute, it would be possible to quickly find the phone number associated with a telephone by 
loading the telephone’s connection in the connection details view and setting the connection details 
view to display user attributes (see section 6.4).

You can specify a default value for each user attribute. The default value for a user attribute is 
applied when a new instance is created from the template, or when a new location is added. You can 
also specify that a (unique) value is required for each instance using the user attribute.

User attributes accept any text as value. The values allowed can be constrained by specifying a 
pattern (see section 15.8 for more on patterns). Alternatively you can create attributes that only 
accept numbers, truth values or dates as values and even attributes that only accept values from a set 
of custom objects you created. Finally, if the data center module is installed, PatchManager supports 
SNMP and can use it to automatically retrieve values for user attributes.

The administration of user attributes can be performed centrally in the user attributes overview. The 
user attributes overview contains a user attributes tab and a custom objects tab. Examples of these 
are shown in Illustration 58 and Illustration 59. You can open the overview using the 
Administration > User Attribute Overview menu entry, or by clicking on the  
button in the tool bar at the top of the window.
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The following sections describe how to create and use user attributes. Note that creating, modifying, 
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applying a user attribute, and editing user attribute values (sections 8.1 through 8.4), can all be done 
in the same dialog and can therefore all be done at the same time.

8.1   Creating a User Attribute
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Click on the  button. The user attribute dialog will appear. An example of the user 
attribute dialog is shown in Illustration 60.

3. Enter the values for the user attribute. The name of the user attribute must be unique. Note 
that in the type drop-down menu, you can select the standard Text, Number, True or 
false, Date, and File Set options. Any custom types you create will also be available 
in the type drop-down menu. Details on file set attributes are given in section 8.5. Custom 
objects are discussed in section 8.7. See section 15.8 for details on patterns. The SNMP 
Object ID and SNMP Community properties are discussed in section 8.9.

4. Click on the OK button. The new user attribute will appear in the table.

PatchManager Reference Manual Version 4.1 Page 149 / 274

Illustration 60: User Attribute Dialog



8.2   Modifying a User Attribute
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the user attribute you would like to modify in the table.

3. Click on the  button. The user attribute dialog will appear. An example of the user 
attribute dialog is shown in Illustration 60. As an alternative to steps 2 and 3, you can also 
right-click on the user attribute you would like to modify and select the Edit... option or 
double-click on the user attribute you would like to modify.

4. Enter the new values for the user attribute. Note that the name of the user attribute must be 
unique. Also note that it is not possible to change the type of a user attribute if at least one 
value for that attribute is stored.

5. Confirm the changes by clicking on the OK button. The table of user attributes will be 
updated accordingly.

Note that details on file set attributes are given in section 8.5. 

8.3   Applying a User Attribute
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the user attribute for which you would like to modify the application in the table.

3. Click on the  button. The user attribute dialog will appear. An example of the user 
attribute dialog is shown in Illustration 60. As an alternative to steps 2 and 3, you can also 
right-click on the user attribute for which you would like to modify the application and 
select the Edit... option.

4. Select the Application tab. A tree similar to the one shown in Illustration 61 will appear.

5. In the tree, select the templates you would like to apply the user attribute to. Note that you 
can also apply user attributes to categories. If you do, the user attribute will be inherited by 
all templates in the category.

6. Click on the  button to apply the user attribute. A check mark will appear next to the 
selected templates and or categories.

7. If applicable, click on the  button to remove the application of the user attribute. The 
check marks will disappear from the selected templates and or categories.

8. Confirm the changes by clicking on the OK button.
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Note that you can also change the application of a user attribute while editing a template or category 
(see sections 3.1.1.2 and 3.1.3) using the following steps.

8.3.1   Applying a User Attribute to a Single Template or Category
1. Open the appropriate dialog.

2. Click on the  button. A list of user attributes that can be applied to the template will 
appear.

3. Select the user attributes you would like to apply in the list.

4. Click on the OK button. The user attributes will appear in the list of properties of the 
template or category.

5. Confirm the template or category dialog by clicking on the OK button to save the changes.

8.3.2   Removing a User Attribute from a Single Template or Category
1. Open the appropriate dialog.
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2. Select the user attribute you would like to remove from the template or category.

3. Click on the  button. The selected user attribute will disappear from the list of properties 
of the template or category.

4. Confirm the template or category dialog by clicking on the OK button to save the changes.

8.4   Editing User Attribute Values
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the user attribute for which you would like to edit values in the table.

3. Click on the  button. The user attribute dialog will appear. An example of the user 
attribute dialog is shown in Illustration 60. As an alternative to steps 2 and 3, you can also 
right-click on the user attribute for which you would like to edit the values and select the 
Edit... option.

4. Select the Values tab. A tree similar to the one shown in Illustration 62 will appear.

5. For the item for which you would like to modify the value, double-click on the Value 
column. As a shortcut, you can also copy values, as described in the next section.

6. Type in or select the new value for the user attribute. Note that details on file set attributes 
are given in section 8.5.

7. Press Enter on the keyboard to confirm the new value.

8. Click on the OK button to confirm the changes.
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Note that you can also modify user attribute values using the property sheet (see section 2.5).

8.4.1   Copying Values
1. In the values tree (see Illustration 62), select the values you would like to copy (note that it 

is possible to copy multiple values to multiple rows).

2. Press the Ctrl and C keys on the keyboard to copy the values to the clipboard.

3. Select the rows you would like to copy the values to.

4. Press the Ctrl and V keys on the keyboard to paste the values in the selected rows.

5. Click on the OK button to confirm the changes.

8.5   File Set Attributes
The purpose of file set attributes is to allow associating files with a certain item. For example, using 
file set attributes it is possible to associate the installation manual of a piece of equipment with the 
equipment. The files that can be used in file set attributes should first be registered with 
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PatchManager Server. This is done using the file management dialog, as described in section 15.2.

When editing the value of a file set user attribute, you will see a dialog similar to the one shown in 
Illustration 63. The following sections describe what you can do in this dialog.

8.5.1   Adding a File
1. Open the file set attribute dialog by editing the value of a user attribute, as described in 

section 8.4.

2. Click on the  button in the tool bar at the top of the dialog. A dialog similar to the one 
shown in Illustration 64 will appear.

3. Select the file you would like to add to the value of the user attribute in the tree of files. 

4. Click on the OK button. The selected files will appear in the list of files representing the user 
attribute value.

5. Click on the OK button to store the current file list as the new user attribute value.

Note that you can select and add multiple files at the same time.
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8.5.2   Removing a File
1. Open the file set attribute dialog by editing the value of a user attribute, as described in 

section 8.4.

2. Select the file you would like to remove from the list of files representing the user attribute 
value.

3. Click on the  button in the tool bar at the top of the dialog. The selected file will disappear 
from the list of files representing the user attribute value.

4. Click on the OK button to store the current file list as the new user attribute value.

Note that you can select and remove multiple files at the same time.

8.5.3   Moving a File Up or Down
1. Open the file set attribute dialog by editing the value of a user attribute, as described in 

section 8.4.

2. Select the file you would like to move up or down in the list of files representing the user 
attribute value.

3. Click on the  button in the tool bar at the top of the dialog to move the file up, or on the 
 button in the tool bar at the top of the dialog to move the file down.

4. Click on the OK button to store the current file list as the new user attribute value.

8.5.4   Opening a File
1. Open the file set attribute dialog by editing the value of a user attribute, as described in 

section 8.4.
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2. Select the file you would like to open.

3. Click on the  button in the tool bar at the top of the dialog. The selected file will be 
opened using the program associated with the selected file's type. As an alternative to steps 2 
and 3, you can also double-click on the file you would like to open.

8.6   Deleting a User Attribute
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the user attributes you would like to delete.

3. Click on the  button. As an alternative to steps 2 and 3, you can also right-click on the 
user attribute you would like to delete and select the Delete option. The user attribute will 
disappear from the table. If the user attribute is currently applied to a template, 
PatchManager will ask for confirmation before deleting the user attribute. Note that any 
values set for the user attribute will be lost if you click on the Yes button.

8.7   Custom Objects
Custom objects can be used to model entities in your organization that are not explicitly 
implemented in PatchManager. For example, using custom objects you can model people or 
departments in your organization. Two steps are required to model custom objects:

1. creating a custom type (section 8.7.1) and

2. creating the custom objects (section 8.7.2).

For example, when modeling people in your organization you would first create a custom 'Person' 
type and then create objects for the actual people in your organization.

8.7.1   Custom Types
A custom type contains information about the fields used to model custom objects. Each field has a 
name and type (text, number, truth value, date or another custom type) and can be further 
constrained by requiring a (unique) value or specifying a pattern for the field (see section 15.8 for 
details on patterns). For example, a simple custom 'Person' type would have a field for the first 
name and a field for the last name.

A custom type also describes how objects of that type should be displayed on single lines, on 
multiple lines, in tool tips and in select boxes. This is done by associating fields with expressions. In 
the 'Person' example, you could associate the expression fn with the first name and ln with the last 
name. These expressions can now be used in the single line format of the person type. For example, 
the format {ln}, {fn} would mean that the last name is displayed first, followed by a comma, a 
space and then the first name. Note that in the multiple line and tool tip formats, <br> will be 
treated as a line break.

8.7.1.1   Adding a Custom Type
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the Custom Objects tab (shown in Illustration 59).
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3. Click on the  button. The custom type dialog will appear. An example of this dialog is 
shown in Illustration 65.

4. Enter the values for the custom type. You can add fields using the  button. You can edit 
fields in the table by clicking on the appropriate cells. You can delete fields using the  
button.

5. Click on the Apply or OK button. The new custom type will appear in the list of custom 
types.

8.7.1.2   Modifying a Custom Type
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the Custom Objects tab (shown in Illustration 59).

3. Select the custom type you would like to modify in the list of custom types.

4. Click on the  button. The custom type dialog will appear. An example of this dialog is 
shown in Illustration 65. As an alternative to steps 3 and 4 you can also double-click on the 
custom type you would like to modify.
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5. Enter the new values for the custom type.

6. Click on the Apply or OK button. If applicable, the changes to the custom type will be 
reflected in the custom objects tab.

8.7.1.3   Deleting a Custom Type
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the Custom Objects tab (shown in Illustration 59).

3. Select the custom type you would like to delete in the list of custom types.

4. Click on the  button. PatchManager will ask for confirmation before deleting the custom 
type. Note that if a custom type is deleted, all data about custom objects of that type will 
also be deleted.

5. Confirm the deletion by clicking on the Yes button. The custom type will disappear from 
the list of custom types.

8.7.2   Custom Objects
Once you have created a custom type, you can add custom objects of that type. These objects can 
then be selected as values for user attributes using the custom type. The following sections discuss 
how to add, modify, delete, import, and export custom objects.

8.7.2.1   Adding a Custom Object
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the Custom Objects tab (shown in Illustration 59).

3. Select the custom type for which you would like to add a custom object in the list of custom 
types.

4. Click on the  button. The custom object dialog will appear. An example of this dialog is 
shown in Illustration 66.

5. Enter the values for the custom object.

6. Click on the Apply or OK button. The new custom object will appear in the table of custom 
objects.

PatchManager Reference Manual Version 4.1 Page 158 / 274



8.7.2.2   Modifying a Custom Object
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the Custom Objects tab (shown in Illustration 59).

3. Select the custom type for which you would like to modify a custom object in the list of 
custom types.

4. Select the custom object you would like to modify in the table of custom objects.

5. Click on the  button. The custom object dialog will appear. An example of this dialog is 
shown in Illustration 66. As an alternative to steps 4 and 5, you can also double-click on the 
custom object you would like to modify.

6. Enter the new values for the custom object.

7. Click on the Apply or OK button. If applicable, the changes to the custom object will be 
reflected in the table of custom objects.

8.7.2.3   Deleting a Custom Object
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the Custom Objects tab (shown in Illustration 59).

3. Select the custom type for which you would like to delete a custom object in the list of 
custom types.

4. Select the custom object you would like to delete in the table of custom objects.

5. Click on the  button. PatchManager will ask for confirmation before deleting the custom 
object.
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6. Confirm the deletion by clicking on the Yes button. The custom object will disappear from 
the table of custom objects.

8.7.2.4   Importing Custom Objects
Custom objects can be exported to, and imported from, compatible CSV files. In order for a CSV 
file to be compatible with a custom type, the header of each column in the CSV file should 
correspond to an existing field in the custom type. The following steps describe how to import 
custom objects. Exporting custom objects is described in the next section.

1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the Custom Objects tab (shown in Illustration 59).

3. Select the custom type for which you would like to import custom objects in the list of 
custom types.

4. Click on the  button in the tool bar at the top of the user attributes overview. A file 
selection dialog will appear.

5. Select the file you would like to import custom objects from.

6. Click on the Open button. The custom objects will appear in the table of custom objects.

8.7.2.5   Exporting Custom Objects
1. Open the user attributes overview, as described in the introduction of this chapter.

2. Select the Custom Objects tab (shown in Illustration 59).

3. Select the custom type for which you would like to export custom objects in the list of 
custom types.

4. Optionally select the custom objects you would like to export in the table of objects. If you 
do not select any custom objects, all custom objects in the table will be exported.

5. Click on the  button in the tool bar at the top of the user attributes overview. A file 
selection dialog will appear.

6. Select the file you would like to export the custom objects to.

7. Click on the Save button. The selected custom objects will be exported to the file and upon 
success, a confirmation message will be shown.

8.8   User Attribute Indicators
Throughout the user interface, the presence of user attribute values for an item are indicated using 
blue rectangles. For example, if a port has a non-empty value for at least one of the user attributes 
that applies to it its display will be decorated by a blue rectangle in the upper right corner of the 
port.

8.9   SNMP
Note: in order to use the SNMP functionality, it needs to be enabled explicitly in the configuration 
of the server software. See the PatchManager Configuration Reference for details.
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User attributes can be associated with SNMP objects. This means that PatchManager will 
periodically make SNMP requests to determine the values for those attributes for each equipment 
instance they apply to. You can use either equipment-level SNMP objects or port-, slot- and 
terminator-level SNMP objects.

8.9.1   Equipment-Level SNMP Objects
The following steps describe how to enable SNMP for equipment E and user attribute A.

1. Modify attribute A as described in section 8.2 and specify the SNMP Object ID and 
optionally the SNMP Community for the attribute. For example, you can specify the value 
'1.3.6.1.2.1.1.5.0' to associate attribute A with the machine description. If you do not specify 
a value for SNMP Community, the public community will be used.

2. Apply attribute A to the equipment template of equipment E, as described in section 8.3.

3. Associate the IP address attribute with the equipment template of equipment E, as described 
in section 8.3. By default PatchManager will use the user attribute named IP Address (if 
it exists) to determine the address where the SNMP request is sent. However, this can be 
overridden by your administrator. In this case please contact your administrator to determine 
the proper user attribute.

4. Set the value of the IP address attribute to the proper value for equipment E, as described in 
section 5.2.3. PatchManager will now periodically send requests to the given IP address for 
attribute A (and all other applicable attributes that have SNMP object ids associated with 
them) and automatically update the appropriate values. Note that if the equipment doesn't 
respond to the SNMP requests, the value of the user attribute for that equipment will be reset 
to the default value for the user attribute.

8.9.2   Port-, Slot- and Terminator-Level SNMP Objects
The following steps describe how to enable SNMP for the ports on equipment E using user attribute 
A. The same steps apply for slots and terminators.

1. Modify attribute A as described in section 8.2 and specify the SNMP Object ID and 
optionally the SNMP Community for the attribute. As part of the value for 
SNMP Object ID, you can use expressions that will be evaluated for each port 
separately. The expressions you can use are described in Table 27. If you do not specify a 
value for SNMP Community, the public community will be used.

2. Apply attribute A to the port template of the ports on equipment E, as described in section 
8.3.

3. Associate the IP address attribute with the equipment template of equipment E, as described 
in section 8.3. By default PatchManager will use the user attribute named IP Address (if 
it exists) to determine the address where the SNMP request is sent. However, this can be 
overridden by your administrator. In this case please contact your administrator to determine 
the proper user attribute.

4. Set the value of the IP address attribute to the proper value for equipment E, as described in 
section 5.2.3. For each port on equipment E, PatchManager will periodically evaluate the 
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expressions in SNMP Object ID for attribute A relative to that port, send an SNMP request 
to the IP address specified for equipment E and automatically update the appropriate values. 
Note that if the equipment doesn't respond to the SNMP requests, the values of the user 
attribute for the ports will be reset to the default value for the user attribute.

Expression Description
{label} Evaluates to the label of the port, terminator or slot.
{port-index} Evaluates to the number of the port on the equipment.
{slot-index} Evaluates to the number of the slot on the equipment.
{terminator-index} Evaluates to the number of the terminator on the equipment.
{user attribute name} Evaluates to the value entered for the given user attribute for 

each port, terminator or slot. For example, if user attribute 
Interface applies to ports, then for each port 
{Interface} will evaluate to the value specified for 
Interface for that port.

Table 27: SNMP Object ID Expressions
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Chapter 9: Work Orders
PatchManager allows recording modifications in the network infrastructure in work orders. Using 
this mechanism, you can add, move or remove equipment and connections in PatchManager and 
then schedule a work order for the actual changes to be made in the field. 

Work orders can be exported or printed so that they can be handed over to the engineers who 
perform the physical changes in the network infrastructure. Once a work order has been performed, 
it can be executed in PatchManager to commit the changes to the database. Alternatively, you can 
reject a work order to undo the changes recorded to the work order.

You can manage work orders in the work order overview by clicking on the Work Orders tab of 
the main view (see section 2.6). There is also a workspace dedicated to working with work orders 
(see section 2.9). An example of the work order overview is shown in Illustration 67.

9.1   Adding a Work Order
1. Open the Work Orders tab.

2. Click on the  button in the tool bar at the top of the work order overview (this button is 
disabled if there is currently an active work order; refer to section 9.3.2 for details on 
deactivating a work order). The dialog shown in Illustration 68 will appear.

3. Enter the values for the work order. You can change the scheduled dates by double-clicking 
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on the date and selecting a new date in the calendar that appears. Note that each work order 
must have a unique name.

4. Click on the OK button. The work order will appear in the work order overview and be the 
active work order.

9.2   Modifying a Work Order
1. Open the Work Orders tab.

2. Select the work order you would like to modify in the table of work orders.

3. Click on the  button in the tool bar at the top of the work order overview. A dialog similar 
to the one shown in Illustration 68 will appear.

4. Enter the new values for the work order. You can change the scheduled dates by double-
clicking on the date and selecting a new date in the calendar that appears. Note that each 
work order must have a unique name.

5. Click on the OK button. If applicable the changes will be reflected in the table of work 
orders.

Note that you cannot modify the start and end times of a work order if it has already been executed 
or rejected.
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9.3   Recording a Work Order
You can record actions to a work order by activating it, as described in section 9.3.1. The actions 
that are recorded are:

● adding equipment (see section 5.2.1),

● moving equipment (see sections 5.2.4 and 7.3.5),

● deleting equipment (see section 5.2.5),

● adding cables (see section 5.3.1),

● moving cables (see section 5.3.4),

● deleting cables (see section 5.3.5),

● connecting cables to equipment (see chapter 6),

● modifying equipment, port, terminator, slot and cable labels (see sections 5.2.3, 5.6.1 and 
5.7.1, 5.8.1 and 5.3.3) and

● modifying attribute values for equipment, ports, terminators, slots and cables (see section 
8.4).

PatchManager imposes appropriate restrictions on the actions that can be performed on items that 
are currently used in work orders that have not yet been executed or rejected (these items can be 
recognized by the indicators described in section 9.5). For example, PatchManager will give an 
error message when trying to delete an equipment instance that is created in a work order that has 
not yet been executed or rejected.

Note that at most one of the work orders you created can be active at a given time. You can only 
activate work orders that you created. When you add a new work order, it will become the active 
work order.

9.3.1   Activating a Work Order
1. Open the Work Orders tab.

2. If applicable, deactivate the currently active work order using the steps described in section 
9.3.2.

3. Select the work order you would like to activate in the table of work orders. Note that you 
can only activate work orders that you created.

4. Click on the  button in the tool bar at the top of the work order overview. The selected 
work order will become the active work order.

9.3.2   Deactivating a Work Order
1. Open the Work Orders tab.

2. Select the work order you would like to deactivate in the table of work orders. Note that you 
can only deactivate work orders that you created.

3. Click on the  button in the tool bar at the top of the work order overview. The selected 
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work order will no longer be active.

9.4   Viewing Work Order Details
1. Open the Work Orders tab.

2. Select the work order for which you would like to view the details in the table of work 
orders. The details and steps of the work order will be shown in the lower part of the work 
order overview.

9.5   Work Order Indicators
For work orders that have not yet been executed or rejected, PatchManager uses the following 
indicators to show that an item is currently used in a work order.

● Icons – where applicable, PatchManager shows a green plus icon to indicate that an item is 
added or connected in a work order, a red minus icon to indicate that an item is removed or 
disconnected in a work order or a blue arrow icon to indicate that an item is moved in a 
work order. A blue circle indicates any other changes to the item in a work order, such as 
changing the item's label.

● Borders – in the cabinets and equipment overviews, PatchManager uses a green border to 
indicate that an equipment instance is created in a work order, a red border to indicate that 
an equipment instance if removed in a work order or a blue border to indicate that an 
equipment instance is moved in a work order.

9.6   Executing a Work Order
You can execute work orders that have not yet been executed or rejected using the following steps.

1. Open the Work Orders tab.

2. If applicable, deactivate the work order you would like to execute using the steps described 
in section 9.3.2.

3. Select the work order you would like to execute in the table of work orders.

4. Click on the  button in the tool bar at the top of the work order overview. The dialog 
shown in Illustration 69 will appear.

5. Optionally enter a completion remark

6. Click on the OK button. The selected work order will be executed.
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Note that you can continue recording a work order after it has been executed by activating it using 
the steps described in section 9.3.1. In this case, the steps of the work order that have already been 
executed will not be affected. This way it is possible to have a work order that contains both steps 
that have been executed and steps that have been rejected. For such partially executed work orders, 
the table showing the steps of the work order will indicate which steps were rejected using a red 
background for the step number.

9.7   Rejecting a Work Order
You can reject work orders that have not yet been executed or rejected using the following steps.

1. Open the Work Orders tab.

2. If applicable, deactivate the work order you would like to reject using the steps described in 
section 9.3.2.

3. Select the work order you would like to reject in the table of work orders.

4. Click on the  button in the tool bar at the top of the work order overview. The dialog 
shown in Illustration 69 will appear.

5. Optionally enter a rejection remark.

6. Click on the OK button. The selected work order will be rejected.

9.8   Deleting Work Orders
You can delete work orders that have been executed, partially executed or rejected or that do not 
have any line items using the following steps.

1. Open the Work Orders tab.

2. Select the work orders you would like to delete in the table of work orders. You can select 
multiple work orders by using the Ctrl and Shift keys on the keyboard.

3. Click on the  button in the tool bar at the top of the work order overview. The selected 
work orders will be deleted.

9.9   Exporting a Work Order
You can export a work order to a PDF document using the following steps.
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1. Open the Work Orders tab.

2. Select the work order you would like to export in the table of work orders.

3. Click on the  button in the tool bar at the top of the work order overview.

4. Select a file location and click on the Save button. The document will be saved to the 
specified location.

5. If you would like to view the exported document now click Yes in the dialog that appears. 
Otherwise, click No.

9.10   Printing a Work Order
1. Open the Work Orders tab.

2. Select the work order you would like to print in the table of work orders.

3. Click on the  button in the tool bar at the top of the work order overview. The standard 
printing dialog will appear.
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Chapter 10: Import / Export
PatchManager supports the following ways of importing data to and exporting data from the 
PatchManager database:

● importing data about locations, network objects and connections through scheduled imports,

● importing data about locations, network objects and connections from CSV files,

● exporting data about locations, network objects and connections to CSV, PDF, HTML files 
and a printer,

● exporting cable labels to CSV files and

● importing and exporting data about model templates from and to XML files.

Scheduled Imports are discussed in detail in section 15.4. The other forms of data exchange are 
discussed in the following sections.

10.1   Locations, Network Objects and Connections
The following sections describe how to import and export locations, network objects and 
connections from and to CSV files. PatchManager can handle five types of CSV files: locations, 
cabinets, equipment, cables and connections. The formats of these file types are described in 
appendix B. The first line of each import file must contain the column names described in appendix 
B separated by a separator character. If a file is not recognized as a valid import file, PatchManager 
will indicate which column causes the problem.

Note that it is possible to select an alternative separator character for export files, as described in 
section 15.9. Also note that PatchManager can handle alternative separator characters in import 
files. You do not have to specify the separator character used in an import file, or the type of import 
file; PatchManager will determine these automatically based on the header of the import file.

10.1.1   Importing
You can use the import mechanism to add new data, or to update existing data, using the following 
steps. The ways in which PatchManager determines if a row should be handled as an update or an 
add are described in appendix B. Two important concepts used when reading an import file are 
identifiers and extra information. 

1. Right-click on a location or cabinet in the locations tree or in a graphical overview.

2. Select the Import option. The import screen, as shown in Illustration 70 will appear in the 
main view.
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3. Click on the ... button next to the File field. A standard file dialog will appear.

4. Select an import file and click on the Open button. Note that you do not have to specify 
what type of import file you are using, PatchManager will determine this automatically.

5. Optionally you can specify that PatchManager should only import part of the import file. 
You can do this by clicking on the ... button next to the Range field. A dialog similar to 
the one shown in Illustration 71 will appear. You can use the table to select the rows you 
would like to import. After selecting the appropriate rows, click on the OK button to close 
the dialog.
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6. Select a log level. Note that you can change the log level at any time during the import. 

7. Optionally check the Use Import Folder box. If you do, any imported items will be 
placed in a temporary import folder which will appear in the locations tree. Using the import 
folder you can build up part of the locations tree in a temporary place, from where you can 
later move it to the appropriate position in the locations tree. Moving locations, cabinets, 
equipment and cables are described in sections 4.4, 5.1.5, 5.2.4 and 5.3.4 respectively.

8. Specify whether history should be logged for the items that are imported using the Log 
History box. Disabling history logging will improve performance.

9. Specify whether errors should be ignored or not using the Ignore Errors box. If errors 
are ignored, the import will log the error and automatically continue. Otherwise, 
PatchManager will for each error ask if you would like to continue the import.

10. Click on the Start button. PatchManager will start importing the data in the import file 
and progress messages will appear in the import screen. You can interrupt the import by 
clicking on the Stop button. You can remove the messages in the import screen by clicking 
on the Clear button. Alternatively, you can save the messages to a file by clicking on the 
Save button.

10.1.1.1   Identifiers
Identifiers are used by the import to determine to which item values in the import file apply. Ideally, 
an identifier uniquely specifies an item. If this is not possible, you can opt to add extra information 
to the identifier value, as described in the next section.

The identifiers PatchManager can use when importing are described in Table 28. Note that not all 
identifiers apply to all items. Also note that the enterprise location is always identified by an empty 
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value. You can make sure your import file uses the correct identifiers either by properly configuring 
the data format (see section 11.2.2) or through the configuration of the connections export (see 
section 10.1.2.2).

Identifier Description
Qualified Name Identifies a location by its name, and the names of all its parent 

locations.
Qualified Label Same as qualified name, but applies to equipment and cables.
Name Identifies a location by its name. This is useful if you know that all 

locations in the database have a unique name.
Label Same as name, but applies to equipment, cables, cable-elements, 

connectors, ports and slots.
Description Identifies items by their description. This is useful if you know that all 

items in your database have a unique description.
Attribute Identifies items by their value for a user attribute. For example, if you 

maintain the MAC addresses of equipment using user attributes, you 
can use the MAC address of equipment to identify it. Note that this 
option appears only if you have applied user attributes to the relevant 
items (see chapter 8). 

Table 28: Possible Identifiers

If in the connections export you have selected Attribute for any of the identifiers (see section 
10.1.2.2), a dialog will appear after you click the OK button in the export dialog where you can 
select the user attributes to use. An example of this dialog is shown in Illustration 72. PatchManager 
allows you to specify a list of attributes to use. When exporting an item, PatchManager goes 
through this list of attributes and uses the first non-empty value it finds. If no values are found, the 
label or name will be used.

You can add and remove export attributes using the  and  buttons. You can change the order in 
the list using the  and  buttons. The export will start once you click on the OK button.
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10.1.1.2   Extra Information
If there is no identifier that can uniquely identify items, you can include extra information in the 
identifier. For example, if you have multiple ports with the same label on equipment, you can 
include the index of the port behind square brackets. The options for including extra information are 
described in Table 29. Note that not all options apply to all items.

Option Description
Template Include the name of the model template of the network object (see chapter 3).
Coordinates Include the x, y coordinates of the location, cabinet, equipment or cable (if it is 

not connected) in the graphical overview (see chapter 7).
Index Include the index of a port, slot or connector on its equipment (based on the 

order they were added to the equipment template, see section 3.2.3) or the 
index of a cable-element in its cable (see section 3.2.4).

All Include all applicable extra information. Each value will have its own square 
brackets.

Table 29: Extra Information Options

10.1.2   Exporting
When exporting locations, cabinets, equipment, cables, cable-elements or ports, PatchManager will 
present an export preview of the selected data. From this export preview you can specify how the 
data should be exported and then save the data to file or print it. The export preview is described in 
section 10.1.2.1.

Currently it is not possible to use a custom file format for exporting connections. Instead, the 
connections file format described in section B.5 will be used. Exporting connections is described in 
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section 10.1.2.2.

10.1.2.1   Export Preview
The export preview allows you to see what the contents of an export file or print will look like 
before you create it. An example of the export preview is shown in Illustration 73. The following 
sections describe how to open and use the export preview and how to use it to save and print the 
data presented in it.

10.1.2.1.1   Opening the Export Preview
1. Right-click on the top node in the locations tree. If you would like to export data relevant to 

a certain location, cabinet or equipment instance only you can also right-click on the 
appropriate item.

2. Move the mouse cursor over the Export option.

3. Select the Locations, Cabinets, Equipment or Cables option. The export preview 
will appear showing the relevant data.

Note that you can also open the export preview by performing a search (see chapter 11). If you do, 
the tool bar of the export preview will have an additional button. While the search is still running, 
the button will appear as  and clicking it will interrupt the search. When the search is finished, the 
button will appear as  and clicking it will repeat the search.
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10.1.2.1.2   Using the Export Preview
The export preview allows you to select the data format you would like to use to present the data in 
it. You can select a data format using the select box at the top of the export preview. The preview 
will update automatically according to the selected data format. Note however that the preview does 
not support grouping data. For details on data formats, see section 11.2.2.

You can interact with the data in the export preview in several ways. If you select a row in the table, 
the selected item will automatically be displayed in the locations tree (see section 2.3) and 
properties view (see section 2.5) and if applicable in the connection details (see section 6.4). You 
can also right-click on a row in the table. A pop-up menu will be shown with the different available 
options applicable to the selected item. Finally, you can double-click on a row. This will cause the 
default action for the selected item to be performed.

10.1.2.1.3   Saving Data
1. Open the export preview, as described in the previous section.

2. Select the data format you would like to use in the select box.

3. Optionally select the rows of data you would like to save. If you do not select any rows, all 
rows will be saved.

4. Click on the  button in the tool bar at the top of the export preview. The export dialog will 
appear, as shown in Illustration 74.

5. Click on the ... button in the export dialog. A file selection dialog will appear.

6. Select the file you would like to save the data to. Note that you can select PDF, HTML and 
CSV files.

7. Click on the Save button. The selected file will appear in the export dialog.

8. Make sure the Open exported file check box is checked if you would like the 
exported file to be opened once it is saved.

9. Click on the OK button. The file will be saved and if applicable it will be opened in the 
default application associated with the selected file type.
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10.1.2.1.4   Printing Data
1. Open the export preview, as described in section 10.1.2.1.1.

2. Select the data format you would like to use in the select box.

3. Optionally select the rows of data you would like to print. If you do not select any rows, all 
rows will be printed.

4. Click on the  button in the tool bar at the top of the export preview. The print dialog will 
appear, as shown in Illustration 75.

5. Select either Portrait or Landscape orientation.

6. Click on the OK button. A standard print dialog will appear allowing you to select the printer 
and additional options. Once you confirm the standard print dialog, the selected data will be 
printed.
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10.1.2.2   Connections Export
1. Right-click on the top node in the locations tree. If you would like to export connections 

relevant to a certain location, cabinet or equipment instance only you can also right-click on 
the appropriate item.

2. Move the mouse cursor over the Export option.

3. Select the Connections option. The export dialog will appear, as shown in Illustration
76.

4. Click on the ... button next to the file box to select the file to export to.

5. Specify the identifiers that should be used in the export file by clicking on the appropriate 
table cells. Identifiers are discussed in section 10.1.1.1.

6. Specify the extra information that should be used in the export file by clicking on the 
appropriate table cells. Extra information is discussed in section 10.1.1.2.

7. Click on the OK button. The connections will be exported to the file specified. 
PatchManager will notify you when the export is completed.
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10.2   Cable Labels
PatchManager can export cable labels to a Brady LabelMark™ compatible CSV file. In this file 
format, the first line of a cable label appears in the first column, the second line in the second 
column et cetera.

1. Right-click on the top node in the locations tree. If you would like to export only cable 
labels relevant to a certain location, cabinet, equipment instance or cable you can also right-
click on the appropriate item.

2. Move the mouse cursor over the Export option.

3. Select the Cable Labels option. A file selection dialog will appear.

4. Select the file you would like to export the cable labels to and click on the Save button. The 
cable labels will be exported to the file specified. PatchManager will notify you when the 
export is completed.

10.3   Model Templates
The following sections describe how to import and export templates from and to XML files. 

10.3.1   Importing
1. Right-click on the category where you would like to import templates. Note that the type of 
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the category must match the type of the template for the import to succeed.

2. Select the Import option.

3. Select the folders and files you would like to import. If you select folders, PatchManager 
will create categories to reflect the folder structure.

4. Click on the Open button. The selected templates will be imported.

In some cases, importing a template depends on the existence of other templates. For example, an 
equipment template depends on the port and slot templates used in the equipment template. If 
PatchManager cannot find a necessary port or slot template, or if the existing port or slot template 
doesn't have the expected dimensions, the necessary port and slot templates will be created in the 
import category.

10.3.2   Exporting
1. Right-click on the template you would like to export. You can also right-click on a category 

to export all templates in the category. In this case, PatchManager will create a folder 
structure similar to the category hierarchy.

2. Select the Export option.

3. Select the location where you would like to save the files. Note that the names of the 
resulting files will match the names of the exported templates.

4. Click on the Save button. The selected templates will be exported to the specified location.
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Chapter 11: Search
Note: The reporting facility that was available in PatchManager 4.0 has been replaced by the 
advanced search (section 11.2) and export preview (section 10.1.2.1) functions.
PatchManager has powerful search functionality that allows you to easily find items in the database. 
There are two types of search available. The first option is to use the find dialog. The find dialog 
allows you to do simple searches, based on a single constraint. It presents the results of the search in 
the dialog itself, making it very easy to quickly find an item and perform an action on it. The find 
dialog is described in section 11.1.

The second search option is advanced search. Advanced search supports combining multiple search 
constraints into a complex query. Search results are presented using the export preview (see section 
10.1.2.1), making it easy to create reports using the advanced search functionality. Advanced 
searches are described in section 11.2.

11.1   Find Dialog
You can open the find dialog by selecting the Edit > Find... menu entry, by clicking on the 

 button in the tool bar of the main window, or by simultaneously pressing the Ctrl and F keys 
on the keyboard. An example of the find dialog is shown in Illustration 77.

In the find dialog, you can search for templates, locations, cabinets, equipment, cables, cable-
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elements, ports, slots, terminators (see chapters 3 through 6). The search pattern, which can either 
be a simple search pattern similar to the one Windows uses (where * is treated as a wild-card 
character) or a regular expression (see section A), can be matched against the name or label of the 
item, the name of the template of the item or any of the user attributes values of the item (see 
chapter 8). The following steps describe how to use the find dialog.

1. Open the find dialog, as described in the introduction of this section.

2. Enter the search pattern. You can use * as wild-card character, or you can check the 
Regular Expression box and enter a regular expression (see section A).

3. Specify whether or not the case of the search pattern is significant using the Match Case 
box.

4. Select the types of items you would like to search for. You can select multiple items by 
clicking on a type while keeping the Ctrl key pressed.

5. Select what you would like to match the search pattern against. You can select multiple 
items by clicking on an item while keeping the Ctrl key pressed.

6. Click on the Start Search button. As results are found, they will appear in the bottom 
part of the find dialog. Selecting a search result will display it in the locations tree. Double-
clicking on a search result will perform the standard action for that item. You can perform 
additional actions with the search results by right-clicking on them.

11.2   Advanced Search
Advanced search allows you to combine search constraints to perform more complex searches than 
the find dialog supports. Additionally, you can search based on more values than just name, 
template and user attributes. The search results of an advanced search are presented using an export 
preview (see section 10.1.2.1). The export preview allows flexible presentation of the data in your 
database, by using data formats. 

Advanced searches and data formats can both be managed in the searches and data formats 
overview. You can open the searches and data formats overview by selecting the 
Administration > Searches and Data Formats menu entry, or by clicking on the  
button in the tool bar of the main window. An example of the Searches tab of the searches and 
data formats overview is shown in Illustration 78. 
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An example of the Data Formats tab of the searches and data formats overview is shown in 
Illustration 79.
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Configuring and using searches is described in the next section. Data format management is 
described in section 11.2.2.

11.2.1   Searches
The following three sections describe how to add, modify, and delete searches in general terms. 
Actual search configuration is described in section 11.2.1.4. Once you have configured a search, 
you can run it, as described in section 11.2.1.5. You can also mark searches as favorites, causing 
them to appear in the Searches menu. Favorite searches are described in detail in section 
11.2.1.6. Finally, exporting and importing searches are described in sections 11.2.1.7 and 11.2.1.8.

11.2.1.1   Adding Searches
1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Searches tab is selected.

3. Select the tree node associated with the type of search you would like to add.

4. Click on the  button in the tool bar at the top of the searches and data formats overview. 
The search dialog will appear. An example of the search dialog is shown in Illustration 80. 
As an alternative to steps 3 and 4, you can also right-click on the tree node for the type of 
search you would like to add, and select the Add... entry.

5. Configure the search, as described in section 11.2.1.4.

6. Click on the Apply or OK button. The new search will appear in the tree of searches.
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11.2.1.2   Modifying Searches
1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Searches tab is selected.

3. Select the search you would like to modify in the tree of searches.

4. Click on the  button in the tool bar at the top of the searches and data formats overview. 
The search dialog will appear, with the selected search loaded. An example of the search 
dialog is shown in Illustration 80. As an alternative to steps 3 and 4, you can also right-click 
on the search you would like to modify, and select the Edit... entry.

5. Configure the search, as described in section 11.2.1.4.

6. Click on the Apply or OK button. If applicable, the updates will be reflected in the tree of 
searches.

11.2.1.3   Deleting Searches
1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Searches tab is selected.
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3. Select the search you would like to delete in the tree of searches.

4. Click on the  button in the tool bar at the top of the searches and data formats overview. 
PatchManager will ask for confirmation before deleting the selected search. Alternatively, 
you can also press the Delete key on the keyboard, or right-click on the search you would 
like to delete and select the Delete option.

5. Confirm the deletion by clicking on the Yes button. The selected search will disappear from 
the tree of searches.

Note that it is possible to select and delete multiple searches at the same time. 

11.2.1.4   Configuring Searches
Each search requires a unique name. You can optionally select a preferred data format in the search 
dialog. The preferred data format will be used as the initial data format selection in the export 
preview when performing the search (see sections 10.1.2.1, 11.2.1.5, and 11.2.2).

The following sections describe how to configure the constraints of a search. In the following 
sections, it is assumed that you have already opened the search dialog for the search you would like 
to configure, as described in sections 11.2.1.1 and 11.2.1.2.

11.2.1.4.1   Adding Constraints
1. Click on the  button in the tool bar at the top of the search dialog. The constraint dialog 

will appear. An example of the constraint dialog is shown in Illustration 81.

2. Select the field you would like to base the constraint on. The available fields are described 
in section 11.2.1.4.4.

3. Click on the Next button. 

4. If the type of the field you selected requires a format, enter one. See Table 43 for details on 
field types.

5. Click on the Next button. 

6. Select the comparison you would like to apply in the constraint. Note that you can check the 
Negation box if you would like to invert the comparison.

7. Click on the Next button. 

8. Specify the values you would like to base the constraint on. Note that you can also check the 
Wildcard box. Wildcard constraints are described in section 11.2.1.4.5.

9. Click on the Next button.

10. Verify that the constraint has been properly configured. You can click on the Previous 
button if you would like to make any changes. Otherwise, click on the Finish button. The 
new constraint will appear in the table of constraints.
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11.2.1.4.2   Modifying Constraints
1. Select the constraint you would like to modify.

2. Click on the  button in the tool bar at the top of the search dialog. The constraint dialog 
will appear. An example of the constraint dialog is shown in Illustration 81. As an alternative 
to steps 1 and 2 you can also double-click on the constraint you would like to modify.

3. Follow steps 2 – 10 from the previous section to configure the constraint. Once you click on 
the Finish button, the selected constraint will be updated in the table of constraints.

11.2.1.4.3   Removing Constraints
1. Select the constraint you would like to remove.

2. Click on the  button in the tool bar at the top of the Advanced tab. The selected 
constraint will be removed from the table of constraints.

11.2.1.4.4   Constraint Fields
The following tables describe the different fields available in the advanced search. Each table 
provides a description and the type of the field. The different field types are described in Table 43.
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Field Description Type
Name Name of the location. Text
Description Description of the location. Text
Template Location template of the location. This field 

will have the sub-fields described in Table
31.

Object

Parent Location the location is located in. This field 
will have the same sub-fields described in 
this table.

Location

User Attributes User attribute values associated with the 
location.

Attributes

Resources Consumed Consumption values for the resources 
consumed by the location.

Resource Values

Resources Provided Provision values for the resources provided 
by the location.

Resource Values

Resource Details Detailed summaries of the resource usage in 
the location.

Resource Details

Table 30: Location Constraint Fields

Field Description Type
Name Name of the location template. Text
Description Description of the location template. Text
Category Category the location template is in. This field will have the sub-

fields described in Table 42.
Category

Table 31: Location Template Constraint Fields
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Field Description Type
Name Name of the cabinet. Text
Description Description of the cabinet. Text
Available Space Description of the available space in the 

cabinet.
Text

Available Space (%) Percentage of space available in the 
cabinet.

Percentage

Template Cabinet template of the cabinet. This field 
will have the sub-fields described in Table
33.

Object

Location Location the cabinet is in. This field will 
have the sub-fields described in Table 30.

Location

User Attributes User attribute values associated with the 
cabinet.

Attributes

Resources Consumed Consumption values for the resources 
consumed by the cabinet.

Resource Values

Resources Provided Provision values for the resources provided 
by the cabinet.

Resource Values

Resource Details Detailed summaries of the resource usage 
in the cabinet.

Resource Details

Table 32: Cabinet Constraint Fields

Field Description Type
Name Name of the cabinet template. Text
Description Description of the cabinet template. Text
Category Category the cabinet template is in. This field will have the sub-

fields described in Table 42.
Category

Table 33: Cabinet Template Constraint Fields
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Field Description Type
Label Label of the equipment. Text
Description Description of the equipment. Text
Template Equipment template of the equipment. This 

field will have the sub-fields described in 
Table 35.

Object

Location Location the equipment is in. This field will 
have the sub-fields described in Table 30.

Location

Cabinet Cabinet the equipment is in. This field will 
have the sub-fields described in Table 32.

Object

U Position U position in the cabinet the equipment is 
located at.

Number

User Attributes User attribute values associated with the 
equipment.

Attributes

Resources Consumed Consumption values for the resources 
consumed by the equipment.

Resource Values

Resources Provided Provision values for the resources provided 
by the equipment.

Resource Values

Resource Details Detailed summaries of the resource usage in 
the equipment.

Resource Details

Table 34: Equipment Constraint Fields

Field Description Type
Name Name of the equipment template. Text
Description Description of the equipment template. Text
Rack Mounted Whether or not equipment of this template is rack-mounted. Truth Value
Modular Whether or not equipment of this template is modular. Truth Value
Category Category the equipment template is in. This field will have 

the sub-fields described in Table 42.
Category

Table 35: Equipment Template Constraint Fields
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Field Description Type
Label Label of the cable. Text
Description Description of the cable. Text
# Free Connectors Number of free connectors on the cable. Number
Template Cable template of the cable. This field will 

have the sub-fields described in Table 37.
Object

Location Location the cable is in (if it is not 
connected). This field will have the sub-
fields described in Table 30.

Location

User Attributes User attribute values associated with the 
cable.

Attributes

Resources Consumed Consumption values for the resources 
consumed by the cable.

Resource Values

Resources Provided Provision values for the resources provided 
by the cable.

Resource Values

Resource Details Detailed summaries of the resource usage in 
the cable.

Resource Details

Table 36: Cable Constraint Fields

Field Description Type
Name Name of the cable template. Text
Description Description of the cable template. Text
Category Category the cable template is in. This field will have the sub-fields 

described in Table 42.
Category

Table 37: Cable Template Constraint Fields
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Field Description Type
Label Label of the port. Text
Defect Whether or not the port is defect (see section 

5.6.2).
Truth Value

Reserved Whether or not the port is reserved (see section 
5.6.3).

Truth Value

Available Whether or not the port is available. Truth Value
Template Port template of the port. This field will have the 

sub-fields described in Table 39.
Object

Equipment Equipment the port is on. This field will have the 
sub-fields described in Table 34.

Object

Top-Level Equipment Top-level equipment the port is on. Top-level in 
this context means that the constraint will “see 
through” modular equipment to find the 
equipment containing the modular equipment. 
This field will have the sub-fields described in 
Table 34.

Object

User Attributes User attribute values associated with the port. Attributes
Table 38: Port Constraint Fields

Field Description Type
Name Name of the port template. Text
Description Description of the port template. Text
Category Category the port template is in. This field will have the sub-fields 

described in Table 42.
Category

Table 39: Port Template Constraint Fields
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Field Description Type
Label Label of the cable-element. Text
Description Description of the cable-element. Text
Template Cable-element template of the cable-element. This field 

will have the sub-fields described in Table 41.
Object

Cable Cable the cable-element is part of. This field will have the 
sub-fields described in Table 36.

Object

Ports Textual description of the ports the cable-element is 
connected to.

Text

Port (Left) Port the left side of the cable-element is connected to. This 
field will have the sub-fields described in Table 38.

Object

Port (Right) Port the right side of the cable-element is connected to. 
This field will have the sub-fields described in Table 38.

Object

User Attributes User attribute values associated with the cable-element. Attributes
Table 40: Cable-Element Constraint Fields

Field Description Type
Name Name of the cable-element template. Text
Description Description of the cable-element template. Text
Category Category the cable-element template is in. This field will have the 

sub-fields described in Table 42.
Category

Table 41: Cable-Element Template Constraint Fields

Field Description Type
Name Name of the category. Text
Description Description of the category. Text
Parent Category this category falls under. This field will itself have the 

sub-fields described in this table.
Category

Table 42: Category Constraint Fields
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Field Type Description
Attributes When creating a search constraint based on an Attributes field, you 

will be asked to supply a format for the field. If you would like to base 
the constraint on the value of a single user attribute only, you can enter 
the format {UA}, where UA is the name of the user attribute. You can 
also use a path to access individual custom object fields. For example, if 
you have a Person custom type with First Name and Last Name 
fields, and you apply an Owner user attribute, of type Person, the 
following would be a valid expression: {Owner.Last Name} (see 
section 8.7 for details about custom objects).If you would like to base 
the constraint on all user attribute values, you can also enter 
{attributes}. Given a format, Attributes fields behave similar 
to Text fields.

Category Search constraints based on a Category field can match either on 
equality or on a category's path in the templates tree. For example, you 
can search for categories that equal or are directly or indirectly in a 
certain category.

Number Search constraints based on a Number field can use simple numerical 
comparisons such as less than, greater than and equals.

Object Search constraints based on an Object field can only search for object 
equality. This applies for example to equipment and templates.

Percentage Percentage fields behave the same way as Number fields.
Resource Details When creating a search constraint based on a Resource Details 

field, you will be asked to supply a format for the field. You can enter 
{resources} if you would like to base the constraint on the entire 
summary. If you would like to base the constraint on the values for a 
single resource only you can enter {R}, where R is the name of the 
resource. Finally, you can access the individual values in the summary 
using {R-total}, {R-available}, {R-consumed} and 
{R-level}, where R is the name of a resource. Given a format, 
Resource Details fields behave similar to Text fields.

Resource Values A resource values field corresponds to a list of resource-number pairs. 
When creating a search constraint based on a Resource Values 
field, you will be asked to supply a format. If you would like to base the 
constraint on all resource-number pairs you can enter {resources}. If 
you would like to base the search constraint on a single resource only 
you can enter {R}, where R is the name of the resource. Given a format, 
Resource Values fields behave similar to Text fields.

Text With Text fields you can search for text that equals a given pattern, 
starts with or ends with a given pattern, contains a given pattern or 
matches a given pattern. Note that you can specify whether or not the 
case of the pattern is significant.

PatchManager Reference Manual Version 4.1 Page 193 / 274



Field Type Description
Truth Value With Truth Value fields you can specify whether the value should be 

true or false.

Table 43: Field Types

11.2.1.4.5   Wildcard Constraints
As mentioned in section 11.2.1.4.1, you can specify that a constraint is a wildcard constraint. This 
means that you do not have to specify a constraint value when configuring the search. Instead, 
PatchManager will ask for the constraint value when the search is performed.

When specifying wildcard constraints, you can optionally enter a wildcard ID. This ID allows you 
to reuse constraint values. When performing the search, PatchManager will only ask for a value for 
each wildcard ID once. All wildcard constraints with the same wildcard ID will use the same 
constraint value.

11.2.1.5   Performing Searches
1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Searches tab is selected.

3. Select the search you would like to perform in the tree of searches.

4. Click on the  button in the tool bar at the top of the searches and data formats overview. 
An export preview will be opened that will display the search results as they are found. If 
the performed search contains any wild-card constraints PatchManager will first ask for 
values for each wild-card constraint, as described in the previous section. Details about the 
export preview are provided in section 10.1.2.1.

Note that you can also perform a search by right-clicking on it and selecting the Run Search 
option. A shortcut for performing searches is described in the next section.

11.2.1.6   Favorite Searches
You can mark advanced searches as favorites. Searches that are marked as favorites will appear in 
the Searches menu, and selecting their corresponding menu entry will directly open an export 
preview and perform the search (see section 10.1.2.1 for details about the export preview).

The following steps describe how you can select your favorite searches. Note that favorite searches 
are configured on a per-user basis.

1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Searches tab is selected.

3. Select the searches for which you would like to modify the favorites status.

4. Use the  button in the tool bar at the top of the searches and data formats overview to 
toggle the favorites status of the selected searches. Note that you can also right-click on a 
search, and select either Add to Favorites or Remove from Favorites.
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Optionally, you can have your favorite searches grouped by search type. You can use Searches 
> Group by search type menu entry to enable or disable grouping. To run a favorite search, 
simply select its entry from the Searches menu. Alternatively, you can click on the  button in the 
tool bar of the main window.

11.2.1.7   Exporting Searches
Searches can be exported to, and imported from, XML files. The following steps describe how to 
export searches. Importing searches is described in the next section.

1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Searches tab is selected.

3. Select the searches you would like to export in the tree of searches.

4. Click on the  button in the tool bar at the top of the searches and data formats overview. A 
file selection dialog will appear. Alternatively, you can also right-click on one of the selected 
searches and select the Export Selected Searches option.

5. If you selected a single search in step 3, specify the file you would like to export the search 
to. Otherwise, specify the folder where you would like to export the selected searches.

6. Click on the Save button. The selected searches will be exported, and upon success a 
confirmation message will appear.

11.2.1.8   Importing Searches
1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Searches tab is selected.

3. Click on the  button in the tool bar at the top of the searches and data formats overview. A 
file selection dialog will appear. Alternatively, you can right-click anywhere in the tree of 
searches and select the Import Searches option.

4. Select the files you would like to import. Note that if you include a folder in the selection, 
all files in that folder will be imported.

5. Click on the Open button. The selected files will be imported, and upon success a 
confirmation message will appear.

11.2.2   Data Formats
A data format specifies a tabular file format that can be used to present the data stored in the 
PatchManager database. PatchManager allows you to create your own data formats for the different 
items stored, such as locations, cabinets, equipment, cables, ports and cable-elements. You can 
select the data format you would like to apply when exporting data (see section 10.1.2.1).

Adding and modifying data formats is described in sections 11.2.2.1 and 11.2.2.2. The details of 
data format configuration are described in section 11.2.2.3. Deleting data formats is described in 
section 11.2.2.4. Finally, exporting and importing data formats are described in sections 11.2.2.5 
and 11.2.2.6 respectively.
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11.2.2.1   Adding a Data Format
1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Data Formats tab is selected.

3. Select the tree node associated with the type of data format you would like to add.

4. Click on the  button in the tool bar at the top of the data formats overview. The data 
format dialog will appear. An example of the data format dialog is shown in Illustration 82. 
Alternatively, you can also right-click on the tree node associated with the type of data 
format you would like to add and select the Add... option.

5. Specify the name, description and fields for the data format. Data format configuration is 
described in detail in section 11.2.2.3.

6. Click on the OK button. The new data format will appear in the data formats overview.

11.2.2.2   Modifying a Data Format
1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Data Formats tab is selected.

3. Select the data format you would like to modify in the tree of data formats.

4. Click on the  button in the tool bar at the top of the data formats overview. The data 
format dialog will appear. An example of the data format dialog is shown in Illustration 82. 
As an alternative to steps 2 and 3, you can also double-click on the data format you would 
like to modify, or right-click on it and select the Edit... option.

5. Modify the name, description or fields of the data format. Data format configuration is 
described in detail in section 11.2.2.3.

6. Click on the OK button. Your changes will be saved to the data format and if applicable, the 
data formats overview will reflect the changes.

11.2.2.3   Data Format Configuration
Data formats can be configured in the data format dialog. An example of the data format dialog is 
shown in Illustration 82. For each type of data format (locations, cabinets, equipment, cables, ports 
and cable-elements) the name of the data format must be unique. You can also enter an optional 
description of the data format in the data format dialog.

The most important part of a data format is its list of fields. You can specify three types of fields for 
a data format. Regular fields are the fields that correspond to columns in the output resulting from a 
data format. Regular fields are described in section 11.2.2.3.1. Ordering fields control the ordering 
of data in the output resulting from the data format. Ordering fields are described in section 
11.2.2.3.2. Finally, grouping fields allow you to group data in the output resulting from the data 
format. Grouping fields are described in section 11.2.2.3.3.

PatchManager Reference Manual Version 4.1 Page 196 / 274



11.2.2.3.1   Regular Fields
The regular fields of a data format correspond to the columns that will be used when exporting data. 
The following sections describe how you can add, modify, remove and order the regular fields of a 
data format.

11.2.2.3.1.1   Adding Regular Fields

1. Open the data format dialog, as described in sections 11.2.2.1 and 11.2.2.2.

2. If necessary, select the Fields tab.

3. Click on the  button in the tool bar at the top of the Fields tab. The add fields dialog 
will appear. An example of the add fields dialog is shown in Illustration 83.

4. Select the fields you would like to add to the data format in the tree. Note that the order in 
which you select fields affects the order the fields will appear in the data format. However, it 
is very easy to modify the order of regular fields later on, as described in section 
11.2.2.3.1.4.
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5. Click on the OK button. The selected fields will be added to the list of regular fields for the 
data format.

11.2.2.3.1.2   Modifying a Regular Field

1. Open the data format dialog, as described in sections 11.2.2.1 and 11.2.2.2.

2. If necessary, select the Fields tab.

3. Select the field you would like to modify.

4. Click on the  button in the tool bar at the top of the Fields tab. The modify field dialog 
will appear. An example of the modify field dialog is shown in Illustration 84.

5. Enter the new values for the field.

6. Click on the OK button. The data format dialog will update to reflect the changes.
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Note that you can also double-click on a field to edit it. If you double-click in the Column cell, you 
can directly enter a new header for the column. If you double-click in any of the other cells, the 
modify field dialog will appear.

The options that can be configured in the modify field dialog depend on the type of field you are 
modifying. The different types of fields and their associated presentation options are described in 
Table 44 (note that field types that do not have any presentation options are omitted from the table). 
The following section describes connection fields in detail.
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Field Types Presentation Options
Location
Cabinet
Equipment
Equipment Position
Cable
Cable-Element
Port
Category
Template
User Attributes

Expression
An expression that will be evaluated based on the value for the field. You can 
enter any text as the expression. The values in the expression that will be 
replaced with the appropriate value based on the item the expression is 
evaluated against, and the field types they apply to, are described in Table
45. 

Connection Expression
An expression that will be used to output the connection. Details of the 
connection expression are described in the following section.

Truth Value True
Specifies the value that will be used if the value for the field evaluates to 
true.

False
Specifies the value that will be used if the value for the field evaluates to 
false.

Number Precision
The number of digits that will appear behind the decimal separator.

Dimension Unit
The unit the dimension will be presented in.

Precision
The number of digits that will appear behind the decimal separator.

Coordinates Precision
The number of digits that will appear behind the decimal separator.

Expression
This value can contain any text. When the coordinates are output, any 
occurrence of {X} will be replaced with the x-coordinate and any 
occurrence of {Y} will be replaced with the y-coordinate.

Table 44: Field Presentation Options
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Expression Field Types Description
{name} Location, Cabinet, Category, 

Template
The name of the item.

{qname} Location, Cabinet, Category, 
Template

The qualified name of the item.

{label} Equipment, Cable, Cable-
Element, Port

The label of the item.

{qlabel} Equipment, Cable, Cable-
Element, Port

The qualified label of the item.

{description} Location, Cabinet, 
Equipment, Cable, Category, 
Template

The description of the item.

{template} Location, Cabinet, 
Equipment, Cable, Cable-
Element, Port

The name of the template of the item.

{category} Template The name of the category the template is in.
{coordinates} Location, Cabinet, 

Equipment
The coordinates the item is positioned at.

{position} Equipment A description of the position of the equipment.
{port-index} Equipment For modular equipment plugged in to a port, 

this is the (1-based) index of that port on the 
equipment the port is on.

{slot-index} Equipment For modular equipment plugged in to a slot, 
this is the (1-based) index of that slot on the 
equipment the slot is on.

{container} Equipment Position The qualified label of the top-level equipment 
a module is plugged in to.

{details} Equipment Position A detailed description of the position of the 
equipment.

{LT} Location LT should be the name of a location template. 
If the location is an instance of this template, or 
is directly or indirectly in a location of this 
template, the expression will be replaced with 
the name of the location of this template.

{attributes} User Attributes A list containing all the user attribute values of 
the item.

{UA} User Attributes UA should be the name of a user attribute. The 
expression will be replaced with the item's 
value for the user attribute.

{UA.path} User Attributes UA should be the name of a user attribute that 
uses a custom type. The path allows you to 
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Expression Field Types Description
access individual fields in the custom objects. 
For example, if you have a Person custom 
type with First Name and Last Name 
fields, and if equipment has a user attribute 
named Owner, of type Person, the following 
expression would be valid: 
{Owner.Last Name}. See section 8.7 for 
details about custom objects.

Table 45: Field Expressions

11.2.2.3.1.2.1 Connection Field Expression

When writing connections to a text file or table, PatchManager will split the connections into 
multiple lines. Each line describes one cable in the entire connection. The expression specified for a 
connection field is applied to each line. If a port has multiple connections, these connections will be 
written on separate lines with an empty line between them.

If you are only interested in displaying the first and last port in the connections, you can add the text 
[end-points] to the expression. In this case, only one line of text will be displayed per 
connection and the expression will be applied to only the first and last port in the connection.

The values that will be replaced in the connection expression are described in Table 46.
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Expression Description
{label} The label of the current cable.
{template} The name of the template of the current cable.
{connector-template-N} The name of the connector template of the Nth connector on the 

cable, where N must be 1 or 2.
{port-N} The label of the Nth port connected by the current cable, where 

N must be 1 or 2.
{port-template-N} The name of the template of the Nth port connected by the 

current cable, where N must be 1 or 2.
{equipment-N} The label of the equipment the Nth port connected by the 

current cable is on, where N must be 1 or 2.
{equipment-template-N} The name of the template of the equipment the Nth port 

connected by the current cable is on, where N must be 1 or 2.
{cabinet-N} The name of the cabinet containing the equipment the Nth port 

connected by the current cable is on, where N must be 1 or 2.
{location-N} The name of the location containing the equipment the Nth port 

connected by the current cable is on, where N must be 1 or 2.
{qualified-location-N} The qualified name of the location containing the equipment the 

Nth port connected by the current cable is on, where N must be 
1 or 2.

{LT} The name of the location (directly or indirectly) containing the 
equipment the Nth port connected by the current cable is on, 
where N must be 1 or 2, and the name of the template of the 
location equals LT. For example, if you have a location 
template named Building, you can use the expression 
{Building} to display the building containing the relevant 
equipment.

Table 46: Connection Field Expressions

You can filter out lines in the connection field output based on equipment templates, port templates 
and cable templates. This is done by adding one or more of the following flags: 
[include-equipment:X], [include-ports:X], and [include-cables:X]. In each 
flag, X should be a comma-separated list of template names. For example, the flag 
[include-ports:A,B] would make sure that only lines containing ports of port template A or 
port template B are included in the output.

Instead of the above-mentioned include flags, you can also use exclude flags (for example, 
[exclude-ports:A,B]). In this case, lines will only be included in the output if the relevant 
templates do not appear in the comma-separated list of template names.
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11.2.2.3.1.3   Removing Regular Fields

1. Open the data format dialog, as described in sections 11.2.2.1 and 11.2.2.2.

2. If necessary, select the Fields tab.

3. Select the fields you would like to remove.

4. Click on the  button in the tool bar at the top of the Fields tab. The selected fields will 
be removed from the list of regular fields.

11.2.2.3.1.4   Changing Regular Fields Order

1. Open the data format dialog, as described in sections 11.2.2.1 and 11.2.2.2.

2. If necessary, select the Fields tab.

3. Select the field you would like to move up or down in the list of regular fields.

4. Click on the  button in the tool bar at the top of the Fields tab to move the field up, or 
on the  button in the tool bar at the top of the Fields tab to move the field down. The 
list will update immediately to reflect the change.

11.2.2.3.2   Ordering Fields
You can add ordering fields to a data format to specify how exported data should be ordered. You 
can specify multiple ordering fields. If you do, the data will first be ordered based on the first field, 
then based on the second field et cetera. Note that you can order data based on a field even if it is 
not part of the output. The following sections describe how to add, modify, remove and change the 
priority of ordering fields.

11.2.2.3.2.1   Adding Ordering Fields

1. Open the data format dialog, as described in sections 11.2.2.1 and 11.2.2.2.

2. If necessary, select the Ordering Fields tab.

3. Click on the  button in the tool bar at the top of the Ordering Fields tab. The add 
fields dialog will appear. An example of the add fields dialog is shown in Illustration 83.

4. Select the fields you would like to add to the data format in the tree. Note that the order in 
which you select fields affects the order the fields will appear in the data format. However, it 
is very easy to modify the order of ordering fields later on, as described in section 
11.2.2.3.2.4.

5. Click on the OK button. The selected fields will be added to the list of ordering fields for the 
data format.

11.2.2.3.2.2   Modifying Ordering Fields

You can specify whether data should be ordered based on an ordering field in ascending or 
descending order. You can simply click on the check box in the appropriate table cell to change 
from ascending to descending and vice versa.
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11.2.2.3.2.3   Removing Ordering Fields

1. Open the data format dialog, as described in sections 11.2.2.1 and 11.2.2.2.

2. If necessary, select the Ordering Fields tab.

3. Select the fields you would like to remove.

4. Click on the  button in the tool bar at the top of the Ordering Fields tab. The 
selected fields will be removed from the list of ordering fields.

11.2.2.3.2.4   Changing Ordering Fields Order

1. Open the data format dialog, as described in sections 11.2.2.1 and 11.2.2.2.

2. If necessary, select the Ordering Fields tab.

3. Select the field you would like to move up or down in the list of ordering fields.

4. Click on the  button in the tool bar at the top of the Ordering Fields tab to move the 
field up, or on the  button in the tool bar at the top of the Ordering Fields tab to 
move the field down. The list will update immediately to reflect the change.

11.2.2.3.3   Grouping Fields
You can add grouping fields to a data format to specify how exported data should be grouped. You 
can specify multiple grouping fields. If you do, the data will first be grouped based on the first field, 
then based on the second field et cetera. Note that you can group data based on a field even if it is 
not part of the output.

Grouping data is not supported in comma-separated value (CSV) files. When exporting to a CSV 
file, the grouping fields of the data format are ignored. The following sections describe how to add, 
modify, remove and change the priority of grouping fields.

11.2.2.3.3.1   Adding Grouping Fields

1. Open the data format dialog, as described in sections 11.2.2.1 and 11.2.2.2.

2. If necessary, select the Grouping Fields tab.

3. Click on the  button in the tool bar at the top of the Grouping Fields tab. The add 
fields dialog will appear. An example of the add fields dialog is shown in Illustration 83.

4. Select the fields you would like to add to the data format in the tree. Note that the order in 
which you select fields affects the order the fields will appear in the data format. However, it 
is very easy to modify the order of grouping fields later on, as described in section 
11.2.2.3.3.3.

5. Click on the OK button. The selected fields will be added to the list of grouping fields for the 
data format.

11.2.2.3.3.2   Removing Grouping Fields

1. Open the data format dialog, as described in sections 11.2.2.1 and 11.2.2.2.

2. If necessary, select the Grouping Fields tab.
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3. Select the fields you would like to remove.

4. Click on the  button in the tool bar at the top of the Grouping Fields tab. The 
selected fields will be removed from the list of grouping fields.

11.2.2.3.3.3   Changing Grouping Fields Order

1. Open the data format dialog, as described in sections 11.2.2.1 and 11.2.2.2.

2. If necessary, select the Grouping Fields tab.

3. Select the field you would like to move up or down in the list of grouping fields.

4. Click on the  button in the tool bar at the top of the Grouping Fields tab to move the 
field up, or on the  button in the tool bar at the top of the Grouping Fields tab to 
move the field down. The list will update immediately to reflect the change.

11.2.2.4   Deleting a Data Format
1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Data Formats tab is selected.

3. Select the data format you would like to delete.

4. Click on the  button in the tool bar at the top of the data formats overview. Alternatively, 
you can press the Delete key on the keyboard, or right-click on the data format you would 
like to delete and select the Delete option. PatchManager will ask for confirmation before 
deleting the selected data format.

5. Confirm the deletion by clicking on the Yes button. The selected data format will disappear 
from the data formats overview.

Note that it is possible to select and delete multiple data formats at the same time.

11.2.2.5   Exporting Data Formats
Data formats can be exported to, and imported from, XML files. The following steps describe how 
to export data formats. Importing data formats is described in the next section.

1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Data Formats tab is selected.

3. Select the data formats you would like to export in the tree of searches.

4. Click on the  button in the tool bar at the top of the searches and data formats overview. A 
file selection dialog will appear. Alternatively, you can also right-click on one of the selected 
data formats and select the Export option.

5. If you selected a single data format in step 3, specify the file you would like to export the 
data format to. Otherwise, specify the folder where you would like to export the selected 
data formats.

6. Click on the Save button. The selected data formats will be exported, and upon success a 
confirmation message will appear.
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11.2.2.6   Importing Data Formats
1. Open the searches and data formats overview, as described in section 11.2.

2. Make sure the Data Formats tab is selected.

3. Click on the  button in the tool bar at the top of the searches and data formats overview. A 
file selection dialog will appear. Alternatively, you can right-click anywhere in the tree of 
data formats and select the Import option.

4. Select the files you would like to import. Note that if you include a folder in the selection, 
all files in that folder will be imported.

5. Click on the Open button. The selected files will be imported, and upon success a 
confirmation message will appear.
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Chapter 12: Resources
Note: resource management is implemented in the data center module. If you do not have this  
module, this chapter does not apply to your installation.
PatchManager can be configured to handle resources. Examples of resources are electrical power 
and cooling. For each location, cabinet, equipment and cable administered by PatchManager, you 
can specify how many resources it consumes and how many resources it makes available. 

In order to administer resources, you first have to specify what resources you would like to 
administer. How this is done is described in section 12.1. The next step is to specify which items 
consume resources and which items provide them. This step is described in section 12.2. Once 
everything is properly configured, you can view the resource details for specific items in the 
network. This is described in section 12.3.

12.1   Managing Resources
You can add, modify and delete resources in the resources overview. You can open the resources 
overview using the Administration > Resources Overview menu item. An example of 
the resources overview is shown in Illustration 85. 

Once you select a resource in the table of resources, the bottom part of the resources overview will 
show the details of the selected resource. The General tab shows the general properties of the 
resource. The Consumers tab lists all items consuming the selected resource. The Providers 
tab lists all items providing the selected resource.
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12.1.1   Creating a Resource
1. Open the resources overview as described above.

2. Click on the  button in the tool bar to the left of the tables of resources. The resource 
dialog will appear. An example of the resource dialog is shown in Illustration 86.

3. Specify the name of the resource, and optionally a description and a unit.

4. Click on the OK button. The new resource will appear in the resources overview.

12.1.2   Modifying a Resource
1. Open the resources overview as described above.

2. Select the resource you would like to modify in the table of resources.

3. If necessary, select the General tab in the bottom part of the resources overview.

4. Enter new values for name, description or unit and press Enter or Tab, or click 
somewhere else on the overview when done. The changes will be reflected in the table of 
resources.

12.1.3   Deleting a Resource
1. Open the resources overview as described above.

2. Select the resource you would like to delete in the table of resources.

3. Click on the  button in the tool bar to the left of the table of resources. PatchManager will 
ask for confirmation before deleting the resource.

4. Confirm the deletion. The selected resource will no longer appear in the table of resources.

Note that when you delete a resource, all information about its levels, consumers and providers is 
also lost.

12.2   Managing Consumers and Providers
Once you have created resources, you can specify which items consume and which items provide 
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the resources. Items that can consume and provide resources are locations, cabinets, equipment and 
cables. The quantity of each resource these items provide or consume can be specified at three 
levels. These levels are described in Table 47.

Level Description Specified in See section
Category Applies to all instances of all 

templates directly or indirectly 
in the category.

• Cabinet category dialog
• Equipment category dialog
• Cable category dialog

3.1.1.2

Template Applies to all instances of the 
template.

• Location template dialog
• Cabinet template dialog
• Equipment template dialog
• Cable template dialog

3.2.1 - 3.2.4

Item Applies only to the item itself. • Resource details view 12.3

Table 47: Consumers / Providers Specification Levels

When determining the quantity of a resource a specific item consumes or provides, PatchManager 
first checks if a quantity is specified for the item. If not found, it will check if a quantity is specified 
for the template. Finally, if no quantity is found, the category quantity will be used if available. If no 
quantity is specified at any of these levels, the item is assumed not to consume or provide the 
resource. 

You can specify quantities for categories, templates and items in the consumers and providers 
dialog. An example of this dialog is shown in Illustration 87. Where applicable, you can open the 
consumers and providers dialog by clicking on the  button.

PatchManager Reference Manual Version 4.1 Page 210 / 274



In order to change quantities you can double-click on the cell you would like to edit in the 
appropriate table. Once you have entered a value, press Enter to confirm it. When you are done, 
click on the OK button. The quantities will be saved in the database and applied where appropriate.

Note that consumption and provision quantities cascade upward in the hierarchy. Item A's 
consumption of resource R is calculated as the quantity of R consumed by A, plus the sum of the 
consumption of A's children. As a concrete example, consider the consumption of the resource 
'power' in a cabinet. The total power consumption in the cabinet consists of a base quantity for the 
cabinet (for example used by cooling fans) plus the sum of the power consumption of the 
equipment in the cabinet.

12.2.1   Resource Levels
If you have specified that an item provides a certain resource, you can specify levels of resource 
consumption. A level is a combination of a name for the level, a color and a range of values. When 
the consumption of the resource falls in this range, the consumption is considered to be at that level. 

For example, using resource levels, you can specify that 80% and less consumption of the power 
available in a cabinet is acceptable, whereas more than 80% is critical. Where appropriate, 
PatchManager will use the name and color associated with the resource level to indicate the 
consumption level (for example when viewing resource details, see section 12.3).

The range for a level is specified using a minimum and a maximum value (both inclusive). You can 
omit one of these values to create an open-ended range. Note that the ranges of multiple levels for 
the same resource cannot overlap. Also note that there is no limit to the number of levels you can 
specify for a resource provider.

Resource levels for a provider can be managed in the resource levels overview. You can open the 

PatchManager Reference Manual Version 4.1 Page 211 / 274

Illustration 87: Consumers / Providers Dialog



resource levels overview for a provider by clicking on the appropriate Levels button in the 
consumers and providers dialog (see Illustration 87). An example of the resource levels dialog is 
shown in Illustration 88. The following sections describe how to add, modify and delete resource 
levels.

12.2.1.1   Adding a Level
1. Open the resource levels overview, as described above.

2. Click on the  button in the tool bar next to the tables of levels. The resource level dialog 
will appear. An example of the resource level dialog is shown in Illustration 89.

3. Specify the values for the resource level. Note that when adding the first level for a resource, 
you can specify whether the minimum and maximum values should be treated as absolute 
values or percentages.

4. Click on the OK button. The new resource level will appear in the table of resources.
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12.2.1.2   Modifying a Level
1. Open the resource levels overview, as described above.

2. Select the resource level you would like to modify in the table of levels.

3. Click on the  button in the tool bar to the left of the table of resource levels. The resource 
level dialog will appear. An example of the resource level dialog is shown in Illustration 89. 
As an alternative to steps 2 and 3, you can also double-click on the resource level you would 
like to modify.

4. Specify the new values for the resource level.

5. Click on the OK button. If applicable, the table of resources will update to reflect the 
changes.

12.2.1.3   Deleting a Level
1. Open the resource levels overview, as described above.

2. Select the resource level you would like to delete in the table of levels.

3. Click on the  button in the tool bar to the left of the table of resource levels. 
PatchManager will ask for confirmation before deleting the resource level.

4. Confirm the deletion. The selected level will no longer appear in the table of resource levels.

Note that it is possible to select and delete multiple resource levels at the same time.

12.3   Viewing Resource Details
You can view the details of resource consumption for a certain item in the resource details view. An 
example of the resource details view is shown in Illustration 90. In order to view the resource 
details for an item, for example a cabinet, just click on it. The left part of the resource details view 
will show a summary of the consumption of resources in the item. The right part of the resource 
details view will show a summary of the resources consumed by the item.
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12.3.1   Charting
PatchManager can create line charts displaying the history of resource consumption for a resource 
and a provider of that resource, and pie charts displaying the current consumption. You can specify 
what data you would like to display and PatchManager can present forecasts based on the historical 
data. You can also export the resource data to a CSV file.

12.3.1.1   Creating Charts
1. Load the item for which you would like to chart the resource consumption in the resource 

details view, as described above.

2. Select the resource for which you would like to chart the consumption in the left table of the 
resource details view.

3. Click on the  button in the tool bar of the resource details view. A chart dialog will appear. 
An example of a chart dialog is shown in Illustration 91.
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12.3.1.2   Modifying Charts
You can specify both for consumption and provision if PatchManager should display the actual 
data, a moving average calculation or both. You can also select a date in the future for which you 
would like to forecast consumption and provision levels.

1. Open a chart dialog, as described in the previous section.

2. Make sure the Line Chart tab is selected.

3. Click on the Chart Settings button. The chart settings dialog will appear. An example 
of the chart settings dialog is shown in Illustration 92.

4. If you would like to enable forecasting, check the Forecast box and select a date in the 
future.

5. Select for consumption and provision whether you would like to see the actual data, a 
moving average or both (you can select both by pressing the Ctrl key on the keyboard 
before selecting the second item).

6. Click on the OK button. The chart will be updated to reflect the new configuration.
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12.3.1.3   Exporting Chart Data
1. Create a chart as described in the previous section.

2. In the chart dialog, click on the Export button.

3. Specify the file name and location.

4. Click on the Save button. The chart data will be written to the selected file.

12.3.2   Indicating Resource Levels on Cabinets
You can configure PatchManager to indicate the level of consumption of a specific resource for 
specific cabinets. If you do, instead of the standard color for the cabinet PatchManager will use the 
color associated with the current level of consumption (see section 12.2.1) of the selected resource 
when displaying cabinets in the location and cabinets overviews (see chapter 7).

In order to display the level of consumption of a resource for a cabinet, load the cabinet in the 
property sheet (see section 2.5), edit the Displayed Resource property and select the resource 
you would like to display. You can revert to the standard cabinet color by clearing the selected 
resource. Note that PatchManager will also use the standard color if the current consumption of the 
resource doesn't fall in the range of any level specified for the resource. Also note that the 
Displayed Resource property will also be editable if you select multiple cabinets, given that 
all selected cabinets currently have the same value for the property. 
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Chapter 13: Monitoring
Note: monitoring is implemented in the data center module. If you do not have this module, this 
section does not apply to your installation.
PatchManager has a monitoring facility that allows you to monitor changes to locations, cabinets 
and equipment. To enable monitoring, you can specify a monitor for an item, or a group of items. A 
monitor is a combination of a condition and an action; when the condition is met for the monitored 
item, the action is performed. 

For example, you can specify a monitor that ensures that whenever the value of a user attribute of a 
piece of equipment changes, an e-mail is sent to a given address or a report is uploaded to a given 
FTP account. Note that in order to send e-mails, an SMTP account should be registered in 
PatchManager. Registering an SMTP account is described in section 15.3.1.2.1. Adding FTP 
accounts is described in section 15.3.1.1.1.

You can get a view of all monitors specified in the application by opening the monitoring overview 
using the Administration > Monitoring menu item. An example of the monitoring 
overview is shown in Illustration 93.

Sections 13.1 through 13.3 describe how to add, modify and delete monitors. The available monitor 
conditions and monitor actions are described in sections 13.4 and 13.5 respectively.
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13.1   Adding a Monitor
Monitors can be specified for a single item, for all items of a template or for all items in a category.

1. Right-click on the item you would like to specify a monitor for. The items you can click on 
are listed in Table 48.

2. Select the Monitoring... option. The monitoring overview will open showing the 
monitors specified for the selected item.

3. Click on the  button in the tool bar of the monitoring overview. The monitor dialog will 
appear. An example of the monitor dialog is shown in 

4. Select a condition for the monitor. If applicable, you can click on the Edit... button 
below the condition to configure the selected condition. The available conditions are 
described in section 13.4.

5. Select an action for the monitor. If applicable, you can click on the Edit... button below 
the action to configure the selected action. The available actions are described in section 
13.5.

6. Click on the OK button. The new monitor will appear in the monitoring overview.

Item Description
Equipment Monitor changes to the selected equipment.
Equipment Template Monitor changes to all equipment of the selected equipment template.
Equipment Category Monitor changes to all equipment of an equipment template that is 

directly or indirectly in the selected equipment category.
Cabinet Monitor changes in the selected cabinet.
Cabinet Template Monitor changes in all cabinets of the selected cabinet template.
Cabinet Category Monitor changes in all cabinets of a cabinet template that is directly 

or indirectly in the selected cabinet category.
Location Monitor changes in the selected location.
Location Template Monitor changes to all locations of the selected location template.
Location Category Monitor changes to all locations of a location template that is directly 

or indirectly in the selected location category.

Table 48: Monitoring Options
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13.2   Modifying a Monitor
1. Open the monitoring overview as described in the first two steps of the previous section.

2. Select the monitor you would like to modify.

3. Click on the  button in the tool bar at the top of the monitoring overview. The monitor 
dialog will appear. An example of the monitor dialog is shown in Illustration 94. As an 
alternative to steps 2 and 3, you can also double-click on the monitor you would like to 
modify.

4. Specify the properties of the monitor as described in steps 4 and 5 of the previous section.

5. Click on the OK button. If applicable, the monitoring overview will reflect the changes to the 
monitor.

13.3   Deleting a Monitor
1. Open the monitoring overview as described in the first two steps of section 13.1.

2. Select the monitor you would like to delete.

3. Click on the  button in the tool bar at the top of the monitoring overview. PatchManager 
will ask for confirmation before deleting the selected monitor.

4. Confirm the deletion. The selected monitor will be removed from the monitoring overview.

13.4   Monitor Conditions
The following sections describe the conditions that can be used for monitors.
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13.4.1   Periodic Conditions
Periodic conditions can be specified so that monitor actions are performed periodically. The specific 
conditions available and the configuration properties associated with them are described in Table
49.

Condition Configuration Properties
Daily The time of day the action is performed.
Weekly The time of day and the day of the week the action is performed.
Monthly The time of day and the day of the month the action is performed.

Table 49: Periodic Conditions

13.4.2   User Attribute Change Condition
You can specify that a monitor action should be performed whenever the value for a user attribute 
changes (see chapter 8). You can further specify this condition using the properties described in 
Table 50.

Property Description
Attribute If specified, only changes to the value for this attribute meet this 

condition.
New Value If specified, only changes where the new value equals the specified 

value meet this condition.
Old Value If specified, only changes where the old value equals the specified 

value meet this condition.

Table 50: User Attribute Change Condition Configuration

13.4.3   Resource Conditions
There are three resource-related conditions available. They are described in Table 51. None of these 
conditions have further configuration properties associated with them.

Condition Description
Before Increase Met when a request is made that increases resource consumption.
Consumption Change Met when a request caused a change in resource consumption.
Level Change Met when a request caused a change in resource consumption level.

Table 51: Resource-related Conditions
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13.5   Monitor Actions
The following sections describe the actions that can be used for monitors.

13.5.1   E-Mail Action
The e-mail action sends an e-mail report when the corresponding monitor condition is met. The 
configuration properties for the e-mail action are described in Table 52. Note that an SMTP account 
must be registered before this action can be performed (see section 15.3.1.2.1).

Property Description
Address The e-mail address the report will be sent to. You can specify multiple 

addresses using a ; as separator.
Subject An optional subject line for the e-mail sent.

Table 52: E-Mail Action Properties

13.5.2   FTP Action
The FTP action uploads a report when the corresponding monitor condition is met. The 
configuration properties for the FTP action are described in Table 53.

Property Description
FTP Account The FTP account the report will be uploaded to. Registering FTP accounts 

is discussed in section 15.3.1.1.1.
Folder An optional folder on the FTP server the report will be uploaded to.
File Name The file name used for the uploaded report. You can use expressions such 

as {name}, {date} and {time} to construct the file name. 
{name} evaluates to the name of the item the report is about, {date} 
evaluates to the date the report was created and {time} evaluates to the 
time the report was created.

Table 53: FTP Action Properties

13.5.3   Confirmation Action
The confirmation action can be used to show a confirmation dialog detailing changes caused by a 
request made by a user before the request is handled. The confirmation action does not have any 
configuration properties associated with it.
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Chapter 14: User Access Management
PatchManager uses a security model based on users, user groups, user roles, user policies and 
actions. A user policy is a group of actions that can be performed by a policyholder. A policy can 
also specify that a certain action can only be performed with certain items. For example, you can 
specify that a user can only add cabinets in a specific location, or that a user can only edit templates 
in a certain category.

Policies are associated with user roles. Examples of roles are the administrator role, the operator 
role and the patcher role. Users are in one or more roles when working with PatchManager. These 
roles can be assigned to a single user or a group of users. User groups make it easy to assign roles to 
multiple users, for example all users in a specific department.

User administration is handled in the user overview, which can be opened using the 
Administration > User Overview menu entry or by clicking on the  button in the tool 
bar at the top of the window. Note that only users in the Administrator role are allowed to open the 
user overview. An example of the user overview is shown in Illustration 95. You can collapse and 
expand parts of the user overview by clicking on their headers.

Note that a bold font in the Users section indicates that the user is currently logged in. The 
following sections describe the administration of user policies, user roles, user groups and users.
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14.1   User Policies
The following sections describe how to add, modify, configure and delete user policies.

14.1.1   Adding a Policy
1. Open the user overview as described in the introduction to this chapter.

2. Expand the Policies section by clicking on its header.

3. Click on Add Policy.... The policy dialog will appear. An example of the policy dialog 
is shown in Illustration 96.

4. Enter a name and optionally a description of the policy.

5. Configure the actions in the policy as described in sections 14.1.3 and 14.1.4.

6. Confirm the changes by clicking on the OK button. The new policy will appear in the 
Policies section of the user overview.

14.1.2   Modifying a Policy
1. Open the user overview as described in the introduction to this chapter.

2. Expand the Policies section by clicking on its header.

3. Click on the name of the policy you would like to modify. The policy dialog will appear. An 
example of the policy dialog is shown in Illustration 96.

4. If applicable, enter a new name and description for the policy.

5. If applicable, configure the actions in the policy as described in sections 14.1.3 and 14.1.4.

6. Confirm the changes by clicking on the OK button. If applicable, the user overview will 
update to reflect the changes.
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14.1.3   Allowing and Disallowing Actions
1. Open the policy dialog by adding a policy or modifying an existing policy, as described in 

the sections above.

2. In the tree, select the action, or category of actions, you would like to allow or disallow.

3. Click on the  button in the tool bar to allow, or the  button in the tool bar to disallow the 
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selected actions. 

4. Click on the OK button to confirm the changes.

Note that a yellow check mark ( ) indicates that some, but not all of the actions in a category are 
allowed. Also note that if you allow or disallow viewing of items, the users holding the policy will 
not see any changes until they login again.

14.1.4   Configuring an Action
1. Open the policy dialog by adding a policy or modifying an existing policy, as described in 

the sections above.

2. In the tree, select the action you would like to configure. If an action is configurable, the  
button in the tool bar will be enabled.

3. Click on the  button in the tool bar. The constrain action dialog will appear. An example 
of the constrain action dialog (for the 'add equipment' action) is shown in Illustration 97.

4. If applicable, select the appropriate tab to view different items.

5. Select the items for which you would like to allow or disallow the action.

6. Click on the  button in the tool bar to allow, or the  button in the tool bar to disallow the 
selected actions. 

7. Confirm the changes by clicking on the OK button.

8. Save the changes to the policy by clicking on the OK button in the policy dialog.
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14.1.5   Deleting a Policy
1. Open the user overview as described in the introduction to this chapter.

2. Expand the Policies section by clicking on its header.

3. Click on the  button next to the policy you would like to delete. The policy will disappear 
from the Policies section of the user overview.

Note that the Allow All policy cannot be deleted.

14.2   User Roles
The following sections describe how to add, modify and delete user roles.

14.2.1   Adding a Role
1. Open the user overview as described in the introduction to this chapter.

2. Expand the Roles section by clicking on its header.
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3. Click on Add Role.... The role dialog will appear. An example of the role dialog is 
shown in Illustration 98.

4. Enter a name and optionally a description of the role.

5. Select the policies that apply to the role by clicking on them. You can remove a policy by 
clicking on it again.

6. Confirm the changes by clicking on the OK button. The new role will appear in the Roles 
section of the user overview.

14.2.2   Modifying a Role
1. Open the user overview as described in the introduction to this chapter.

2. Expand the Roles section by clicking on its header.

3. Click on the name of the role you would like to modify. The role dialog will appear. An 
example of the role dialog is shown in Illustration 98.

4. If applicable, enter a new name and description for the role.

5. If applicable, select the policies that apply to the role by clicking on them. You can remove a 
policy by clicking on it again.

6. Confirm the changes by clicking on the OK button. If applicable, the user overview will 
update to reflect the changes.
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14.2.3   Deleting a Role
1. Open the user overview as described in the introduction to this chapter.

2. Expand the Roles section by clicking on its header.

3. Click on the  button next to the role you would like to delete. The role will disappear from 
the Roles section of the user overview.

Note that the Administrator role cannot be deleted.

14.3   User Groups
The following sections describe how to add, modify and delete user groups.

14.3.1   Adding a Group
1. Open the user overview as described in the introduction to this chapter.

2. Expand the Groups section by clicking on its header.

3. Click on Add Group.... The group dialog will appear. An example of the group dialog is 
shown in Illustration 99.

4. Enter a name and optionally a description of the group.

5. Select the users who are member of the group by clicking on them. You can remove users by 
clicking on them again.

6. Select the roles that apply to the group by clicking on them. You can remove roles by 
clicking on them again.

7. Confirm the changes by clicking on the OK button. The new group will appear in the 
Groups section of the user overview.
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14.3.2   Modifying a Group
1. Open the user overview as described in the introduction to this chapter.

2. Expand the Groups section by clicking on its header.

3. Click on the name of the group you would like to modify. The group dialog will appear. An 
example of the group dialog is shown in Illustration 99.

4. If applicable, enter a new name and description for the group.

5. If applicable, select the users who are member of the group by clicking on them. You can 
remove users by clicking on them again.

6. If applicable, select the roles that apply to the group by clicking on them. You can remove 
roles by clicking on them again.

7. Confirm the changes by clicking on the OK button. If applicable, the user overview will 
update to reflect the changes.

14.3.3   Deleting a Group
1. Open the user overview as described in the introduction to this chapter.

2. Expand the Groups section by clicking on its header.

3. Click on the  button next to the group you would like to delete. The group will disappear 
from the Groups section of the user overview.
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14.4   Users
The following sections describe how to add, modify and delete users.

14.4.1   Adding a User
1. Open the user overview as described in the introduction to this chapter.

2. Click on Add User.... The user dialog will appear. An example of the user dialog is 
shown in Illustration 100.

3. Enter a user name and password and optional first and last names for the user. Note that you 
can check the User must change password at next login box to specify that 
a user should set a new password at the next login.

4. Select the groups the user is a member of. You can remove groups by clicking on them 
again.

5. Select the roles that apply to the user by clicking on them. You can remove roles by clicking 
on them again.

6. Confirm the changes by clicking on the OK button. The new user will appear in the Users 
section of the user overview.

Note that the new user will be asked to enter a new password the first time he or she logs in.

14.4.2   Modifying a User
1. Open the user overview as described in the introduction to this chapter.

2. Click on the user name of the user you would like to modify. The user dialog will appear. An 
example of the user dialog is shown in Illustration 100.

3. If applicable, enter the new values for the user. Note that you can check the User must 
change password at next login box to specify that a user should set a new 
password at the next login.

4. If applicable, select the groups the user is a member of. You can remove groups by clicking 
on them again.

5. If applicable, select the roles that apply to the user by clicking on them. You can remove 
roles by clicking on them again.

6. Confirm the changes by clicking on the OK button. If applicable, the user overview will 
update to reflect the changes.

Note that you cannot change the user name of the admin user and that you cannot remove the 
Administrator role from it. 
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14.4.3   Deleting a User
1. Open the user overview as described in the introduction to this chapter.

2. Click on the  button next to the user you would like to delete. The user will disappear 
from the Users section of the user overview. 

Note that you cannot delete the admin user.
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Chapter 15: Administration
This chapter discusses the various administrative tasks you may need to perform in order to use 
PatchManager. These include:

● History Tracking (section 15.1),

● File Management (section 15.2),

● Server Administration (section 15.3),

● Scheduled Imports (section 15.4),

● Labeling Schemes (section 15.5),

● Rules (section 15.7),

● Patterns (section 15.8),

● Setting Preferences (section 15.9) and 

● Getting Information About PatchManager (section 15.10).

15.1   History Tracking
PatchManager maintains a history of changes made in the database. You can view this history in its 
entirety, or for a single item in the database. An example of the history overview is shown in 
Illustration 101.
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15.1.1   Viewing the History Overview
1. Click on the  icon in the main tool bar. The history overview will open in the main 

window. Alternatively, you can use the Administration > History Overview 
menu entry.

15.1.2   Viewing the History Overview for a Single Item
1. Right-click on the item for which you would like to view the history, for example in the 

locations tree (see section 2.3) or a graphical overview (see chapter 7).

2. Select the History Overview option. The history overview will open showing only the 
history of the item you selected.

15.1.3   Using the History Overview
If there are multiple pages in the history overview, you can browse through them using the  and 

 buttons in the tool bar. If a line in the overview contains more details, you can use the tree 
controls appearing in the line to show or hide the details. You can right-click on the items in the 
Item column to get a menu with further action. You can also double-click on items to perform the 
default action. For example, double-clicking on an equipment instance in the history overview will 
show the equipment overview for that equipment instance (see section 7.4 for details on equipment 
overviews).
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15.1.4   Exporting History
The history overview can be exported to a comma-separated values (CSV) file for further 
processing in another application, such as Microsoft Excel. 

1. Open the history overview as described above.

2. Click on the  button in the tool bar. The dialog shown in Illustration 102 will appear.

3. Select the portion of the history you would like to export. You can select all, current page, or 
specify a start and end date. When specifying a range, both dates are inclusive.

4. If you would like the exported items to be deleted from the PatchManager database after the 
export has completed, select the Delete items after export box.

5. Click on the OK button.

6. Specify the path and file name of the export file.

7. Click on the Save button. If the specified file already exists, PatchManager will ask for 
confirmation before overwriting the file.

8. After writing the file, PatchManager will inform you that the export succeeded. If you have 
chosen to delete the items as well, the items will be removed from the database and the 
history overview will be updated accordingly.

15.2   File Management
PatchManager uses support files extensively. For example, icons are displayed in the trees and 
graphical overviews to represent your data. Images are another example; their uses include being 
displayed as background images for equipment and locations. Finally, files can be associated with 
items through the use of file-set user attributes.
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The files available in PatchManager are maintained on the server, but the administration of these 
files can be performed using the client software, through the file management dialog. An example 
of the file management dialog is shown in Illustration 103. You can open the file management 
dialog by using the Administration > File Management menu entry, or by clicking on 
the  button in the tool bar at the top of the window. 

The file management dialog consists of three tabs; one for icons, one for images, and one for other 
files. All tabs have similar functionality. The actions discussed below refer to the administration of 
images, but are equally applicable to icons and other files.

15.2.1   Adding a Folder
1. Open the file management dialog, as described above.

2. Select the Images tab.

3. Select the folder in which the new sub-folder should be added.

4. Click on the Create Folder button.

5. Enter the name for the new folder.
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6. Press Enter or click on the OK button. The new folder will appear in the tree.

15.2.2   Adding Images
The following steps can be used to either add a new image or replace an existing image. 

1. Open the file management dialog, as described above.

2. Select the Images tab.

3. Select the folder to which the new image should be added.

4. Click on the Upload button.

5. In the dialog that appears, browse to the image to be added and select it. Note that you can 
select multiple images.

6. Click on the Open button. The image will appear in the tree.

15.2.3   Downloading Images
If you would like to edit an image on the server, you should first download it to the local machine. 
You can then edit it using any image-editing software. After editing the file, you can upload it to the 
server again as discussed in the previous section.

1. Open the file management dialog, as described above.

2. Select the Images tab.

3. Select the images and folders to be downloaded.

4. Click on the Download button.

5. In the dialog that appears, select the destination folder for the download and click on the 
Save button.

6. The selected images and folders will be downloaded to the selected destination. 
PatchManager will inform you when the download is complete.

15.2.4   Deleting Folders and Images
1. Open the file management dialog, as described above.

2. Select the Images tab.

3. Select the images and folders to be deleted. Note that non-empty folders cannot be deleted 
directly.

4. Click on the Delete button. The tree will be updated accordingly.

15.3   Server Administration
The following sections describe how external servers can be configured and how you can change 
the global SNMP configuration for PatchManager.
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15.3.1   External Servers
PatchManager can interact with several types of external servers. For example, the monitoring 
facility (see chapter 13) uses an SMTP account to send e-mails, or an FTP account to upload files. 
Accounts for external servers can be specified in the server administration overview. You can open 
this overview using the Administration > Server Administration menu entry, or by 
clicking on the  button in the tool bar at the top of the window. External servers are displayed in 
the Servers tab. An example of this tab is shown in Illustration 104. The following sections 
describe how to add, modify and delete accounts for external servers.

15.3.1.1   FTP Servers
PatchManager can be configured to upload reports to an FTP server when certain conditions are 
met. The following sections show how to add, modify and delete FTP accounts.

15.3.1.1.1   Adding an FTP Account
1. Open the server administration overview, as described above, and select the Servers tab.

2. Click on the  button in the tool bar above the table of FTP accounts. The FTP server 
dialog will appear. An example of the FTP server dialog is shown in Illustration 105.

3. Specify the properties of the FTP account.

4. Click on the OK button. The new FTP account will appear in the server administration 
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overview.

15.3.1.1.2   Modifying an FTP Account
1. Open the server administration overview, as described above, and select the Servers tab.

2. Select the FTP account you would like to modify in the table of FTP accounts.

3. Click on the  button in the tool bar above the table of FTP accounts. The FTP server 
dialog will appear. An example of the FTP server dialog is shown in Illustration 105. As an 
alternative to steps 2 and 3 you can also double-click on the account you would like to 
modify.

4. Specify the properties of the FTP account.

5. Click on the OK button. If applicable the changes to the FTP account will be reflected in the 
server administration overview.

15.3.1.1.3   Deleting an FTP Account
1. Open the server administration overview, as described above, and select the Servers tab.

2. Select the FTP account you would like to delete in the table of FTP accounts.

3. Click on the  button in the tool bar above the table of FTP accounts. PatchManager will 
ask for confirmation before deleting the selected account.

4. Confirm the deletion. The selected account will be removed from the table of FTP accounts.
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15.3.1.2   SMTP Servers
PatchManager can be configured to send e-mail reports when certain conditions are met. The 
following sections show how to add, modify and delete SMTP accounts. Note that if you specify 
multiple SMTP accounts, PatchManager will try each of them in unspecified order until one works.

15.3.1.2.1   Adding an SMTP Account
1. Open the server administration overview, as described above, and select the Servers tab.

2. Click on the  button in the tool bar above the table of SMTP accounts. The SMTP server 
dialog will appear. An example of the SMTP server dialog is shown in Illustration 106.

3. Specify the properties of the SMTP account.

4. Click on the OK button. The new SMTP account will appear in the server administration 
overview.

15.3.1.2.2   Modifying an SMTP Account
1. Open the server administration overview, as described above, and select the Servers tab.

2. Select the SMTP account you would like to modify in the table of SMTP accounts.

3. Click on the  button in the tool bar above the table of SMTP accounts. The SMTP server 
dialog will appear. An example of the SMTP server dialog is shown in Illustration 106. As 
an alternative to steps 2 and 3 you can also double-click on the account you would like to 
modify.
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4. Specify the properties of the SMTP account.

5. Click on the OK button. If applicable the changes to the SMTP account will be reflected in 
the server administration overview.

15.3.1.2.3   Deleting an SMTP Account
1. Open the server administration overview, as described above, and select the Servers tab.

2. Select the SMTP account you would like to delete in the table of SMTP accounts.

3. Click on the  button in the tool bar above the table of SMTP accounts. PatchManager will 
ask for confirmation before deleting the selected account.

4. Confirm the deletion. The selected account will be removed from the table of SMTP 
accounts.

15.3.2   SNMP Configuration
Note: in order to use the SNMP functionality, it needs to be enabled explicitly in the configuration 
of the server software. See the PatchManager Configuration Reference for details.
The global SNMP configuration used by PatchManager can be modified in the SNMP tab of the 
server administration overview. An example of this tab is shown in Illustration 107. The settings 
that can be configured are described in Table 54. Note that each of these settings can be overridden 
on a per-equipment basis by loading the equipment in the property sheet (see section 2.5). 
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Property Description
Interval (ms) The time between requests in milliseconds. If this is set to 0, no requests 

will be made.
Host The expression that will be used to evaluate the network address SNMP 

requests will be sent to. You can enter the actual address, or an expression in 
the form {a}, meaning that for each equipment, the value for user attribute 
a will be used as the address.

Port The port number SNMP requests will be sent to.
Time Out (ms) How long PatchManager will wait for a response from the equipment in 

milliseconds. If an equipment instance does not respond to an SNMP request 
within this period, the default value for the user attribute corresponding to 
the SNMP request will be applied to the equipment.

Retries How many times PatchManager will attempt to retrieve a value from the 
equipment.

Version The version of the SNMP protocol PatchManager will use to send requests 
to equipment.

Table 54: SNMP Configuration Properties

15.4   Scheduled Imports
Scheduled imports can be set up to periodically synchronize the data in the PatchManager database 
with an external source. Certain actions are disabled while a scheduled import is running 
(depending on the type of import). To indicate that a scheduled import is running, its name will 
appear in the lower right corner of the window. If an error occurs while running the import, its name 
will be highlighted using a red background; moving the mouse over the red area will provide a hint 
identifying the type of error.

You can view the currently configured imports and schedule new imports in the scheduled imports 
overview, as shown in Illustration 108. Use the Administration > Scheduled Imports 
menu entry or click on the  button in the tool bar at the top of the window to open the scheduled 
imports overview. Note that the scheduled imports overview also indicates whether or not an import 
is running: a running import is highlighted in yellow in the table.

The table in the scheduled imports overview shows the currently configured imports. Note that it is 
possible to configure a scheduled import without actually scheduling it by setting the Enabled 
property of a scheduled import to false, as discussed below. Scheduled imports that are enabled are 
shown in the scheduled imports overview using a regular font, whereas imports that are not enabled 
are shown using a grayed out font.
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15.4.1   Scheduled Import Properties
Scheduled imports are configurable using the properties described in Table 55.

Property Description
Name A unique name for the scheduled import.
Type The type of the scheduled import. 
Configuration File A path on the server where the configuration of the 

scheduled import will be saved. This may be a path 
relative to the installation folder of the server.

Log File A path on the server where the results of the scheduled 
import will be logged. This may be a path relative to the 
installation folder of the server.

Period The time, in minutes, the server waits between two runs of 
the import (if the import is enabled).

Enabled Tells whether or not the server should actually schedule the 
import. 

<type-specific 
properties>

Depending on the type of import selected, there may be 
additional properties to configure.

Table 55: Scheduled Import Properties
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15.4.2   Adding a Scheduled Import
1. Open the scheduled imports overview, as discussed above.

2. Click on the Add... button. A dialog similar to the one shown in Illustration 109 will 
appear.

3. Enter the values for the scheduled import (see section 15.4.1 for a description of the 
properties). Note that the type-specific properties can be entered in the Configuration 
tab of the dialog.

4. Click on the OK button. The new scheduled import will appear in the scheduled imports 
overview.

15.4.3   Modifying a Scheduled Import
1. Open the scheduled imports overview, as discussed above.

2. Select the import that is to be modified by clicking on it in the table.

3. Click on the Edit... button. A dialog similar to the one shown in Illustration 109 will 
appear with the values for the selected scheduled import filled in.

4. Enter the values for the scheduled import (see section 15.4.1 for a description of the 
properties). Note that the type-specific properties can be entered in the Configuration 
tab of the dialog.

5. Click on the OK button. If applicable the scheduled imports overview will update according 
to the changes.
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15.4.4   Scheduling a Scheduled Import
A scheduled import will be scheduled by PatchManager if its Enabled property is set to true. It 
will be run when the server is started, and repeated according to its Period property. Use the 
methods described in the section above to change the Enabled and Period properties of an 
import.

15.4.5   Running a Scheduled Import
Use the following steps if you would like to perform a single run of a scheduled import without 
enabling it.

1. Open the scheduled imports overview, as discussed above.

2. Select the import that is to be run by clicking on it in the table.

3. Click on the Run Now button. The import will appear in the lower right corner of the 
window, and will be highlighted in yellow in the table.

15.4.6   Deleting a Scheduled Import
1. Open the scheduled imports overview, as discussed above.

2. Select the import that is to be deleted by clicking on it in the table.

3. Click on the Delete button.

15.5   Labeling Schemes
You can create labeling schemes to automatically manage the labeling of cables. The main part of a 
labeling scheme is its format. This format will be applied to the current state of a cable to determine 
what the label of the cable should be. The format of a labeling scheme can contain expressions so 
that the label of a cable will contain, for example, the labels of the ports it is connecting. If a cable 
uses a labeling scheme to show its current state, any changes to that state will automatically be 
reflected in the cable label.

Labeling schemes can be managed in the labeling schemes overview. You can open the labeling 
schemes overview using the Administration > Labeling Schemes menu item, or by 
clicking on the  button in the tool bar at the top of the window. An example of the labeling 
schemes overview is shown in Illustration 110. 

The following three sections describe how to add, modify and delete labeling schemes. Section 
15.5.4 describes the various options you have to construct the format of a labeling scheme.
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15.5.1   Adding a Labeling Scheme
1. Open the labeling schemes overview, as described above.

2. Click on the  button in the tool bar at the top of the labeling schemes overview. A new 
labeling scheme dialog will appear. An example of the labeling scheme dialog is shown in 
Illustration 111.

3. Enter the name and optionally a description of the labeling scheme you would like to add.

4. Enter the format of the labeling scheme you would like to add. Labeling scheme formats are 
described in section 15.5.4.

5. Click on the Apply or OK button. The new labeling scheme will appear in the labeling 
schemes overview.
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15.5.2   Modifying a Labeling Scheme
1. Open the labeling schemes overview, as described above.

2. Select the labeling scheme you would like to modify in the table of labeling schemes.

3. Click on the  button in the tool bar at the top of the labeling schemes overview. The 
labeling scheme dialog will appear. An example of the labeling scheme dialog is shown in 
Illustration 111. Note that as an alternative to steps 2 and 3 you can also double-click on the 
labeling scheme you would like to modify.

4. Enter the new values for the labeling scheme.

5. Click on the Apply or OK button. If applicable the new values will be reflected in the 
labeling schemes overview. Note that changes in the format will be automatically applied to 
cables that are using the labeling scheme.

15.5.3   Deleting a Labeling Scheme
1. Open the labeling schemes overview, as described above.

2. Select the labeling scheme you would like to delete in the table of labeling schemes.

3. Click on the  button in the tool bar at the top of the labeling schemes overview. Before 
deleting the labeling scheme PatchManager will first ask for confirmation.

4. Confirm the deletion by clicking on the Yes button. The selected labeling scheme will be 
removed from the labeling schemes overview.

Note that you cannot delete a labeling scheme that is currently in use.
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15.5.4   Labeling Scheme Formats
The format of a labeling scheme determines what the label of a cable will be when the labeling 
scheme is applied. Note that the format of a labeling scheme can contain line breaks and 
consequently cables can have labels of multiple lines1. Also, the format of the labeling scheme can 
be split up into several sections. Each section can contain expressions that will be evaluated against 
the current state of the cable. When the state of the cable that has a labeling scheme applied 
changes, the appropriate labels will be updated automatically.

Below, the different sections allowed in a labeling scheme are described. For each section, a 
description when the section applies is given and the applicable expressions are listed. Note that if 
an expression cannot be evaluated for a specific cable, the expression will appear unchanged in the 
cable label.

15.5.4.1   Default Section
The default section is applied when the cable is disconnected, or when no other section is specified 
in the labeling scheme. The default section should start with the text [DEFAULT]. However, if the 
default section is the only section specified in the labeling scheme the header can be omitted.

The expressions available in the default section are described in Table 56. Note that the location-
related expressions can only be applied if the cable is disconnected. You can also use expressions 
from the connected section in the default section, but note that these can only be evaluated if the 
cable is actually connected.

Expression Description
{<location-template-
name>}

Name of the location of the given location template the cable is 
directly or indirectly located in.

{location} Name of the location the cable is located in.
{qualified-location} Qualified name of the location the cable is located in.
{template} Name of the template of the cable.
{qualified-template} Qualified name of the template of the cable (i. e. including 

categories).
{<sequence-name>} Next value from a sequence. <sequence-name> must match an 

existing sequence (see section 15.6).
{<attribute-name>} Value for a user attribute of the cable. <attribute-name> 

must match an existing user attribute that is applied to the cable 
(see chapter 8).

Table 56: Labeling Scheme Expressions: Default Section

1 If a cable has a multi-line label and PatchManager needs to display this label on a single line, it will do this by 
replacing line breaks in the label with slash characters (/).
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15.5.4.2   Connected Section
The connected section applies when the cable is connected to at least one port. The connected 
section should start with the text [CONNECTED]. The expressions available in the connected 
section are described in Table 57.

Note that some of the expressions listed in Table 57 are indexed, for example {port-N}, which 
evaluates to the port connected to the cable on the Nth equipment that is connected to the cable. 
When evaluating indexed expressions PatchManager orders the equipment the cable is connected to 
by their labels.

Instead of entering a number for N, you can also enter source (which will be evaluated as 1) or 
dest (which will be evaluated as 2). For example, {port-source} is the same a {port-1} 
and {port-dest} is the same as {port-2}.
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Expression Description
{<location-template-name>-N} Name of the location of the given location template the 

Nth equipment the cable is connected to is directly or 
indirectly located in.

{location-N} Name of the location the Nth equipment the cable is 
connected to is located in.

{qualified-location-N} Qualified name of the location the Nth equipment the 
cable is connected to is located in.

{cabinet-N} Name of the cabinet the Nth equipment the cable is 
connected to is located in.

{U-position-N} U-position of the Nth equipment the cable is connected 
to.

{equipment-N} Label of the Nth equipment the cable is connected to.
{equipment-template-N} Name of the template of the Nth equipment the cable is 

connected to.
{qualified-equipment-N} Qualified label of the Nth equipment the cable is 

connected to.
{port-N} Label of the (first) port the cable connects on the Nth 

equipment the cable is connected to.
{port-template-N} Name of the template of the (first) port the cable 

connects on the Nth equipment the cable is connected 
to.

{ports-N} Labels of the ports the cable connects on the Nth 
equipment the cable is connected to.

{template} Name of the template of the cable.
{qualified-template} Qualified name of the template of the cable (i. e. 

including categories).
{<sequence-name>} Next value from a sequence. <sequence-name> 

must match an existing sequence (see section 15.6).
{<attribute-name>} Value for a user attribute of the cable. <attribute-

name> must match an existing user attribute that is 
applied to the cable (see chapter 8).

Table 57: Labeling Scheme Expressions: Connected Section

15.5.4.3   Elements Section
The elements and connected elements sections are similar to the default and connected sections. 
However, these sections are used to calculate labels for the cable-elements in the cable instead of 
the cable itself. The elements section should start with the text [ELEMENTS]. All the expressions 
available in the default, connected and connected elements sections can also be used in the elements 
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section. 

15.5.4.4   Connected Elements Section
The connected elements section applies to cable-elements that are connected to at least one port. 
This section should start with the text [ELEMENTS-CONNECTED]. All expressions available in 
the connected section are also available in the connected elements section. Additionally, the 
expressions described in Table 58 can be applied in the connected elements section.

Expression Description
{terminator-N} Label of the (first) terminator the cable-element terminates in 

on the Nth equipment the cable is connected to.
{terminator-template-N} Name of the template of the (first) terminator the cable-

element terminates in on the Nth equipment the cable is 
connected to.

{terminators-N} Labels of the terminators the cable-element terminates in on 
the Nth equipment the cable is connected to.

Table 58: Labeling Scheme Expressions: Connected Elements Section

15.5.4.5   Termination Labels Section
Termination labels are cable labels that apply to one side of the cable. For example, termination 
labels can be used in the field to indicate on a cable where the other side of the cable terminates. 
Termination labels are not used in the PatchManager interface. However, they are included when 
exporting cable labels (see section 10.2) making it easy to print them and apply them to the actual 
cables.

The termination labels section should start with the text [TERMINATION-LABELS]. When a 
termination labels section is specified and the labels of a cable are exported, a termination label is 
exported for each equipment instance the cable is connected to. For example, a simple patch cable 
connecting two ports on different equipment will have two termination labels.

The expressions available in the termination labels sections are described in Table 59. Keep in mind 
that each expression is evaluated relative to a single equipment instance the cable is connected to.
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Expression Description
{<location-template-name>} Name of the location of the given template the equipment 

is directly or indirectly located in.
{cabinet} Name of the cabinet the equipment is located in.
{location} Name of the location the equipment is located in.
{qualified-location} Qualified name of the location the equipment is located 

in.
{equipment} Label of the equipment.
{equipment-template} Name of the template of the equipment.
{qualified-equipment} Qualified label of the equipment.
{U-position} U-position of the equipment.
{port} Label of the (first) port on the equipment the cable 

connects.
{port-template} Name of the template of the (first) port on the equipment 

the cable connects.
{ports} Labels of the ports on the equipment the cable connects.

Table 59: Labeling Scheme Expressions: Termination Labels Section

15.6   Sequences
A sequence is a list of values. Sequences can be used in labeling schemes; when using sequences in 
labeling schemes, each item the labeling scheme applies to will receive a unique value from the 
sequence. 

Sequences can be managed in the sequences overview. You can open the sequences overview using 
the Administration > Sequences Overview menu item, or by clicking on the  button 
in the tool bar at the top of the window. An example of the sequences overview is shown in 
Illustration 112. The following sections describe how to add, modify, and delete sequences 
respectively.
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15.6.1   Adding a Sequence
1. Open the sequences overview, as described above.

2. Click on the  button in the tool bar at the top of the sequences tab. A new sequence dialog 
will appear. An example of the sequence dialog is shown in Illustration 113.

3. Enter values for the properties of the sequence. The properties of a sequence are described in 
Table 60.

4. Click on the Apply or OK button. The new sequence will appear in the table of sequences.
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Property Description
Name Name of the sequence. This name should be used to apply the 

sequence in a labeling scheme.
Expression Expression of the sequence. By default this is simply {counter}, 

but you can enter text before and after this value to create more 
complex sequences.

Start Starting value of the counter used in the sequence. This can be a 
number or a letter.

Step The increment or decrement used to obtain the next value for the 
counter.

Padding Character Padding character used to make sure sequence values have the same 
length.

Counter Length Length, in number of characters, of the counter part of the sequence. If 
the counter part is shorter than this value, the padding character will be 
added at the front until the counter is long enough.

Table 60: Sequence Properties

15.6.2   Modifying a Sequence
1. Open the sequences overview, as described above.
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2. Select the sequence you would like to modify in the table of sequences.

3. Click on the  button in the tool bar at the top of the sequences tab. The sequence dialog 
will appear. An example of the sequence dialog is shown in Illustration 113.

4. Enter the new values for the properties of the sequence. The properties of a sequence are 
described in Table 60.

5. Click on the Apply or OK button. If applicable the table of sequences will be updated to 
reflect the changes to the sequence.

Note that if the modified sequence is used in a labeling scheme that is currently applied to cables, 
the labels of those cables will be updated to reflect the changes to the sequence.

15.6.3   Deleting a Sequence
1. Open the sequences overview, as described above.

2. Select the sequence you would like to delete in the table of sequences.

3. Click on the  button in the tool bar at the top of the sequences tab. Before deleting the 
sequence PatchManager will ask for confirmation.

4. Confirm the deletion by clicking on the Yes button. The selected sequence will be removed 
from the table of sequences.

15.7   Rules
PatchManager's rule mechanism provides a flexible way of introducing optional rules to the 
software. An example of a rule that can be specified is 'decorate all equipment with IP-addresses 
starting with 192.168.0 with a green border'. 

Rules can be managed in the rules overview. You can open the rules overview by selecting the 
Administration > Rules menu item, or by clicking on the  button in the tool bar at the 
top of the window. An example of the rules overview is shown in Illustration 114. The following 
sections describe how to add, modify, enable, disable and delete rules.
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15.7.1   Adding a Rule
1. Open the rules overview, as described above.

2. Click on the  button in the tool bar at the top of the rules overview. The rule dialog will 
appear. An example of the rule dialog is shown in Illustration 115.

3. Select the type of rule you would like to add.

4. Click on the Next button. Based on the type of rule you selected, the dialog will guide you 
through the necessary configuration steps for the rule. You can click on the Next button to 
go to the next configuration step and on the Previous button to go back to the previous 
configuration step.

5. Once the rule is completely configured, click on the Finish button. The new rule will 
appear in the rules overview.
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15.7.2   Modifying a Rule
1. Open the rules overview, as described above.

2. Select the rule you would like to modify.

3. Click on the  button in the tool bar at the top of the rules overview. The rule dialog will 
appear. An example of the rule dialog is shown in Illustration 115. Note that you cannot 
change the type of an existing rule. As an alternative for steps 2 and 3, you can also double-
click on the rule you would like to modify.

4. Use the rule dialog to change the configuration of the rule.

5. When the rule configuration is complete, click on the Finish button. If applicable, the 
rules overview will update to reflect the changes.

15.7.3   Enabling or Disabling a Rule
You can temporarily disable a rule and enable it at a later time. Simply click on the check box in the 
table cell of the rule you would like to enable or disable.

15.7.4   Deleting a Rule
1. Open the rules overview, as described above.

2. Select the rule you would like to delete.

3. Click on the  button in the tool bar at the top of the rules overview. Before deleting the 
selected rule, PatchManager will ask for confirmation.

4. Confirm the deletion. The selected rule will disappear from the rules overview.

Note that it is possible to select and delete multiple rules at the same time.
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15.8   Patterns
PatchManager allows you to specify patterns for different purposes. Examples are constraining the 
possible names of cabinets (see section 3.2.2), constraining the possible labels of ports (see section 
3.2.7) and constraining the possible values for user attributes (see chapter 8).

Patterns can be managed in the patterns overview. An example of the patterns overview is shown in 
Illustration 116. The patterns overview can be opened using the Administration > 
Patterns Overview menu entry or by clicking on the  button in the tool bar at the top of the 
window.

Adding, modifying, and deleting patterns are described in sections 15.8.1 through 15.8.3. You can 
also export and import patterns, as described in sections 15.8.4 and 15.8.5. The format 
PatchManager uses for specifying patterns is regular expressions. Appendix A provides an 
introduction to regular expressions2. 

15.8.1   Adding a Pattern
1. Open the patterns overview, as described above.

2. Click on the  button in the tool bar at the top of the patterns overview. A dialog similar to 

2 Please note that the syntax used to create regular expressions is programming language-specific. The conventions 
used for regular expressions in PatchManager are based on those used in the Java TM programming language, which 
are very similar to those used in the Perl programming language.
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the one shown in Illustration 117 will appear.

3. Enter the values for the pattern. Note that the name, expression and example are required, 
and that the name must be unique.

4. Click on the OK button. The new pattern will appear in the table of patterns.

15.8.2   Modifying a Pattern
1. Open the patterns overview, as described above.

2. Select the pattern you would like to modify.

3. Click on the  button in the tool bar at the top of the patterns overview. A dialog similar to 
the one shown in Illustration 117 will appear. Note that as an alternative for steps 2 and 3, 
you can also double-click on the pattern you would like to modify.

4. Enter the new values for the pattern. Note that the name, expression and example are 
required, and that the name must be unique.

5. Click on the OK button. If applicable, the changes will be reflected in the table of patterns.

15.8.3   Deleting a Pattern
1. Open the patterns overview, as described above.

2. Select the pattern you would like to delete.

3. Click on the  button in the tool bar at the top of the patterns overview. PatchManager will 
ask for confirmation before deleting the selected pattern.

4. Confirm the deletion by clicking on the Yes button. The selected pattern will disappear 
from the table of patterns.

Note that it is possible to select and delete multiple patterns at the same time. Also note that it is not 
possible to delete a pattern if it is in use.
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15.8.4   Exporting Patterns
You can export the patterns in the database to a comma-separated values (CSV) file. The following 
steps describe how to do this. The resulting file can be used to import the patterns in another 
database, as described in the following section.

1. Open the patterns overview, as described above.

2. Click on the  button in the tool bar at the top of the patterns overview. A file selection 
dialog will appear.

3. Select the file you would like to export the patterns to.

4. Click on the Save button. The patterns will be exported to the selected file.

15.8.5   Importing Patterns
1. Open the patterns overview, as described above.

2. Click on the  button in the tool bar at the top of the patterns overview. A file selection 
dialog will appear.

3. Select the file you would like to import the patterns from.

4. Click on the Open button. The patterns from the selected file will be imported.

15.9   Setting Preferences
The preferences dialog can be opened using the File > Preferences menu entry. An example 
of the preferences dialog is shown in Illustration 118. The preferences dialog presents both global 
preferences and user-specific preferences. Global preferences apply to all users. Note that you need 
permission to modify global preferences (see chapter 14).

User-specific preferences apply only to your account. Note that your user-specific preferences will 
be applied on every computer you run the PatchManager client on. The settings available in the 
preferences dialog are discussed in Table 61. 
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Setting Description
Enable Recycle Bin Specifies whether or not deleted objects should be moved to the 

recycle bin. If the recycle bin is disabled, deleting an item will delete 
it from the database directly, and the deletion cannot be undone.

Session Expiry If a value is specified for session expiry, inactive users will 
automatically be logged off after the number of minutes specified has 
passed since the last user activity. Note that a value of 0 means that 
users will never be automatically logged off.

Unit When displaying dimensions, PatchManager will use the unit selected 
here. Note that when editing individual values, a different unit can 
usually be selected by clicking on the unit indicator (for example, '' 
for inches).

Export Separator The character that is used as the separator in exported files. The 
default value is ,, resulting in comma-separated values file (CSV).

Paper Size The default page size used when printing.
Look and Feel This setting can be used to change the appearance of the interface. 

Changes to this setting will become visible when the PatchManager 
Client is restarted.

Background Color Where applicable, PatchManager will use this background color. The 
graphical overviews (see chapter 7) and the connection details view 
(see section 6.4) are examples of where the background color is 
applied.

Table 61: Global Preferences

15.10   Getting Information About PatchManager
The about PatchManager dialog can be opened using the Help > About PatchManager 
menu entry. Alternatively, you can right-click on the enterprise in the locations tree and click on the 
About PatchManager option. Illustration 119 shows an example of the about PatchManager 
dialog.
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Appendix A: Regular Expressions
A regular expression is a string of characters that follows several rules to define a set of strings of 
characters. Each string of characters in the set defined by a regular expression is said to 'match' the 
regular expression. 

In the following, the word string refers to strings of characters. A blue, fixed-width font is used for 
regular expressions, a regular fixed-width font is used for strings matching the regular expression.

For example, the regular expression gr[ae]y defines a set of two words: gray and grey. 
Alternatively, the words gray and grey match the regular expression gr[ae]y (the rules used in 
this regular expression are discussed in sections A.1 and A.3).

The following sections describe the rules used most often in regular expressions. A complete 
discussion of regular expressions is beyond the scope of this manual. Good articles on regular 
expressions can be found on-line.

A.1   Literal Characters
Characters appearing in a certain position in a regular expression must appear in the corresponding 
position in each string that matches the regular expression. Consequently, a regular expression 
containing only simple characters defines exactly one string, namely the regular expression itself. 
For example, only the word ABC matches the regular expression ABC.

Some characters have a special meaning in regular expressions. These are (, [, {, \, ^, -, $, |, ], 
}, ), ?, * and +. If you would like to use one of these characters as a literal character (in other 
words, if you would like to specify that one of these characters should appear in the strings 
matching the regular expression), you should add a \ before the character. For example, the regular 
expression \(ABC\) defines the string (ABC).

A.2   Wildcard Character
A . appearing in a regular expression means that any character is allowed at the corresponding 
position. For example, the regular expression A.C defines the set of strings of three characters, 
starting with A and ending with C with any character in between (such as AAC, ABC, ACC et cetera).

A.3   Character Sets
You can specify that the character at a certain position must be a member of a certain set of 
characters by specifying a character set between square brackets. Some simple examples of 
character sets are described in Table 62. As the last two examples show, character sets can be 
combined to create more complex sets.

PatchManager Reference Manual Version 4.1 Page 263 / 274



Character Set Description
[ABC] This character must be A, B or C.
[^ABC] This character can be any character except A, B or C.
[A-Z] This character must be an upper-case letter.
[a-z] This character must be a lower-case letter.
[0-9] This character must be a digit.
[A-Za-z0-9] This character must be an upper-case letter, lower-case letter or digit.
[A-Z&&[^QXY]] This character must be an upper-case letter, but not Q, X or Y.

Table 62: Regular Expression Character Set Examples

For example, the regular expression A[0-3] defines the strings A0, A1, A2 and A3.

A.4   Quantification
You can use quantification to specify that part of a regular expression can or must appear multiple 
times. The quantifiers you can use are described in Table 63.

Quantifier Description
? The preceding character can appear once, or not at all.
* The preceding character can appear zero or more times.
+ The preceding character can appear one or more times.
{N} The preceding character must appear exactly N times.
{N,M} The preceding character must appear at least N times and at most M times. 

Note that at least one of N and M must be specified. For example, {,5} means 
at most five times.

Table 63: Regular Expression Quantifiers

For example, the regular expression A+ defines strings containing one or more A characters. Note 
that quantifiers can also be applied to character sets or groups (described in the following section). 
For example, the regular expression [ABC]{3} defines strings of three characters, where each 
character is A, B or C. All strings match the regular expression .*; in PatchManager specifying .* 
as pattern is equivalent to not specifying any pattern.

A.5   Groups
Grouping allows you to apply quantifiers to groups of characters. You can group characters by 
surrounding them with braces. For example, the regular expression (ABC){2} defines the string 
ABCABC. You can also apply grouping to character classes. In this case, each repetition of the group 
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must be the same. For example, the regular expression ([A-Z]{2}){2} defines strings of four 
capital letters, where the first two letters are the same as the last two letters.

PatchManager Reference Manual Version 4.1 Page 265 / 274



Appendix B: Data Exchange File Specifications
Sections B.1 through B.5 describe the CSV formats used for the import of locations, network 
objects and connections by presenting the columns expected along with a short description of each 
column. Section B.6 describes column types used in the different import file formats. Finally, 
special characters used in import files are described in section B.7.

B.1   Locations
Each row in a locations CSV file corresponds to a single location. The columns in a locations CSV 
file are described in Table 64. The table indicates which columns can be used when updating 
existing locations (see section 10.1). A row in a locations file is considered to be an update if a 
location with the same Location Name already exists in the location identified by Location 
Parent.

Column Description Update
Location 
Parent

Identifier identifying the parent location of the location in this row. 
See section 10.1.1.1 for details on identifiers. Note that an empty 
value represents the enterprise location.

Location 
Name

The name of the location in this row.

Location 
Template

The name of the template of the location in this row.

Location 
Description

An optional description of the location in this row. √

Location 
Background

An optional background image for the location overview of the 
location in this row.

√

Location 
Position

Optional overview coordinates for the location in this row. See the 
Coordinates column type in section B.6.

√

Location 
Attributes

The user attributes values for the location in this row. See the 
Attribute Values column type in section B.6. 

√

Location 
Length

Optional location length. This value only applies if the Manage 
Dimensions property of the location template is checked (see 
section 3.2.1). See the Dimension column type in section B.6.

√

Location 
Breadth

Optional location breadth. This value only applies if the Manage 
Dimensions property of the location template is checked (see 
section 3.2.1). See the Dimension column type in section B.6.

√

Table 64: Locations CSV Format
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B.2   Cabinets
Each row in a cabinets CSV file corresponds to a single cabinet. The columns in a cabinets CSV file 
are described in Table 65.  The table indicates which columns can be used when updating existing 
cabinets (see section 10.1). A row in a cabinets file is considered to be an update if a cabinet with 
the same Cabinet Name already exists in the location identified by Cabinet Location.

Column Description Update
Cabinet 
Location

Identifier identifying the room the cabinet in this row is in. See 
section 10.1.1.1 for details on identifiers.

Cabinet 
Name

The name of the cabinet in this row.

Cabinet 
Template

The name of the template of the cabinet in this row. √

Cabinet 
Description

An optional description of the cabinet in this row. √

Cabinet 
Color

An optional color for the cabinet in this row. See the Color column 
type in section B.6.

√

Cabinet 
Position

Optional overview coordinates of the cabinet in this row. See the 
Coordinates column type in section B.6.

√

Closed 
Front

Optional flag specifying if the front door of the cabinet is closed. The 
default value is closed for new cabinets and no change for existing 
cabinets. See the Flag column type in section B.6.

√

Closed Rear Optional flag specifying if the rear door of the cabinet is closed. The 
default value is closed for new cabinets and no change for existing 
cabinets. See the Flag column type in section B.6.

√

Rotated Optional flag specifying if the cabinet is rotated or not (see section 
7.2.11 for details on rotated cabinets). The default value is not rotated 
for new cabinets and no change for existing cabinets. See the Flag 
column type in section B.6.

√

Cabinet 
Attributes

The user attributes values for the cabinet in this row. See the 
Attribute Values column type in section B.6.

√

Table 65: Cabinets CSV Format

B.3   Equipment
Each row in a equipment CSV file corresponds to a single equipment instance, either regular or 
modular. The columns in an equipment CSV file are described in Table 66.  The table indicates 
which columns can be used when updating existing equipment (see section 10.1). A row in an 
equipment file is considered to be an update if the value for the Equipment Identifier 
column identifies existing equipment in the database.
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Column Description Update
Equipment 
Identifier

An optional  identifier for the equipment. See section 10.1.1.1 for 
details on identifiers.

Equipment 
Location

Identifier identifying the location or cabinet the equipment in this row 
is in. See section 10.1.1.1 for details on identifiers. Note that an empty 
value represents the enterprise location. If this row represents modular 
equipment, the value for this column contains an equipment identifier 
and either a port or a slot identifier, separated by a comma.

Equipment 
Label

The label of the equipment in this row. √

Equipment 
Template

The name of the equipment template for the equipment in this row.

Equipment 
Position

An optional equipment position, which can be coordinates in a 
graphical overview or a position in a cabinet. See the Equipment 
Position column type in section B.6.

√

Equipment 
Description

An optional description of the equipment in this row. √

Equipment 
Attributes

The user attributes values for the equipment in this row. See the 
Attribute Values column type in section B.6.

√

Port 
Labeling 
Front

Optional labels for the ports on the front of this equipment. See the 
Labeling column type in section B.6.

√

Port 
Labeling 
Rear

Optional labels for the ports on the rear of this equipment. See the 
Labeling column type in section B.6.

√

Slot 
Labeling 
Front

Optional labels for the slots on the front of this equipment. See the 
Labeling column type in section B.6.

√

Slot 
Labeling 
Rear

Optional labels for the slots on the rear of this equipment. See the 
Labeling column type in section B.6.

√

Defect 
Ports Front

An optional comma separated list of port identifiers representing the 
ports on the front of the equipment in this row that are defect. See 
section 10.1.1.1 for details on identifiers. See section 5.6.2 for details 
on defect ports. If a port has multiple terminators, and only some of 
the terminators are defect, the terminators can be listed in parentheses 
after the port identifier. See section 5.7.2 for details on defect 
terminators.

√

Defect 
Ports Rear

An optional comma separated list of port identifiers representing the 
ports on the rear of the equipment in this row that are defect. See 
section 10.1.1.1 for details on identifiers. See section 5.6.2 for details 
on defect ports. If a port has multiple terminators, and only some of 
the terminators are defect, the terminators can be listed in parentheses 

√
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after the port identifier. See section 5.7.2 for details on defect 
terminators.

Reserved 
Ports Front

An optional comma separated list of port identifiers representing the 
ports on the front of the equipment in this row that are reserved. See 
section 10.1.1.1 for details on identifiers. See section 5.6.3 for details 
on reserved ports. If a port has multiple terminators, and only some of 
the terminators are reserved, the terminators can be listed in 
parentheses after the port identifier. See section 5.7.3 for details on 
reserved terminators.

√

Reserved 
Ports Rear

An optional comma separated list of port identifiers representing the 
ports on the rear of the equipment in this row that are reserved. See 
section 10.1.1.1 for details on identifiers. See section 5.6.3 for details 
on reserved ports. If a port has multiple terminators, and only some of 
the terminators are reserved, the terminators can be listed in 
parentheses after the port identifier. See section 5.7.3 for details on 
reserved terminators.

√

Port 
Attributes 
Front

The user attributes values for the ports on the front of the equipment in 
this row. See the Item Attribute Values column type in 
section B.6.

√

Port 
Attributes 
Rear

The user attributes values for the ports on the rear of the equipment in 
this row. See the Item Attribute Values column type in 
section B.6.

√

Slot 
Attributes 
Front

The user attributes values for the slots on the front of the equipment in 
this row. See the Item Attribute Values column type in 
section B.6.

√

Slot 
Attributes 
Rear

The user attributes values for the slots on the rear of the equipment in 
this row. See the Item Attribute Values column type in 
section B.6.

√

Table 66: Equipment CSV Format

B.4   Cables
Each row in a cables CSV file corresponds to a single cable. The columns in a cables CSV file are 
described in Table 67.  The table indicates which columns can be used when updating existing 
cables (see section 10.1). A row in a cables file is considered to be an update if the value for the 
Cable Identifier column identifies an existing cable in the database.
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Column Description Update
Cable 
Identifier

An optional  identifier for the cable. See section 10.1.1.1 for details on 
identifiers.

Cable 
Location

An optional identifier identifying the location the cable in this row is 
in. This value is ignored if connections are specified for the cable. See 
section 10.1.1.1 for details on identifiers. Note that an empty value 
represents the enterprise location.

Cable Label An optional label for the cable in this row. √
Cable 
Template

The name of the cable template for the cable in this row.

Added 
Connectors 
Left

A comma-separated list of connector template names representing the 
connectors that were added to the left side of the cable in this row after 
the cable was created.

Added 
Connectors 
Right

A comma-separated list of connector template names representing the 
connectors that were added to the right side of the cable in this row 
after the cable was created.

Added 
Elements

A description of the cable elements that were added to the cable in this 
row after the cable was created. See the Added Cable-Elements 
column type in section B.6.

Cable 
Description

An optional description for the cable in this row. √

Cable 
Position

Optional overview coordinates for the cable. See the Coordinates 
column type in section B.6.

√

Cable 
Attributes

The user attributes values for the cable in this row. See the 
Attribute Values column type in section B.6.

√

Cable 
Element 
Labels

Optional labels for the cable elements of the cable in this row. See the 
Labeling column type in section B.6.

√

Connections 
Left

Optional connections of the left side of the cable in this row. See the 
Connections column type in section B.6.

√

Connections 
Right

Optional connections of the right side of the cable in this row. See the 
Connections column type in section B.6.

√

Cable 
Element 
Attributes

The user attributes values for the cable elements of the cable in this 
row. See the Item Attribute Values column type in section 
B.6.

√

Table 67: Cables CSV Format
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B.5   Connections
The connections import format is intended as a simpler form of the cables format. The connections 
import file format can be used to import simple connections using cables with a single cable-
element. Unlike the other formats, the connections format is flexible in the number of columns a file 
can have. There are eight possible column headers and each can be repeated as necessary. This way, 
a single line in a connections import file can describe multiple cables.

The eight possible columns in a connections import file are described in Table 68. The first two 
columns in a connections import file must be Cable Label and Cable Template. After that, 
any of the eight columns can be added as necessary. When reading the file, PatchManager will 
create a connection for every two consecutive Port columns in the file. Whenever PatchManager 
encounters a port label in a Port column, it will use the values in the previous columns to 
determine the equipment the port is on, and optionally the location the equipment is in, the label of 
the slot the module the port is on is plugged into and the side of the equipment the port is on.

Column Description
Cable Label The label of the next cable. This column can be left empty to indicate the 

next cable does not have a label.
Cable Template The name of the template of the next cable. This value is required.
Location The name of the location the equipment of the next port is in. This value 

can be left empty. In this case, the identifier of the next equipment should 
uniquely identify an equipment instance (note that the identifier of the 
equipment itself can also be used to include its location, see section 
10.1.1.1).

Equipment Identifier of the equipment the next port is on. See section 10.1.1.1 for 
details on identifiers.

Slot If the next port is on modular equipment, this column can be used to enter 
the label of the slot the equipment of the next port is on. If a value is 
entered, a slot with that label must exist on the equipment identified by the 
value in the last Equipment column.

Side This value can be either Front, Rear or empty. If not empty, the value 
indicates the side of the equipment the next port is on.

Port Identifier of a port. See section 10.1.1.1 for details on identifiers. For every 
second Port column, a cable will be created to connect the two ports 
(provided the Port columns are not left empty).

Connector If the cable described has different connectors in each side, this column 
can be used to specify which connector should be connected to the next 
port. The value in this column should be the name of a connector template.

Table 68: Connections CSV Format

Note that if you opt to select a range of rows in the import file, as described in section 10.1.1, the 
file will be presented as if it is in the cables format. However, the values in the Row column of the 
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table will correspond to the row numbers in the original file.

B.6   Column Types
The table below describes the column types used in the different CSV file formats.
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Column Type Description
Color The format for a color is r=<red> g=<green> b=<blue>, where 

<red>, <green> and <blue> are values in the range [0, 255].
Labeling A comma-separated list of labels. Alternatively, you can enter a labeling 

scheme specified as <prefix>&<start>&<pad>. <start> should 
be an integer number. <pad> is 1 if padding should be applied, 0 
otherwise. How labeling schemes are applied is explained in section 
3.2.3.3.11.3. Note that the step size applied will be 1.
For port labels, if a port has multiple terminators the port labels should be 
listed separated by commas, and the terminator labels should be listed 
between parentheses, separated by pipe characters (|) after each port label.

Flag Either Yes or No.
Dimension A dimension specified as a number and a unit. Examples of valid 

dimensions are 3.76”, 5m and 192cm.
Coordinates X, Y coordinates separated by a comma and a space. For example: 

0.5, 0.5.
Equipment 
Position

For modular equipment that is reversed in a slot the position is Reversed. 
For equipment in locations this is the same as coordinates (see above). 
For equipment in cabinets the format is U<N> <Side> <X> where <N> 
is the U position in the cabinet, <Side> is either Front or Rear and 
<X> is an optional dimension (see above) that specifies the distance 
between the left side of the equipment and the left edge of the cabinet.

Attribute 
Values

The format of this value is <Attribute Name>=<Value> pairs 
separated by ampersands (&), for example a1=v1&a2=v2.

Item Attribute 
Values

The user attributes of each item are specified using an identifier for the 
item (see section 10.1.1.1), followed by a colon, followed by an 
ampersand-separated list of <Attribute Name>=<Value> pairs. The 
items are separated by ::. For example, the value 
I1:A1=1&A2=2::I2:A1=3&A2=4 specifies the values for attributes 
A1 and A2 for items I1 and I2.
For ports that have multiple terminators, you can list the terminator 
attribute values by formatting them similarly, but replacing the colons with 
pipe characters (for example T1|A1=1||T2|A1=2). The terminator 
values should be added after the port values between parentheses.

Connections A pipe character (|) separated list of values identifying ports. An empty 
value means that the corresponding connector on the cable is not 
connected. Each port is identified using an equipment identifier and a port 
identifier, separated by a comma. However, if multiple connections are on 
the same equipment, it is not necessary to repeat the equipment identifier. 
See section 10.1.1.1 for details on identifiers.

Added Cable-
Elements

A comma-separated list of cable-element descriptions. Each description is 
in the format <L>|<T>|<C1>|<T1>|<C2>|<T2>. <L> is the label of 

PatchManager Reference Manual Version 4.1 Page 273 / 274



the cable-element. <T> is the name of the cable-element template. C1 and 
C2 are the connector numbers for each side of the cable-element. These 
number identify the connector the element is connected to in the lists of 
added connectors (see the Added Connectors Left and Added Connectors 
Right columns in the cables CSV format, section B.4). T1 and T2 are the 
numbers of the termination points the cable-element is connected to. See 
section 3.2.4.1 for an explanation of cable template design and section 
5.4.1 for a description of adding cable-elements to an existing cable.

Table 69: Column Types

B.7   Special Characters
There are several characters that have special meaning in import files. If you would like to use such 
a character in a value, without having it's special meaning applied, you need to replace the character 
with one of the values described in Table 70. Note that the characters described in Table 70 only 
have a special meaning in some columns (see the previous section for details).

Character Replacement
| <PIPE>
: <COLON>
= <EQUALS>
& <AND>
, <COMMA>
( <OPEN>
) <CLOSE>
Table 70: Special Characters
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